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KATA PENGANTAR 

Puji syukur penyusun panjatkan kepada Tuhan Yang Maha Esa karena atas rahmat 

dan hidayah-Nya penulis dapat menyelesaikan buku yang berjudul “PERENCANAAN 

WAREHOUSE SISTEM PRE ENGINEERED BUILDING (PEB)”. Perkembangan 

industri yang masif di Indonesia perlu ditopang dengan infrastruktur penunjang industri 

yang memadai. Berbagai kawasan industri kini mulai dikembangkan untuk menciptakan 

kawasan industri yang terpusat dan terpadu. Pembangunan bangunan industri juga ikut 

mengalami perkembangan yang masif seiring digenjotnya berbagai sektor industri mulai 

dari manufaktur, garmen hingga otomotif. Atas dasar tersebut, maka diperlukan panduan 

praktis dalam perencanaan struktur bangunan industri. Tidak banyak buku teks berbahasa 

Indonesia yang membahas tahapan perencanaan struktur baja terutama untuk bangunan 

industri. 

Buku ini menjelaskan tahapan perencanaan struktur bangunan industri dengan 

system Preengineered Building (PEB) menggunakan program ETABS. Berbagai tahapan 

desain mulai dari penentuan material, beban dan kombinasi beban, pemodelan struktur, 

hingga desain struktur diulas secara ringkas berdasarkan standar-standar yang berlaku. 

Penentuan beban mati, hidup, beban angin dan beban gempa juga diuraikan secara 

lengkap berdasarkan SNI 1726-2019 dan SNI 1727-2020.  

Penulis menyadari bahwa buku yang disusun ini masih terdapat kekurangan. Oleh 

karena itu penulis mengharapkan kritik dan saran yang sifatnya membangun. Akhir kata, 

penulis berharap agar buku yang telah penulis susun ini dapat bermanfaat dan 

berkontribusi aktif terhadap perkembangan ilmu pengetahuan khususnya pada bidang 

struktur baja. 

 

Bekasi, 06 Mei 2025 

 

Totok Andi Prasetyo 

Utomo Saputro 
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untuk selalu belajar dan belajar sampai bisa seperti ini dengan perjuangan yang tinggi 

untuk menjadi ahli baja, motivasi beliau adalah Prof Dr Wiryanto Guru Besar UPH. 

Beliau menimba ilmu kepada siapa saja tanpa perlu malu bertanya kepada yang lebih 

muda sekalipun karena menurut beliau ilmu itu luas jadi siapapun bisa belajar dari mana 

saja. Dengan bangga kami sebagai keluarga, anak, istri beliau merasa bersyukur semua 

perlu proses yang panjang dan dengan kesabaran kami. Alhamdulillah beliau bisa jadi 

Dosen, Direktur, dan Asesor. Selamat atas pencapain beliau sebagai penulis buku tentang 

struktur buat para generasi penerus bangsa terutama di bidang struktur. 

Ibu Suryani - Komisaris PT TAP Rekayasa Struktur  

Ashrafi Raihan Tsaqif - (Putra ke 1, Mahasiswa aktif tahap akhir UMJ) 

Muhammad Rizqi Yusuf - (Putra ke 2) 
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Sebagai ketua umum HAKI dan juga sebagai staf pengajar 

di Fakultas Teknik Sipil dan Lingkungan, saya sangat 

berterimakasih kepada penulis yang telah mewakafkan 

waktunya untuk membagi ilmu dan pengalaman desain 

struktur baja yang dimilikinya, khususnya yang terkait 

bangunan industri, dalam bentuk sebuah buku yang cukup 

komplet. Buku desain seperti ini, yang mengacu secara 

konsisten pada SNI-SNI terkait dan diperkaya dengan 

berbagai pengalaman desain yang dimiliki penulis, masih 

sangat jarang tersedia. Sehingga diharapkan buku ini dapat 

menjadi buku acuan bagi praktisi dan juga mahasiswa 

Teknik Sipil di Indonesia dalam mempelajari dan 

memahami berbagai aspek desain struktur baja, khususnya 

untuk bangunan industri. 

 

Prof. Iswandi Imran, M.A.Sc., Ph.D. 

Guru Besar Institut Teknik Bandung ( ITB ), Dosen Senior 

Struktur Beton  

 

 

Pertama-tama saya ucapkan selamat kepada saudara Ir. 

Totok Andi Prasetyo, M.T. yang telah mempublikasikan 

bukunya yang terbaru dengan judul “PERENCANAAN 

WAREHOUSE SISTEM PRE ENGINEERED BUILDING”. 

Buku ini cukup lengkap dan sangat bermanfaat untuk 

aplikasinya khususnya dalam dunia teknik sipil struktur. 

Contoh kasus yang diberikan dapat dijadikan sebagai salah 

satu panduan bagi para engineer dalam perancangan, yang 

dimulai dari pemilihan sistem struktur, pemodelan, 

pembebanan sesuai standar yang berlaku dan analisis 

struktur. Oleh sebab itu buku ini akan lebih memperkaya 

pengembangan ilmu teknik sipil struktur secara praktis di 

Indonesia. 

 

Prof. Dr. Ir. Antonius, M.T.  

Dosen Teknik Sipil/Struktur - Universitas Islam Sultan 

Agung Semarang 
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Buku tulisan Pak Ir. Totok Andi Prasetyo, M.T. dengan 

judul: “PERENCANAAN WAREHOUSE SISTEM PRE-

ENGINEERED BUILDING (PEB)”, Panduan Praktis ini 

sungguh sangat bermanfaat. Contoh yang dibahas adalah 

bangunan yang banyak diterapkan dalam praktik, lengkap 

karena meliputi pemodelan keseluruhan bangunan, analisis 

struktur yang telah memperhitungkan seluruh beban yang 

pengaruhnya signifikan (beban gempa dan/atau beban 

angin) serta dilengkapi dengan perencanaan detail 

sambungan. Metode analisis yang digunakan dalam buku 

ini telah mengikuti perkembangan teknologi saat ini dan 

standar yang diterapkan disesuaikan dengan standar SNI 

dan AISC.  

Saya ingat kata pengantar sebuah buku yang sangat terkenal 

di seluruh dunia, yaitu kitab Al Jabar ("The Beginnings of 

Algebra", "Al-Kitab..al-Jabr wa al-Muqabalah") yang 

ditulis oleh Al-Khwarizmi (1830M). Dalam kata pengantar 

buku tersebut Al-Khwarizmi menerangkan bahwa 

penulisan buku beliau itu bertujuan agar: (a) ilmu hitung 

menjadi alat yang memudahkan urusan, (b) memadukan 

apa yang telah dikumpulkan oleh para ahli sebelumnya, (c) 

memperjelas yang masih samar, (d) membetulkan apa yang 

masih keliru dan menemukan yang baru. Buku yang ditulis 

Pak Ir. Totok Andi Prasetyo, M.T. ini memenuhi beberapa 

tujuan penulisan buku menurut Al-Khwarizmi. 

Insyaa Allah buku ini mudah dipahami dan bermanfaat bagi 

para mahasiswa, dosen dan engineer. Semoga Allah Yang 

Maha Mengetahui memberikan pahala dan keberkahan bagi 

Pak Ir. Totok Andi Prasetyo, M.T. dari amal jariyah dalam 

penulisan buku ini. 

 

Dr.Ir. Sumirin, M.S.  

Dosen Teknik Sipil/Struktur - Universitas Islam Sultan 

Agung Semarang 
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Saya sebagai Kaprodi Teknik Sipil ISTN sangat berterima 

kasih kepada bapak Ir. Totok Andi Prasetyo, M.T., selaku 

penulis buku PERENCANAAN WAREHOUSE DENGAN 

SYSTEM PRE ENGINEERED BUILDING (PEB). Di 

Tengah kesibukannya beliau sebagai pengajar dan praktiksi 

masih meluangkan waktu untuk menulis buku. Buku ini 

sangat membantu sebagai referensi bagi mahasiswa yang 

akan menyusun tugas akhir dengan topik bangunan 

warehouse atau sejenisnya. Semoga buku ini dapat menjadi 

amal jariyah bagi penulis dan keluarganya karena 

manfaatnya.  

 

Ir. Ismono Kusmaryono, M.T. 

Kaprodi Program Sarjana Teknik Sipil ISTN 

 

 

 

Buku ini menyajikan perencanaan struktur baja industri 

secara sistematis—dari teori material, pemodelan 

ETABS, hingga analisis seismik berbasis SNI terkini. 

Contoh nyata dan visualisasi teknis menjadikan buku ini 

sangat aplikatif bagi mahasiswa, perencana, dan praktisi. 

Dari sudut pandang manajemen konstruksi, keunggulan 

buku ini juga terletak pada pendekatannya yang 

menyentuh aspek efisiensi sistem konstruksi PEB—

sebuah sistem yang sangat relevan dalam konteks 

kebutuhan industrial saat ini, di mana waktu, biaya, dan 

keberlanjutan menjadi tolok ukur utama keberhasilan 

proyek. Penulis menekankan pentingnya keterpaduan 

antara desain awal, estimasi beban, dan fleksibilitas 

perakitan struktur baja, yang merupakan fondasi utama 

dalam prinsip-prinsip lean construction dan manajemen 

risiko teknis. 

Saya percaya buku ini akan menjadi rujukan penting di 

lingkungan akademik, BUMN konstruksi, lembaga 

konsultan, dan juga praktisi manajemen konstruksi. 

Semoga karya ini terus diperbarui seiring dengan dinamika 

kebijakan teknis dan inovasi teknologi di masa depan. 

 Dr (Can). Rafama Dewi, S.Pd., S.Ars., MT., MKU. 
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Buku seri ke-4 karya Bpk. Dr. Ir. Totok Prasetyo, MT. ini 

sangat menarik dan bermanfaat karena membahas 

mengenai struktur gudang dengan sistem PEB. Dibahas 

dengan praktis dan lengkap, buku ini akan memperkaya 

pustaka Teknik Sipil di Indonesia.  

Selamat dan sukses untuk tim penulis. 

 

 Dr. Nathan Madutujuh, ESRC, Bandung 

 

 

 Pertama-tama saya mengucapkan selamat atas karya Bapak 

Ir. Totok Andi Prasetyo, MT yang keempat ini, bersama 

Bapak Utomo Saputro. Suatu kehormatan bagi saya untuk 

dapat memberikan testimoni ini.  

Buku ini melengkapi ketiga buku karya Bapak Totok 

sebelumnya. Saya kagum atas semangat beliau untuk 

berbagi ilmu dan pengalaman beliau dalam bidang 

perencanaan struktur baja. Saya yakin buku ini, seperti 

buku-buku sebelumnya, akan sangat bermafaat baik bagi 

praktisi (rekan-rekan insinyur praktik) dan akademisi 

(dosen, mahasiswa) yang hendak menimba pengalaman 

desain struktur baja secara praktis. Buku keempat ini 

khususnya menjelaskan bagaimana contoh nyata desain 

struktur baja pre-engineered building (PEB) dilakukan 

dalam praktik desain. Meskipun dalam praktik terdapat 

beberapa konstruksi baja yang menerapkan konsep PEB, 

saat ini tidak terdapat buku yang khusus menjelaskan 

struktur baja PEB ini. Jadi, buku ini sungguh telah mengisi 

kekosongan yang dibutuhkan dalam dunia pustaka di 

Indonesia. 

 

Wong Foek Tjong, S.T., M.T., Ph.D. - Dosen Desain 

Struktur Baja dan Peneliti dalam Bidang Metode Elemen 

Hingga, Universitas Kristen Petra, Surabaya 
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Buku tulisan Pak Ir. Totok Andi Prasetyo, M.T. dengan 

judul : “PERENCANAAN WAREHOUSE SISTEM PRE-

ENGINEERED BUILDING (PEB)”, Panduan Praktis ini 

sangat bermanfaat untuk referensi dalam perancangan 

struktur Baja khususnya PERENCANAAN WAREHOUSE 

SISTEM PRE-ENGINEERED BUILDING (PEB). Buku ini 

sangat  dibutuhkan  mashasiswa, Dosen, dan para praktisi  

engineering .  Buku ini  mendukung untuk kegiatan EPC 

Engineering Procurement Contracting struktur Baja. 

Karena selain desain atau perencanaan,  pengetahuan 

bahan dan material yang digunakan sangat penting. 

Dengan demikian hal-hal detail material dapat diketahui 

pada saat awal desain. Apalagi penerapan PEB sangat 

membantu proses BIM struktur.  Penerapan SNI-SNI yang 

berlaku serta aplikasi program struktur baja dapat 

digunakan sebagai acuan referensi yang meliputi 

pemodelan keseluruhan bangunan, analisis struktur yang 

telah memperhitungkan seluruh beban yang pengaruhnya 

signifikan (beban gempa dan/ atau beban angin) serta 

dilengkapi dengan perencanaan detail sambungan. Buku ini 

juga disertai contoh kasus perancangan sehingga mudah 

dipahami dengan baik. 

Insyaa Allah buku ini mudah dipahami dan bermanfaat bagi 

para mahasiswa, dosen dan engineer. Semoga Allah Yang 

Maha Mengetahui,  memberikan pahala dan keberkahan 

bagi Pak Ir. Totok Andi Prasetyo, M.T. dari amal jariyah 

dalam penulisan buku ini. Salam sukses Pak Totok Andi 

Prasetyo. 

 

Ir. Moch Arif Toto.Rahardjo, M-Eng, A-Utama  

Sebagai Ketua I DPP HAKI (Himpunan Ahli 

Konstruksi Indonesia),  

Asesor Kompetensi LSP ASBSI (Ahli Struktur Bangunan 

Sipil Indonesia), dan  Dosen Teknik Sipil / Struktur – 

Sekolah Vokasi - Universitas Universitas Gadjah Mada. 
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Buku edisi ke-4 yang membahas PEB sangat menarik untuk 

dibaca, PEB ini merupakan bagian dari kuliah yang jarang 

dibahas didalam perkuliahan struktur baja, padahal 

keahlian PEB ini sangat diperlukan di dunia kerja. 

Terimakasih Pak Totok A. Prasetyo dan tim penulis yang 

berkenan membahas tuntas PEB dengan contoh soal nyata 

dari dunia kerja.  

 

(Donny B. Tampubolon, ST) 

 

‘Karena menulis adalah bekerja untuk keabadian…’ 
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PENDAHULUAN 

 

 

 

 

 

A. MATERIAL BAJA 

Keunggulan baja sebagai material baja struktur 

adalah suatu jenis baja yang berdasarkan pertimbangan 

ekonomi, kekuatan dan sifatnya, cocok untuk pemikul 

beban. Baja struktur banyak dipakai untuk kolom dan balok 

gedung bertingkat, sistem penyangga atap, hanggar; 

jembatan, menara antena, penahan tanah, dan fondasi tiang 

pancang. Ada beberapa keunggulan baja sebagai material 

konstruksi antara lain: 

1. Mempunyai kekuatan yang tinggi. Baja memiliki 

kekuatan tarik dan tekan yang tidak jauh berbeda, 

dengan variasi antara 200 MPa sampai 2000 MPa. 

Dengan kekuatan tinggi ini, ukuran tampang struktur 

jadi lebih kecil, sehingga berat struktur jadi lebih 

ringan. Akibat lebih lanjut, pemakaian fondasi jadi 

lebih hemat. Hal ini cukup menguntungkan bagi 

struktur-struktur jembatan yang panjang, gedung 

yang tinggi atau juga bangunan-bangunan yang 

berada pada kondisi tanah yang buruk. 
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2. Keseragaman dan keawetan yang tinggi. Sifat baja tidak banyak berubah terhadap 

waktu, tidak seperti material beton bertulang misalnya, yang tersusun dari berbagai 

macam bahan penyusun; komponen penyusun baja jauh lebih seragam atau 

homogen serta mempunyai tingkat keawetan yang jauh lebih tinggi, terlebih baja 

diproduksi di pabrik dengan kontrol yang ketat. 

3. Sifat elastis. Baja mempunyai perilaku yang cukup dekat dengan asumsi-asumsi 

yang digunakan dalam analisis, sebab baja dapat berperilaku elastis hingga 

tegangan yang cukup tinggi mengikuti hukum hooke. Momen inersia dari suatu 

profil baja juga dapat dihitung dengan pasti sehingga memudahkan dalam 

melakukan proses analisis struktur. 

4. Daktilitas baja cukup tinggi. Daktilitas didefinisikan sebagai sifat material untuk 

menahan deformasi yang besar tanpa keruntuhan terhadap beban tarik. Suatu 

elemen baja yang diuji terhadap tarik akan mengalami pengurangan luas 

penampang dan akan terjadi perpanjangan sebelum terjadi keruntuhan. Sebaliknya 

pada material keras dan getas (brittle) akan hancur terhadap beban kejut. SNI 03-

1729-2002 mendefinisikan daktilitas sebagai kemampuan struktur atau 

komponennya untuk melakukan deformasi inelastis bolak-balik berulang (siklik) di 

luar batas titik leleh pertama, sambil mempertahankan sejumlah besar kemampuan 

daya dukung bebannya. Beban normal yang bekerja pada suatu elemen struktur 

akan mengakibatkan konsentrasi tegangan yang tinggi pada beberapa titik. Sifat 

daktail baja memungkinkan terjadinya leleh lokal pada titik-titik tersebut sehingga 

dapat mencegah keruntuhan prematur. Keuntungan lain dari material daktil adalah 

jika elemen struktur baja mendapat beban cukup maka akan terjadi defleksi yang 

cukup jelas sehingga dapat digunakan sebagai tanda keruntuhan, karena suatu 

batang baja yang menerima tegangan tarik yang tinggi akan mengalami regangan 

tarik cukup besar sebelum terjadi keruntuhan. 

5. Liat (Toughness). Baja merupakan material yang liat artinya memiliki kekuatan dan 

daktilitas. Suatu elemen baja masih dapat terus memikul beban dengan deformasi 

yang cukup besar. lni merupakan sifat material yang penting karena dengan sifat ini 

elemen baja bisa menerima deformasi yang besar selama pabrikasi, pengangkutan, 

dan pelaksanaan tanpa menimbulkan kehancuran. Dengan demikian pada baja 

struktur dapat diberikan lenturan, diberikan beban kejut, geser, dan dilubangi tanpa 
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memperlihatkan kerusakan. Kemampuan material untuk menyerap energi dalam 

jumlah yang cukup besar. 

6. Permanen. Struktur yang terbuat dari baja yang mendapat perawatan baik akan 

berumur sangat panjang, bahkan hasil penelitian menunjukkan bahwa pada kondisi 

tertentu baja tidak memerlukan perawatan pengecatan sama sekali. 

7. Cocok untuk sebagai struktur tambahan. Struktur baja sangat sesuai untuk 

penambahan struktur. Baik sebagian bentang baru maupun seluruh sayap dapat 

ditambahkan pada portal yang telah ada, bahkan jembatan baja sering kali 

diperlebar. 

8. Kemudahan dalam pemasangan/konstruksi. Kelebihan lain dari material baja  

adalah: (a) kemudahan penyambungan baik dengan baut, paku keling maupun las, 

(b) cepat dalam pemasangan, (c) dapat dibentuk menjadi profil yang diinginkan, (d) 

kekuatan terhadap fatik, (e) kemungkinan untuk penggunaan kembali setelah 

pembongkaran, (f) masih bernilai meskipun tidak digunakan kembali sebagai 

elemen struktur, (g) adaptif terhadap prefabrikasi. 

Meski memiliki banyak keunggulan, baja juga mempunyai kekurangan antara lain: 

1. Biaya pemeliharaan tinggi. Material baja sangat rentan terhadap korosi jika 

dibiarkan terjadi kontak dengan udara dan air. Untuk itu perlu dilakukan tindakan 

pencegahan terhadap korosi secara periodik. Upaya pencegahan korosi ini 

memerlukan biaya yang cukup besar dan mahal. 

2. Sangat rentan terhadap suhu panas/kebakaran. Meskipun baja tidak mudah terbakar 

tetapi kekuatannya menurun drastis jika terjadi kebakaran. Selain itu baja juga 

merupakan konduktor panas yang baik sehingga dapat menjadi pemicu kebakaran 

komponen lain. 

3. Rentan terhadap tekuk (buckling). Semakin langsing suatu elemen tekan, semakin 

besar pula bahaya terhadap buckling (tekuk). Sebagaimana telah disebutkan bahwa 

baja mempunyai kekuatan yang tinggi per-satuan berat dan jika digunakan sebagai 

kolom sering kali tidak ekonomis karena banyak material yang perlu digunakan 

untuk memperkuat kolom terhadap buckling. 
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1. Proses Pembuatan /Fabrikasi 

Secara singkat proses pembuatan besi dan baja dapat dilihat pada Gambar 1.3. 

Uraian singkat mengenai tahapan proses pengolahan besi dan baja tersebut diuraikan di 

bawah ini. 

a. Penambangan dan pengolahan biji besi. Bahan baku awal dalam pembuatan besi 

dan baja adalah biji besi (iron core). Biji besi yang didapatkan dari alam umumnya 

merupakan senyawa besi dengan oksigen seperti hematite (Fe2O3); mognetite 

(Fe3O4); limonite (FezO:); atau siderite (Fe2CO3). Pembentukan senyawa besi 

oksida tersebut sebagai proses alam yang terjadi selama beribu-ribu tahun.  

b. Karena biji besi didapatkan dalam bentuk senyawa dan bercampur dengan kotoran-

kotoran lainnya maka sebelum dilakukan peleburan, biji besi tersebut terlebih 

dahulu harus dilakukan pemurnian untuk mendapatkan konsentrasi biji yang lebih 

tinggi (25-40%). Proses pemurnian ini dilakukan dengan metode: crushing, 

screening, dan washing (pencucian). Untuk meningkatkan kemurnian menjadi lebih 

tinggi (60-65%) serta memudahkan dalam penanganan berikutnya, dilakukan 

proses aglomerasi dengan langkah-langkah sebagai berikut: 

• Biji besi dihancurkan menjadi partikel-partikel halus (serbuk) 

• Partikel-partikel biji besi kemudian dipisahkan dari kotoran-kotoran dengan 

cara pemisahan magnet (magnetic separator) atau metode lainnya. 

• Serbuk biji besi selanjutnya dibentuk menjadi pellet berupa bola-bola kecil 

berdiameter antara 12,5 - 20 mm. 

• Terakhir, pellet biji besi dipanaskan melalui proses sinter/pemanasan hingga 

temperatur 1300°C agar pellet tersebut menjadi keras dan kuat sehingga tidak 

mudah rontok. 

• Proses reduksi. Tujuan proses reduksi adalah untuk menghilangkan ikatan 

oksigen dari biji besi. Proses reduksi ini memerlukan gas reduktor seperti 

hidrogen atau gas karbon monoksida (CO). Proses reduksi ini ada 2 macam 

yaitu proses reduksi langsung dan proses reduksi tidak langsung. 

a) Proses reduksi langsung. Proses ini biasanya digunakan untuk mengubah 

pellet menjadi besi spons sponge iron atau sering disebut: besi hasil reduksi 
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langsung (direct reduced iron). Gas reduktor yang dipakai biasanya berupa 

gas hidrogen atau gas CO yang dapat dihasilkan melalui pemanasan gas 

alam cair (LNG) dengan uap air didalam suatu reaktor yaitu melalui reaksi 

kimia berikut: 

 

 

 

Gambar 1.1 Proses Fabrikasi Baja 

Dengan menggunakan gas CO atau hidrogen dari persamaan 

diatas maka proses reduksi terhadap pellet biji besi dapat dicapai melalui 

reaksi kimia berikut ini : 

 

b) Proses reduksi tidak langsung. Proses ini dilakukan dengan menggunakan 

tungku pelebur yang disebut juga tanur tinggi (blast furnoce). Biji besi 

hasil penambangan dimasukkan ke dalam tanur tinggi tersebut dan didalam 

tanur tinggi dilakukan proses reduksi tidak langsung yang cara kerjanya 

sebagai berikut: Bahan bakar yang digunakan untuk tanur tinggi ini adalah 

CH4  +  H2O   CO + 3H2 

(gas hidro karbon) (uap air panas) (gas reduktor) 
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batu bara yang telah dikeringkan (kokas). Kokas dengan kandungan karbon 

(C) diatas 80%, tidak hanya berfungsi sebagai bahan bakar, tetapi juga 

berfungis sebagai pembentuk gas CO yang berfungsi sebagai reduktor. 

Untuk menimbulkan proses pembakaran maka ke dalam tanur tersebut 

ditiupkan udara dengan menggunakan blower sehingga terjadi proses 

oksidasi sebagai berikut : 

 

Gas CO yang terjadi dapat menimbulkan reaksi reduksi terhadap 

biji yang dimasukkan ke dalam tanur tersebut. Sedangkan panas yang 

ditimbulkan berguna untuk mencairkan besi yang telah tereduksi tersebut. 

Untuk mengurangi kotoran-kotoran (impuritas) dari logam cair, ke dalam 

tanur biasanya ditambahkan sejumlah batu kapur (limestone). Batu kapur 

tersebut akan membentuk terak (slag) dan dapat mengikat kotoran-kotoran 

yang ada didalam logam cair. Karena berat jenis terak lebih rendah dari 

berat jenis cairan besi maka terak tersebut berada dipermukaan logam cair 

sehingga dapat dikeluarkan melalui lubang terak. 

Besi hasil proses tanur tinggi ini disebut juga besi kasar (pig Iron). 

Besi kasar ini merupakan bahan dasar untuk membuat besi tuang lcast 

iron) dan baja (steel). Komposisi kimia unsur-unsur pemadu dalam besi 

kasar ini terdiri dari 3-4%C; 0,06-0,10% S;0,10-0.5% P;1-3% Si dan 

sejumlah unsur-unsur lainnya, sebagai bahan impuritas. Karena kadar 

karbonnya tinggi, maka besi kasar mempunyai sifat yang sangat rapuh 

dengan kekuatan rendah serta menampakkan wujud seperti grafit. Untuk 

pembuatan besi tuang, besi kasar tersebut biasanya dicetak dalam bentuk 

lempengan-lempengan (ingot) yang kemudian dilebur kembali oleh pabrik 

pengecoran (foundryl). Sedangkan untuk pembuatan baja, besi kasar 

dalam keadaan cair langsung dipindahkan dari tanur tinggi ke dalam 

tungku pelebur lainnya yang sering disebut: tungku oksigen basa (bosic 

oxygen furnoce, atau disingkat BOF). Dalam tungku BOF ini kadar karbon 

besi kasar akan diturunkan sehingga mencapai tingkat kadar karbon baja. 
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c) Proses peleburan besi tuang dan baja dilihat dari komposisi kimia yaitu dari 

unsur-unsur yang terkandung antara besi tuang dan baja karbon tidak 

menunjukkan perbedaan. Tetapi perbedaannya terletak pada kadar karbon 

(C) dan kadar Silikon (Si) Di mana kadar dari kedua elemen ini dalam besi 

tuang lebih tinggi dari baja karbon. Karena itu dilihat dari system paduan, 

maka baja karbon termasuk sistem Fe-C, sedangkan besi tuang termasuk 

sistem FeC-Si. Karena perbedaan kadar C dan Si tersebut maka struktur 

dan sifat-sifat besi tuang berbeda dengan struktur dan sifat-sifat baja 

karbon. Struktur besi tuang pada umumnya mengandung grafit sedangkan 

pada baja tidak terjadi grafit. Karena adanya grafit ini maka besi tuang 

mempunyai sifat kurang kuat dan rapuh sedangkan baja pada umumnya 

mempunyai sifat kuat dan lebih ulet. 

2. Klasifikasi Baja 

Berdasarkan persentase carbon: 

a. Baja carbon rendah (low carbon steel). Baja carbon rendah mengandung carbon 

antara 0,10 sampai 0,30%. Baja ini dalam perdagangan dibuat dalam bentuk plat baja, 

baja strip, baja batangan atau profil. Berdasarkan jumlah carbon dalam yang 

terkandung dalam baja, maka baja carbon rendah dapat digunakan atau dijadikan 

sebagai baja-baja sebagai berikut: 

• Baja carbon rendah yang mengandung 0,04%-0,10%C, untuk dijadikan baja-

baja plat atau strip. 

• Baja carbon rendah yang mengandung 0,05% C, digunakan untuk keperluan 

badan-badan kendaraan. 

• Baja carbon rendah yang mengandung 0,15%-0,30 C, digunakan untuk baja 

struktur/konstruksi seperti untuk konstruksi jembatan, bangunan gedung, dan 

menara. 

b. Baja carbon menengah (medium carbon steel). Baja carbon menengah mengandung 

carbon antara 0,30%-0,60% C. Baja karbon menengah ini banyak digunakan untuk 

keperluan alat-alat perkakas bagian mesin, pegas, roda gigi, dan sebagainya. 
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c. Baja carbon tinggi (high carbon steel). Baja carbon tinggi mengandung carbon antara 

0,60%-1,7% C. Baja ini mempunyai tegangan tarik paling tinggi dan banyak 

digunakan untuk perkakas seperti palu, gergaji, pahat potong, kikir, pisau, mata 

gergaji. 

3. Standar Material Baja 

Baja merupakan salah satu material paling vital dalam dunia industri dan 

konstruksi. Kekuatan, daya tahan, dan fleksibilitasnya menjadikannya pilihan utama 

dalam pembangunan infrastruktur, permesinan, serta berbagai produk manufaktur. 

Namun, untuk memastikan bahwa baja yang digunakan memiliki kualitas yang sesuai 

dengan peruntukannya, diperlukan standar mutu yang ketat dan konsisten. Standar mutu 

baja bertujuan untuk menjamin bahwa baja yang diproduksi, dipasarkan, dan digunakan 

memenuhi persyaratan teknis yang telah ditetapkan secara nasional maupun internasional. 

Standar mutu baja mencakup berbagai aspek, mulai dari komposisi kimia, sifat 

mekanik, hingga ketahanan terhadap korosi dan suhu ekstrem. Di Indonesia, standar mutu 

baja diatur oleh Standar Nasional Indonesia (SNI), sedangkan secara global, terdapat 

standar internasional seperti ASTM (American Society for Testing and Materials), JIS 

(Japanese Industrial Standards), dan ISO (International Organization for 

Standardization). Misalnya, ASTM A36 adalah salah satu standar baja karbon yang 

umum digunakan untuk struktur bangunan karena kekuatan tarik dan kelenturannya yang 

baik. 

B. PERENCANAAN BATANG 

1. PERENCANAAN BATANG TEKAN (KOLOM) 

Perencanaan Batang Tekan (kolom) adalah elemen struktur yang menerima gaya 

aksial tekan/desak. Merupakan elemen struktur yang memiliki ketidakstabilan tinggi. 

Ketidakstabilan disebabkan karena adanya eksentrisitas awal (e0) yang selalu ada akibat 

batang yang tidak lurus sempurna. Panjang tekuk batang adalah jarak antar titik balik 

batang tersebut, yaitu jarak antar ujung–ujung sendi ekuivalen baik sendi rill maupun 

imajiner. Panjang tekuk (Lk) dapat dinyatakan dalam persamaan sebagai berikut: 

Lk= K . L ........................................................................................... (1.1) 
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Kolom ideal adalah kolom yang berdiri sebagai kolom tunggal. Dalam 

kenyataannya, kolom ideal jarang ditemui. Contoh berbagai, kolom ideal ditunjukan pada 

gambar. Parameter material, Fy dan Fu akan menentukan batang tarik. Rangka tidak-

bergoyang dan rangka bergoyang. Panjang efektif kolom atau KL adalah cara sederhana 

tetapi efektif dalam memprediksi kekuatan kolom, yaitu mencari korelasi bentuk tekuk 

yang berkesuaian. Pada sistem rangka batang (truss) yang merupakan rangka tidak 

bergoyang, maka nilai 0.5 < K < 1.0. Panjang efektif kolom atau KL tidak melebih dari 

panjang kolom sebenarnya. Besarnya nilai K untuk kolom ideal dapat dilihat pada gambar 

di bawah. 

 

Gambar 1.2 Panjang Efektif Kolom Ideal  

Ketika GA dan GB telah dihitung dari kolom suatu portal, juga telah dievaluasi 

kondisi pertambatannya. Selanjutnya, tempatkan titik Ga pada skala garis alignment chart 

sebelah kiri, juga titik Gb pada garis skala di sebelah kanan. Dari dua titik Ga dan Gb 

tersebut kemudian ditarik garis lurus-lurus sampai memotong garis skala nilai K di 

tengah. Nilai K dibaca sebagai kekakuan. Kolom dari rangka bergoyang nilai Ga=10 dan 

Gb=1.5 maka nilai Ga=10 dan Ga=1 untuk portal tidak bergoyang. 
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Gambar 1.3 Nomogram Faktor Panjang Tekuk 

Nu ≤ ∅. Nn .............................................................................................................. (1.2) 

      Nn = Ag. 
𝑓𝑦

ω 
 ............................................................................................................ (1.3) 

Di mana, 

Nn    = Kuat tekan nominal, (N)  

∅ = 0.85 

Ag   = Luas Penampang Bruto Profil 

Fy = Tegangan Leleh 

Nilai ω (koefisien tekuk) diambil sebesar 3 kemungkinan : 

1) Untuk λc ≤ 0,25 maka ω = 1,0 

2) Untuk 0,25 < λc< 1,2 maka ω = 
1.43

1.6−0.67 𝑥 𝜆𝑐 
 

3) Untuk λc ≥ 1,2 maka ω = 1,25 . λc2 

λc = 
1

𝜋
 x 

𝐿𝑘

𝑟𝑦
 x [√

𝑓𝑦

𝐸
] .......................................................................................... (1.4) 

  



Pendahuluan | 11 

Di mana, 

Ag   = Luas tampang bruto/gross, mm2 

fcr     = Tegangan kritis tampang, Mpa 

fy    = Tegangan leleh baja, Mpa 

ry    = jari-jari girasi komponen struktur terhadap sumbu y-y, mm 

Lk   = Panjang tekuk komponen struktur tersusun pada arah tegak lurus sumbu, 

mm 
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2. PERENCANAAN BATANG LENTUR BALOK (BALOK) 

Batang lentur/balok (beam) adalah elemen struktur yang menerima beban tekan 

bekerja tegak-lurus terhadap sumbu memanjangnya. Akibat arah beban yang tegak lurus 

dengan sumbu memanjang batang, maka pada batang akan timbul gaya-gaya dalam, yaitu 

berupa gaya geser (gaya lintang) yang tergambarkan dalam bentuk SFD dan momen 

lentur yang tergambarkan dalam bentuk BMD. Penampang balok di titik C (pot. A-A) 

harus mampu menahan gaya geser/lintang sebesar Vc dan momen lentur Mc. Balok 

umumnya dalam posisi horisontal. Efek lain akibat arah beban yang tegak lurus dengan 

sumbu memanjang batang, maka batang juga melendut. Untuk itu, perencanaan suatu 

batang lentur (balok), didasarkan pada 3 kriteria, yaitu:  

- berdasarkan momen lentur 

- berdasarkan gaya geser 

- berdasarkan lendut 

Sebuah struktur, ketidakstabilan lokal maupun elemen akan menyebabkan 

keruntuhan seluruh struktur (Galambos & Surovek, 2008). Salah satu ketidakstabilan 

yang dapat terjadi pada komponen struktur balok adalah fenomena tekuk. Fenomena 

tekuk mengakibatkan struktur dapat runtuh sebelum mencapai leleh. Tekuk pada 

komponen struktur dapat dibagi menjadi tekuk lokal dan tekuk global. Salah satu jenis 

tekuk global yang dapat terjadi pada balok penampang I adalah tekuk torsi lateral. Tekuk 

torsi lateral adalah peralihan penampang secara lateral disertai dengan torsi penampang 

yang diakibatkan oleh momen lentur. 

A. Pengaruh Kelangsingan Pada Profil Baja 

Pada umumnya bahwa penampang balok baja terdiri dari profil terbuka dan 

elemennya relatif tipis. Kelangsingan dapat diukur dari rasio lebar-tebal. Jika terjadi 

tegangan tekan, elemen beresiko mengalami keruntuhan tekuk lokal (local backling)  

a)  Tekuk Lokal: 

Suatu batang lentur (natot) dapat mengalami tekuk pada pelat sayap atas dan pelat 

badan bagian atas, tekuk ini disebut sebagai tekuk lokal seperti terlihat pada gambar di 

bawah. Tekuk lokal yang terjadi di badan profil disebut sebagai tekuk badan, sedang yang 

terjadi di sayap profil disebut sebagai tekuk sayap. 
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Gambar 1.2 Kegagalan Tekuk Lokal Baja 

Elemen- elemen penyusun profil diklasifikasikan sebagai kompak, non kompak 

dan langsing. Klasifikasi elemen plat penyusun profil dapat dilihat pada tabel berikut: 
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Gambar 1.1 Klasifikasi Penampang 

Berdasarkan nilai λp dan λr dari plat badan dan sayap, dibagi menjadi 3: 

(1) 
Penampang Kompak 

 
: (λf juga λw) < λp 

  
(2) 

Penampang tak kompak : Λp < (λf juga λw) < λr 

(3) Penampang langsing 

 

: Λr < (λf juga λw) 

  
Profil kompak mampu memikul momen sampai serat terluar mencapai tegangan 

leleh, Ketika diberi momen lagi dapat berotasi lagi, sekaligus mendistribusi tegangan ke 

serat penampang bagian dalam, sampai semuanya plastis (Mp). Profil kompak merupakan 

konfigurasi geometri penampang yang paling efisien dalam memanfaatkan material. 

Profil non-kompak mempunyai efisiensi satu tingkat lebih kecil dibandingkan 

penampang kompak dan ketika dibebani serat tepi terluarnya dapat mencapai tegangan 

leleh, meskipun demikian sebelum penampang plastis penuh terbentuk, profil akan 

mengalami tekuk lokal terlebih dahulu. Oleh karena itu, kapasitas momen yang dapat 

diandalkan pada penampang ini adalah My<Mp. 
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Penampang langsing adalah konfigurasi profil yang tidak efisien ditinjau dari segi 

pemakaian material. Apalagi jika yang dipakai adalah bahan baja yang bermutu tinggi. 

Ketika dibebani sebelum tegangan mencapai kondisi leleh telah terjadi tekuk lokal 

terlebih dahulu, sehingga untuk profil agar mencapai kondisi leleh harus memberi 

sokongan lateral agar tidak terjadi tekuk lokal sebelum profil mencapai kondisi leleh. 

 

Gambar 1.1 Momen Nominal berdasarkan Kelangsingan Penampang 

Untuk profil kompak: 

Mn = ∅ 𝑥 𝑍 𝑥 𝐹𝑦 .......................................................................................................... (1.5) 

 

Untuk penampang non-kompak: 

 .................................................. (1.6) 

 

 Untuk Penampang langsing: 

Mn= 
0.9 𝑥 𝐸𝐾𝑐 𝑥 𝑆𝑥

𝜆2
 ....................................................................................................... (1.7) 

 

Perhitungan Gaya Geser 

Gaya Geser Nominal: 

 Vu < ∅v x Vn .............................................................................................................. (1.8) 

[𝑀𝑛 =  𝑀𝑝 − (𝑀𝑝 − 0.7𝑓𝑦. 𝑠𝑥). (
𝜆𝑓 − 𝜆𝑝𝑓

𝜆𝑟𝑓 − 𝜆𝑝𝑓 
)] 
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Dengan Vn: 

Vn = 0.6 x fy x Aw x Cv 

 

Dengan: 

fy  = kuat leleh baja 

Aw = Luas total plat badan (d x tw) 

Cv = Faktor reduksi untuk mengantisipasi terjadinya tekuk di plat badan 

  

Jika :  h/tw<  ..................................................................................... (1.9)  

∅v = 1 

Cv = 1 

 h/tw <     ........................................................................ (1.10) 

Cv = 1 

      

         < h/tw <   .............................................................. (1.11) 

 

Cv =                 /            (h/tw) 

  

h/tw >    ...................................................................................... (1.12) 

 

Cv =  

 

Koefisien tekuk plat (Kv) untuk profil -I tanpa plat pengaku tegak dan 

kelangsingan plat badannya h/tw<240 nilai Kv=5.0. Apabila ada plat pengaku tegak 

untuk tiap jarak a dengan syarat a/h<3, maka koefisien tekuk plat menjadi: 

2.24 𝑥 [
𝐸

𝑓𝑦
]

0.5

 

1.10 𝑥 [
𝐾𝑣 𝑥 𝐸

𝑓𝑦
]

0.5

 

1.51 𝑥 𝑘𝑣 𝑥 𝐸

(
ℎ

𝑡𝑤)
2

 𝑥 𝑓𝑦

 

2.24 𝑥 [
𝐸

𝑓𝑦
]

0.5

 

1.10 𝑥 [
𝐾𝑣 𝑥 𝐸

𝑓𝑦
]

0.5

 

1.37 𝑥 [
𝐾𝑣 𝑥 𝐸

𝑓𝑦
]

0.5

 

1.37 𝑥 [
𝐾𝑣 𝑥 𝐸

𝑓𝑦
]

0.5
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Kv  = 5 +
5

(
𝑎

ℎ
)

2 ............................................................................................... (1.13)  

b)   Tekuk Torsi Lateral (Tekuk Global) 

Tekuk torsi lateral adalah fenomena kegagalan struktur yang terjadi ketika suatu 

elemen struktur, seperti balok atau kolom, mengalami kombinasi dari tekuk lateral dan 

torsi. Tekuk lateral terjadi ketika elemen struktur mengalami deformasi lateral akibat 

beban yang diberikan, sedangkan torsi terjadi ketika elemen struktur mengalami putaran 

akibat momen torsi. 

 

 

Gambar 1.2 Kegagalan Tekuk Global Baja 

 

Gambar 1.1 Momen Nominal berdasarkan Kelangsingan Penampang 
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3. Batang Kombinasi Tekan dan Lentur 

Pada bab sebelumnya kita belajar terkait perencanaan batang tekan dan lentur 

profil secara terpisah. Hal itu menyebabkan aplikasinya terbatas, hanya terjadi pada 

struktur-struktur tertentu saja. Batang baja terhadap gaya aksial (tarik dan tekan) saja 

hanya cocok untuk profil rangka batang (Truss). Pada kenyataannya, perencanaan kolom 

tidak hanya menahan gaya aksial saja, akan tetapi juga terdapat gaya momen yang harus 

ditahan. Begitu juga pada balok lentur (rafter) tidak hanya menahan gaya lentur (momen) 

akan tetapi tetap menahan gaya aksial juga. 

Struktur yang elemen batangnya menerima kombinasi gaya aksial dan momen 

sekaligus, termasuk frame atau portal. Rangka batang apabila pembebanannya tidak pada 

titik buhul juga akan menimbulkan momen, sehingga perencanaan batang tekan atau tarik 

saja tidak mewakili kenyataan di lapangan sehingga perencanaan tidak valid. Sehingga 

perlu dibahas perilaku dan ketentuan perencanaan batang yang menerima kombinasi yang 

menerima gaya aksial dan momen sekaligus. 

A. Profil Terhadap Kombinasi Gaya-Momen 

Perencanaan secara sendiri elemen-elemen struktur terhadap gaya atau momen 

dipilih karena kapasitas batang hanya maksimal untuk satu kondisi saja. Apabila terjadi 

kombinasi antara gaya dan momen secara sekaligus, maka kapasitas batang menjadi 

terbagi, sehingga kinerja terhadap daya dukungnya menjadi berkurang. Untuk lebih 

mudah memahami perilaku profil baja yang mengalami gaya tekan dan momen maka 

disusun kurva interaksi 3d. Kurva ini merupakan hubungan kolom atau balok terhadap 

gaya aksial dan momen pada sumbu kuat (Mx) dan sumbu lemah (My) suatu profil. 

Tiap sumbu pada diagram di atas mewakili kapasitas balok-kolom yang diibebani 

oleh satu macam gaya atau momen secara sendiri-sendiri. Adapun lengkung di antara dua 

sumbu merupakan kombinasi gaya-momen (biaksial). Adapun kurva permukaan hasil 

pertemuan ketiga kurva merupakan batas kapasitas kombimasi aksial-momen. Seperti 

perencanaan kolom biaksial pada kolom beton, jadi jika terdapat kombinasi beban aksial 

dan momen yang nilainya masih berada di bawah kurva batas kapasitas, maka dianggap 

profil masih aman dan memenuhi syarat perencanaan. Untuk meninjau hal tersebut, 

Rumus yang biasa Ru< ∅Rn atau gaya tumpu perlu harus kurang dari gaya tumpu nominal 
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yang sudah dikalikan faktor reduksi menjadi rumus interaksi Ru/∅Rn < 1.0. Nilai di 

bawah 1 artinya di bawah batas kapasitas. 

 

Gambar 1.1 Kurva kapasitas batang gemuk terhadap kombinasi gaya-momen 

Selanjutnya dapat disusun kurva interaksi sederhana dengan mengkombinasikan 

gaya aksial perlu (Pr) terhadap kapasitas gaya aksial (Pc), momen sumbu kuat perlu (Mrx) 

terhadap kapasitas momen sumbu kuat rencana (Mcx), dan momen sumbu lemah perlu 

(Mry) terhadap kapasitas momen sumbu lemah rencana (Mcy). Hasil kurva interaksi 3D 

pada gambar berikut. 

 

Gambar 1.1 Kurva interaksi kombinasi gaya-momen sederhana 
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B. Penampang Simetri Terhadap Lentur & Gaya Aksial 

Telah dijelaskan bagaimana kurva interaksi AISC disusun, selanjutnya akan 

dijelaskan aplikasi untuk perencanaan. Interaksi momen lentur dan gaya aksial pada 

penampang simentri ganda atau simetri tunggal dengan 0.1<Iyc/Iy<0.9 yang momennya 

dapat dipaksa melentur pada sumbu simetrinya, harus memenuhi persamaan H1-1a dan 

H1-1b (AISC 2010). Adapun Iyc adalah momen inersia sayap dengan tegangan desak 

terhadap sumbu y atau sumbu lemahnya. 

Persamaan interaksinya adalah: 

Jika 
𝑃𝑟

𝑃𝑐
 > 0,2 maka : 

𝑃𝑟

𝑃𝑐
 + 

8

9
 [

𝑀𝑟𝑥

𝑀𝑐𝑥
+ 

𝑀𝑟𝑦

𝑀𝑐𝑦
] < 1.0 .............................................................. (1.14) 

 

Jika 
𝑃𝑟

𝑃𝑐
 < 0,2 maka : 

𝑃𝑟

2𝑃𝑐
 + [

𝑀𝑟𝑥

𝑀𝑐𝑥
+  

𝑀𝑟𝑦

𝑀𝑐𝑦
] < 1.0 ............................................................... (1.15) 

 

Di mana: 

Pr =  Pu kuat aksial perlu elemen struktur, hasil analisa struktur rangka secara 

menyeluruh (global). 

Pc = ∅.Pn Kuat rencana elemen struktur (tentukan batang tarik/batang tekan) 

Mr = Mu Kuat lentur pada elemen, hasil analisis struktur yang telah 

memperhitungkan efek ordo ke-2 atau efek P-∆ pada rangka secara 

menyeluruh 

Mc = ∅.Mn Kuat rencana elemen struktur sebagai balok lentur yang dicari sesuai 

ketentuan pada bab 6. 

X = Subskrip simbol untuk momen lentur terhadap lentur terhadap sumbu 

kuat penampang 

Y = Subskrip simbol untuk momen lentur terhadap lentur terhadap sumbu 

lemah penampang 
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C. PENGENALAN BANGUNAN INDUSTRI 

Bangunan industrial mulai mengalami perkembangan seiring dengan 

perkembangan ekonomi di Indonesia. Proses percepatan investasi dalam negeri yang 

terus di dorong membuat berbagai macam sektor industri semakin maju. Perusahaan-

perusahaan ternama dunia mulai melebarkan sayap industrinya di Indonesia. Hal tersebut 

tentu perlu ditopang dengan kondisi operasional perusahaan yang mumpuni. Dari situlah 

kemudian sebagian besar perusahaan mulai mendirikan bangunan industrial baik untuk 

proses produksi, manufaktur ataupun penyimpanan biasa. 

Bangunan industrial merupakan bangunan dengan komponen arsitektural dan 

struktural yang relatif sederhana dibandingkan dengan tipe bangunan lain seperti, 

perhotelan, perkantoran dan lain sebagainya, yang tentu lebih mementingkan aspek 

estetika. Bangunan industrial lebih mengutamakan fungsi bangunan sebagai penunjang 

proses produksi dan operasional.  

Umumnya bangunan industrial dibangun menggunakan material baja sebagai 

struktur utama. Struktur baja dapat menciptakan ruang luas terbuka yang efisien yang 

dibutuhkan oleh sebagian besar bangunan industrial. Biasanya struktur baja dipilih atas 

alasan keberlanjutan, di mana apabila terdapat rencana pengembangan bangunan, struktur 

baja dapat dengan mudah beradaptasi. Namun tidak menutup kemungkinan bahwa 

bangunan industrial dibangun dengan kombinasi beberapa material lain seperti struktur 

beton bertulang, dan struktur baja canai dingin. 

Dengan fungsi sebagai bangunan penunjang proses produksi dan operasional, 

biasanya bangunan industrial dibangun dengan skala luasan yang besar. Atas dasar itulah, 

proses perancangan bangunan industrial sangat dipengaruhi oleh biaya yang efisien. 

Bangunan industrial juga dibangun dengan biaya operasional yang minimum dengan 

tingkat keberlajutan yang tinggi untuk mengurangi konsumsi energi yang berdampak 

pada biaya operasional bangunan. 

Berdasarkan apa yang dirangkum oleh Newman (2004), bangunan industri 

pertama yang berdiri adalah Ditherington Flax Mill yang dibangun di Inggris pada Tahun 

1796. Bangunan ini terdiri dari kolom-kolom logam yang didirkan untuk menggantikan 

material kayu yang biasa digunakan di Inggris. Ide untuk membangunan fasilitas 
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manufaktur terbangun karena banyaknya bangunan pabrik kapas yang terbakar karena 

menggunakan material kayu. Begitu sifat tahan api pada material logam ditemukan, 

perkembangan bangunan industri dengan material logam mulai jamak digunakan di 

dataran Britania Raya. 

Bangunan industri yang didesain dengan struktur baja memiliki beberapa 

kelebihan, antara lain sebagai berikut; 

- Struktur baja mampu mengakomodir bentang yang cukup panjang. Struktur rangka 

payon (gable frame) dapat mencapai bentang hingga 30m. Kemampuan untuk 

memberikan bentang yang panjang menjadikan struktur baja sebagai material yang 

ekonomis untuk digunakan pada bangunan industri. 

- Pengerjaan struktur baja untuk bangunan industri relatif cepat. Dengan elemen-

elemen yang sudah difabrikasi di workshop, proses instalasi struktur baja di 

lapangan jadi lebih cepat. Dari beberapa referensi, proses pekerjaan bangunan 

industri yang dibangun dengan struktur baja memakan durasi yang tiga kali lebih 

cepat ketimbang dengan material lain. 

- Efisiensi biaya. Dengan sistem pra-fabrikasi di workshop yang menghasilkan durasi 

pekerjaan yang lebih cepat, kebutuhan jumlah pekerja dapat menjadi lebih sedikit 

sehingga biaya upah pekerja dapat dipangkas. Selain itu, sistem pra-fabrikasi yang 

presisi dapat menghasilkan produk yang minim cacat sehingga waste dapat 

diminimalisir. 

- Kemudahan pengembangan. Bangunan industri sering kali dibangun dalam 

beberapa fase. Dengan struktur baja, penambahan massa bangunan akan mudah 

dilaksanakan karena proses pembongkaran bangunan eksisting dapat dilakukan 

secara mudah. Selain itu, struktur baja eksisting juga dapat digunakan kembali 

untuk bangunan baru. 

- Proses pemeliharaan yang ringan. Pada tipikal bangunan industri yang 

menggunakan atap metal sheet yang mudah dirawat, biaya operasional untuk 

pemeliharaan yang dikeluarkan dapat lebih sedikit. Selain itu biaya pemeliharaan 

untuk struktur juga tidak relatif besar, apalagi untuk struktur baja yang telah dilapisi 

dengan lapisan anti korosi. 
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- Proses konstruksi bangunan industri umumnya tidak terlalu rumit dan 

membutuhkan banyak stakeholder sehingga tidak membutuhkan terlalu banyak 

vendor. Stakeholder yang tidak terlalu banyak membuat owner akan dengan mudah 

melacak pertanggungjawaban dari produk konstruksi yang dihasilkan oleh masing-

masing stakeholder. Selain itu, apabila terjadi masalah maupun saat masa 

perawatan, owner juga akan mudah untuk meminta penjelasan kepada stakeholder 

terkait. 

1. Komponen-komponen pada Bangunan Industri 

Elemen paling mendasar yang jamak digunakan pada bangunan industri terdiri 

dari kolom dan balok. Sistem mendasar ini kemudian dimodifikasi dengan cara-cara 

tertentu untuk menghasilkan struktur yang efisien. Tipe struktur yang paling sering 

digunakan adalah portal frame baik yang bertipe gable frame maupun monoslope. Sistem 

struktur ini memiliki stabilitas searah bidang yang cukup. Namun stabilitas pada arah luar 

bidang perlu diantisipasi dengan bantuan bracing. Dalam suatu bangunan industri semua 

komponen bersatu menjadi satu komponen yang membentuk suatu sistem utuh. Terdapat 

beberapa komponen yang hampir selalu ada pada bangunan industri seperti rangka utama, 

purlin, girts, bracings, nok atap, dan kolom post. Pada gambar di bawah disajikan secara 

lengkap gambaran bagaimana komponen bangunan industri membentuk suatu sistem 

yang utuh. 

 

Gambar 1. 1. Komponen pada Bangunan Industri 

(Sumber: Newman, 2003) 
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a. Struktur Utama (Main Frame) 

Di Indonesia, bangunan industri sangat jamak menggunkan sistem struktur portal 

karena alasan efisiensi dan kemudahan fungsi. Berbagai jenis tipe portal dapat didesain 

dengan sistem utama yang hampir serupa, bisa berbentuk gable frame, curved frame, 

gable frame dua bentang dan lain sebagainya. Struktur portal menyediakan ruang dengan 

bentang yang lebar yang akan memudahkan proses operasional dari bangunan industri. 

Umumnya sistem struktur portal ini didesain dengan profil wide flange dari baja canai 

panas, dengan variasi profil baja canai dingin sebagai secondary framing (purlin, girts, 

dan lain sebagainya). Di Eropa dan juga beberapa proyek di Indonesia, sistem struktur 

portal dikembangkan menggunakan variasi profil lain seperti, honeycomb dan cellular 

beam. Tentu pemilihan profil yang digunakan menyesuaikan kebutuhan serta 

pembebanan yang ada. Sistem struktur portal cocok digunakan untuk bentang sedang 25-

40 m. 

Selain struktur portal, sistem lain yang sering digunakan sebagai struktur utama 

bangunan industri adalah sistem truss 2d. Sistem ini dapat dibentuk dengan menggunakan 

profil T, wide flange, pipa, atau kanal. Dua di antara sistem struktur truss untuk atap yang 

paling sering digunakan adalah truss tipe W dan tipe N. Design Guide 7: Design for 

Industrial Building, memberikan rekomendasi konfigurasi truss yang ekonomis untuk 

digunakan. Untuk tinggi truss kurang dari 1,5 direkomendasikan menggunakan truss tipe 

N, sementara untuk tinggi truss di atas 1,5 m direkomendasikan menggunakan truss tipe 

W. Selain itu penggunaan profil T juga lebih ekonomis karena dapat mengeliminasi 

penggunaan gusset untuk batang vertikal dan diagonal. Sebagai acuan awal, umumnya 

rasio tinggi truss terhadap bentang diambil sekitar 1/15 hingga 1/20 karena dapat 

menghasilkan struktur yang ekonomis. Sistem struktur rangka atap truss dapat 

dikombinasikan baik dengan kolom baja biasa, kolom baja truss, maupun kolom beton. 

Semuanya tentu dengan pertimbangan biaya yang dapat diakomodir oleh owner. 
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Gambar 1. 2. Rekomendasi Konfigurasi Truss untuk Atap 

(Sumber: Design Guide 7 AISC: Industrial Building Design, 2019) 

Sistem struktur lain yang bisa digunakan untuk bangunan industri dengan bentang 

yang ekstra lebar adalah sistem struktur suspended. Struktur ini ditopang dengan batang-

batang tarik dari struktur kabel. Struktur tersuspensi dapat dirancang dengan 

memperpanjang kolom di luar gedung untuk penyangga batang tarik. Contoh penggunaan 

struktur tersuspensi di Indonesia ada pada Terminal Induk Pulogebang. 

 

Gambar 1. 3. Contoh Sistem Struktur Suspended (Terminal Pulogebang) 
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b. Struktur Pendukung (Secondary Frame) 

Sistem struktur pendukung pada bangunan industri terdiri dari purlin dan girts. 

Purlin pada bangunan industri dapat didesain baik menggunakan baja canai panas dan 

baja canai dingin. Purlin yang berasar dari baja canai dingin biasa dibuat dari profil C dan 

Z. Purlin dengan tinggi profil 20 hingga 30 kaki dapat mengakomodir bentang 7,5 hingga 

9 m. Purlin dengan profil C atau Z normalnya terbuat dari baja mutu tinggi seperti ASTM 

A 570 atau A 607. Sementara untuk purlin yang berasal dari baja canai panas bisa dibuat 

dari profil CNP, box CNP, Square Hollow Section, maupun Rectangular Hollow Section. 

 

Gambar 1. 4. Profil Baja Canai Dingin C dan Z untuk Purlin 

(Sumber: Newman, 2003) 
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Koneksi antara purlin dengan rafter dapat dibuat secara menerus (continious) 

maupun tertumpu secara sederhana (simply supported beam). Untuk membuat purlin 

dengan sistem menerus, dibutuhkan lap splice yang lebih panjang, umumnya sekitar 120 

cm untuk purlin di bentang pertama dan 60 cm untuk purlin pada bentang yang lain. 

Sementara untuk purlin yang tertumpu sederhana hanya dibutuhkan 10 cm lap splice. 

 

Gambar 1.5. Koneksi Antara Purlin ke Rafter 

(Sumber: Newman, 2003) 

Sementara itu, bagian lain yang merupakan rangka sekunder pada bangunan 

industri adalah girt. Girt bisa digunakan dari profil baja canai dingin seperti profil C dan 

Z, juga bisa digunakan dari profil baja canai panas seperti profil kanal. Belakangan, profil 

hollow square section juga mulai banyak digunakan sebagai girt untuk mengeliminasi 

bracing eksternal yang menghubungkan girt dengan rangka kolom. Profil baja canai 

dingin dapat digunakan apabila faktor ekomomi menjadi pertimbangan. Girt dari profil 

baja canai dingin biasanya tidak membutuhkan sag rod tambahan. Dinding metal juga 

dapat dihubungkan dengan girt dengan screw yang relatif murah. Sementara, profil baja 

canai panas digunakan sebagai struktur girt apabila lingkungan sekitar lokasi rawan 

mengakibatkan korosi. Selain itu, untuk sistem dinding tertentu yang berat, girt harus 
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didesain dengan baja canai dingin yang relatif lebih kuat. Proses desain struktur girt dapat 

dilakukan dengan beberapa tahapan sebagai berikut: 

- Dimensi girt ditentukan berdasarkan beban eksternal baik dari berat sendiri 

dinding atau beban angin 

- Tentukan kebutuhan sag rod berdasarkan kriteria defleksi dan tegangan momen 

di sumbu lemah girt 

- Periksa beban internal hisap pada girt berdasarkan Spesifikasi AISC Bab F 

- Jika dimensi girt tidak cukup kuat, tingkatkan dimensi girt atau tambahkan sag 

rod 

- Cek kriteria kemampuan layanan girt 

- Cek kapasitas sag rod untuk menahan puntir akibat beban hisap. 

2. Standar dan Peraturan yang Digunakan 

Dalam perencanaan struktur bangunan industri, standar dan peraturan yang jamak 

diadopsi antara lain sebagai berikut: 

- Tata cara Perencanaan Ketahanan Gempa untuk Struktur Bangunan Gedung 

dan Non Gedung, SNI 1726-2019.  

- Beban Minimium untuk Perancangan Bangunan Gedung dan Struktur Lain, 

SNI 1727-2020. 

- Spesifikasi untuk Bangunan Gedung Baja Struktural, SNI 1729-2020. 

- Persyaratan Beton Struktural untuk Bangunan Gedung dan Penjelasan, SNI 

2847-2019. 

- Building Code Requirements for Structural Concrete, ACI 318-14. 

- Minimum Design Loads and Associated Criteria for Buildings and Other 

Structures, ASCE 7-16. 

- Specification for Structural Steel Buildings, AISC 360-16. 

3. Alur Beban pada Struktur Bangunan Industri 

Pemahaman mengenai proses alur beban pada suatu struktur menjadi sesuatu yang 

fundamental. Semua elemen struktur yang didesain perlu memiliki kekuatan yang cukup 

untuk mengakomodir beban yang ada. Beban dapat bekerja baik secara gravitasi maupun 

secara lateral. Pada struktur baja beban lain yang perlu dipertimbangkan adalah ekspansi 
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termal. Pada bangunan industri alur beban umumnya dimulai dari atap. Atap akan 

menahan beban vertikal yang terdiri dari berat sendiri struktur, beban mati tambahan pada 

atap, beban hujan, serta beban hidup untuk proses perawatan bangunan. Dalam 

perkembangan yang ada, atap pada bangunan industri juga mulai didesain untuk menahan 

solar panel sehingga beban-beban tambahan seperti walkway perlu dipertimbangkan. 

Beban lain yang bekerja pada atap adalah beban angin. Pada atap dengan sudut yang tidak 

besar, umumnya terjadi angin hisap yang mengakibatkan gaya angkat pada atap. Di 

kawasan yang berpotensi mengalami risiko tekanan angin yang tinggi, atap perlu didesain 

dengan kekuatan yang memadai. 

 

Gambar 1. 6. Beban yang Terjadi pada Bangunan Industri 

Selain bekerja pada atap, beban angin juga bekerja pada kolom sebagai bagian 

dari portal penahan gaya utama. Besaran bebannya variatif dan bergantung pada 

kecepatan angin serta konfigurasi bangunan. Beban angin perlu ditinjau baik yang datang 

dari arah transversal maupun longitudinal. Beban angin yang datang pada arah transversal 

akan ditahan oleh struktur portal yang kokoh, namun beban angin pada arah longitudinal 

akan menerpa sumbu lemah bangunan. Bangunan industri umumnya memiliki stabilitas 

lateral pada arah longitudinal yang rendah sehingga apabila dikenai beban angin terjadi 

keruntuhan. Atas dasar tersebut, penggunaan X-bracing dapat menambah kekuatan di 

sumbu lemah bangunan. 

Selain beban angin, beban horizontal lain yang bekerja pada struktur bangunan 

industri adalah beban gempa. Pada arah transversal beban gempa akan ditahan oleh portal 

rangka yang terdiri dari kolom dan rafter. Sementara pada arah longitudinal beban gempa 
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akan ditahan oleh sistem rangka dengan tambahan X-bracing. Sistem penahan gaya lateral 

yang jamak digunakan pada struktur bangunan industri adalah sistem rangka pemikul 

momen biasa pada arah transversal dan sistem rangka dengan breising konsentris biasa 

pada arah longitudinal. 

 

Gambar 1. 7. Beban Horizontal yang Terjadi pada Portal Utama 

(Sumber: Newman, 2003) 

Pada struktur bangunan industri yang didesain dengan beban crane, beban lateral 

akibat roda juga perlu dipertimbangkan. Beban lateral tersebut akan ditahan oleh runway 

beam dan dibantu dengan backing truss untuk mengantisipasi lendutan horizontal pada 

runway serta buckling di bagian top flange. Beban lateral ini ditransfer ke kolom melalui 

backing truss atau tambatan lateral setempat di setiap kolom yang menopang runway 

beam. Selain beban lateral, crane juga memberikan beban gravitasi yang cukup besar 

pada bangunan. Beban angkat crane serta berat sendiri girder crane plus trolley dan hoist 

perlu dipertimbangkan dengan matang. Runway beam crane perlu didesain dengan inersia 

sumbu kuat yang besar untuk mengantisipasi lendutan vertikal akibat beban angkat dan 

berat sendiri crane. 

Beban lain yang perlu dipertimbangkan adalah beban dinding. Pada bangunan 

industri beban dinding akan ditopang oleh girt yang merangka pada kolom-kolom 

bangunan. Girt juga perlu didesain kuat menahan tekanan akibat beban angin horizontal 

yang didesain berdasarkan beban angin untuk komponen dan klading. Desain untuk 

struktur girt dapat dilakukan secara terpisah dari model struktur utama bangunan namun 

bebannya harus tetap dipertimbangkan karena akan berpengaruh pada perhitungan massa 

gempa efektif. 
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Gambar 1. 8. Tipikal Bangunan Industri dengan X-bracing pada Sumbu Lemah Bangunan 

(Sumber: Newman, 2003) 

4. Pengenalan Sistem PEB (Pre-Engineered Beam) 

Dari banyaknya keunggulan baja dalam material yang dijadikan bahan konstruksi, 

baja merupakan material yang harganya relatif mahal daripada beton. Dalam 

pemakaiannya terkadang ada yang tidak bisa dimanfaatkan dengan penuh (terdapat sisa 

saat pemasangan). Sehingga banyak sekali inovasi yang digunakan untuk optimasi demi 

mengurangi harga material baja tersebut, salah satunya yaitu metode PEB. Secara 

sederhana sistem PEB yaitu suatu jenis sistem yang dirancang dan diproduksi secara 

khusus untuk memenuhi kebutuhan struktural dan arsitektur tertentu. Dalam beberapa 

tahun terakhir, profil balok PEB telah menjadi pilihan populer dalam industri konstruksi 

karena kekuatan, efisiensi, dan fleksibilitasnya. Salah satu kelebihan utama profil balok 

PEB adalah kekuatannya yang tinggi. 

Profil ini dirancang untuk menahan beban yang besar dan dapat digunakan dalam 

berbagai aplikasi, termasuk gudang, pabrik, dan bangunan komersial. Dengan kekuatan 

yang tinggi, profil balok PEB dapat mengurangi risiko kerusakan struktural dan 

meningkatkan keamanan bangunan. Selain kekuatan, profil balok PEB juga memiliki 

efisiensi yang tinggi. Profil ini dirancang untuk memenuhi kebutuhan struktural yang 

spesifik, sehingga dapat mengurangi biaya dan material yang digunakan. Dengan 
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demikian, profil balok PEB dapat membantu mengurangi biaya konstruksi dan 

meningkatkan efisiensi proyek. Fleksibilitas profil balok PEB juga merupakan salah satu 

kelebihannya. Profil ini dapat dirancang dalam berbagai bentuk dan ukuran untuk 

memenuhi kebutuhan arsitektur yang berbeda-beda. Dengan demikian, profil balok PEB 

dapat digunakan dalam berbagai aplikasi, termasuk bangunan dengan desain yang unik 

dan kompleks. 

Pada umumnya menggunakan profil bulit-up baja mutu tinggi dengan profil balok 

non prismastis, yang mempunyai penampang yang tidak sama di sepanjang bentang. 

Sistem ini di dasari pada perbedaan momen yang terjadi di sepanjang bentang. Ukuran 

(tinggi) balok yang efisien jika disesuaikan dengan besarnya momen yang terjadi. Seperti 

yang telah diketahui, pada struktur balok atau portal, akibat beban merata maka momen 

maksimum hanya di tempat-tempat tertentu, apabila simple-beam maka momen 

maksimumnya di lapangan dan untuk portal ada di sudut-sudut portal. 

Jadi pemakaian ukuran profil yang sama, untuk semua bentang, dipastikan ada 

bagian yang tidak optimal. Oleh karena itu, dengan memanfaatkan teknologi las, tinggi 

profil baja diubah sedemikian rupa menjadi bentuk tapered, bagian dengan momen 

maksimum, lebih tinggi daripada bagian lain yang momennya lebih kecil. 

 

Gambar 1. 9. Distribusi Momen Pada Frame 

D. BEBAN-BEBAN PADA STRUKTUR 

1. Beban Mati (Dead Load dan Collateral Load) 

Beban mati merupakan beban yang merepresentasikan berat sendiri struktur dan 

komponen penunjangnya. Dalam suatu bangunan industri, biasanya beban mati juga 

terdiri dari beban peralatan yang ditempatkan secara permanen pada struktur. Beban mati 

dapat diaplikasikan baik sebagai beban garis maupun beban merata. Pada titik-titik 
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tertentu di mana efek akibat beban terjadi secara lokal, analisis khusus secara terpisah 

perlu untuk dipertimbangkan.  

a. Berat Sendiri Elemen Struktur 

Beban mati akibat berat sendiri elemen struktur terdiri atas berat dari material 

struktur yang digunakan. Beberapa berat jenis dari material struktur yang sering 

digunakan pada bangunan industri adalah baja dengan berat jenis 7850 kg/m^3 dan beton 

dengan berat jenis 2400 kg/m^3. Umumnya berat sendiri struktur secara otomatis dapat 

dihitung secara otomatis oleh program bantu analisis struktur seperti ETABS. 

Tabel 1. 1. 

Berat Jenis untuk Bahan Bangunan 

No. Material Berat (kg/m^3) Keterangan 

1. Baja 7850  

2. Batu alam 2600  

3. Batu belah, batu bulat, batu 

gunung 

1500 Berat tumpuk 

4. Batu karang 700 Berat tumpuk 

5. Batu pecah 1450  

6. Besi tuang 7250  

7. Beton 2200  

8. Beton bertulang 2400  

9. Kayu 1000 Kelas I 

10. Kerikil, koral 1650 Kering udara 

sampai lembab, 

tanpa diayak 

11. Pasangan bata merah 1700  

12. Pasangan batu belah, batu 

bulat, batu gunung 

2200  
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No. Material Berat (kg/m^3) Keterangan 

13. Pasangan batu cetak 2200  

14. Pasangan batu karang 1450  

15. Pasir 1600 Kering udara 

sampai lembab 

16. Pasir 1800 Jenuh air 

17. Pasir kerikil, koral 1850 Kering udara 

sampai lembab 

 (Sumber: Pedoman Perencanaan Pembebanan untuk Rumah dan Gedung, 1987) 

b. Beban Mati Tambahan (Superimposed Dead Load) 

Beban Mati Tambahan merupakan berat komponen nonstruktural (arsitektural 

dan MEP) yang sifatnya tetap pada struktur bangunan. Secara tipikal Metal Building 

System Manual memberikan rekomendasi beban SIDL tipikal yang dapat dijadikan acuan 

pada perencanaan bangunan industri sebagaimana pada tabel berikut. 

Tabel 1. 2. 

Tipikal Beban SIDL untuk Bangunan Industri 

 

(Sumber: Metal Building System Manual, 2019) 

 

Beban SIDL, 

kN/m^2

Ceiling

Suspended Acoustical Fiber Tile 0,05

Suspended Gypsum Board - 1/2" 0,10

Suspended Gypsum Board - 5/8" 0,14

Insulation

Glass Fiber Blanket Dapat diabaikan

Cellular Plastic, per inch of insulation 0,01

Lighting 0,005-0,05

HVAC Ducts, Office/Commercial 0,05

Sprinkler

Dry 0,07

Wet 0,14

Material
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2. Beban Hidup Atap (Roof Live Load) 

Beban Hidup (Live Load) adalah beban yang tejadi akibat penggunaan struktur 

atau akibat beban yang sifatnya sementara (tidak tetap). Pada atap, beban hidup 

dipertimbangkan untuk mengakomodir kegiatan pemeliharaan bilamana suatu terjadi 

kerusakan pada atap. SNI 1727-2020 pada Tabel 4-1 merekomendasikan penggunaan 

atap sebesar 0,96 kN/m2 (96 kg/m2). Beban atap ini diizinkan untuk di reduksi dengan 

faktor reduksi 0,6 sehingga berdasarkan SNI 1727:2020 pasal 4.8.2 disyaratkan bahwa 

beban hidup yang bekerja pada atap harus diambil minimum sebesar 0.58 kN/m2 (60 

kg/m2). 

 

Gambar 1. 10. Ketentuan Beban Hidup untuk Atap Berdasarkan SNI 1727-2020 

(Sumber: SNI 1727-2020) 

3. Beban Hujan (R) 

Atap perlu didesain agar dapat menahan beban genangan air hujan apabila sistem 

drainase primer pada atap tertutup. Pedoman perencanaan pembebanan untuk rumah dan 

gedung, 1987, memberikan rekomendasi perhitungan beban air hujan berdasarkan sudut 

kemiringan atap dengan persamaan sebagai berikut: 

   𝑅 = 40 − 0,8 ∗ 𝛼 .................................................................................................... (1.16) 

Di mana: 

R = Beban hujan (kg/m^2) 

α = Sudut atap (derajat) 

Beban atap ini tidak perlu diambil lebih besar dari 20 kg/m^2. 
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Sebagai alternatif lain, SNI 1727-2020 juga memberikan rekomendasi beban yang dapat 

diberikan pada atap akibat genangan air hujan dengan persamaan sebagai berikut: 

𝑅 = 0,0098 ∗ (𝑑𝑠 + 𝑑𝑛) ........................................................................................... (1.17) 

 

R =  Beban hujan (kN/m2) 

ds =  Kedalaman air pada atap yang tidak melendut meningkat ke lubang 

masuk sistem drainase sekunder apabila sistem drainase primer 

tertutup (tinggi statis), dalam in. (mm) 

dn =  Tambahan kedalaman air pada atap yan tidak melendut di atas lubang 

masuk system drainase sekunder pada aliran air rencana (tinggi 

hidrolik), dalam in. (mm). 

4. Beban Angin (Wind Load) 

Beban angin diambil berdasarkan geometri bangunan karena beban angin 

merupakan beban yang paling dominan bekerja pada sebuah stuktur seperti bangunan 

industri. Menurut SNI 1727-2020 Pasal 26 yang mengadopsi ASCE 7-16, bangunan 

industri seperti warehouse masuk dalam kategori Sistem Penahan Gaya Angin Utama 

(SPGAU) serta seluruh Komponen dan Klading (K&K) dalam SNI atau MWFRS and 

C&C dalam ASCE 7-16. Dasar perencanaan beban angin untuk sistem penahan gaya 

angin utama terdapat pada SNI 1727 2020 Pasal 27. Tekanan angin desain untuk SPGAU 

bangunan gedung pada semua ketinggian lb/ft^2 (N/m^2) harus ditentukan dengan 

persamaan sebagai berikut: 

𝑝 = 𝑞 ∗ 𝐺 ∗ 𝐶𝑝 − 𝑞𝑖 ∗ (𝐺 ∗ 𝐶𝑝𝑖) .............................................................. (1.18) 

Di mana: 

q = qz untuk dinding di sisi angin datang yang diukur pada ketinggian 

z di atas permukaan tanah 

q = qh untuk dinding di sisi angin pergi, dinding samping, dan atap 

yang diukur pada ketinggian h 

qi = qh untuk dinding di sisi angin datang, dinding samping, dinding 

di sisi angin pergi, dan atap bagunan gedung tertutup, dan untuk 
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mengevaluasi tekanan internal negatif pada bangunan gedung 

tertutup sebagian 

qi = qz untuk mengevaluasi tekanan internal positif pada bangunan 

gedung tertutup sebagian bila tinggi z ditentukan sebagai level 

dari bukaan tertinggi pada bangunan gedung yang dapat 

mempengaruhi tekanan internal positif. Untuk bangunan gedung 

yang terletak di wilayah puing terbawa angin, kaca yang tidak 

tahan impak atau dilindungi dengan penutup tahan impak, harus 

diperlakukan sebagai bukaan sesuai dengan Pasal 26.12.3. Untuk 

menghitung tekanan internal positif, qi secara konservatif boleh 

dihitung pada ketinggian h (qi= qh) 

G = faktor efek-hembusan angin, lihat Pasal 26.11. Untuk bangunan 

gedung fleksibel, Gf yang ditentukan menurut Pasal 26.11.5 harus 

menggantikan G 

Cp = koefisien tekanan eksternal dari Gambar 27.3-1, 27.3-2 dan 27.3-

3 

GCpi = koefisien tekanan internal dari Tabel 26.13-1 

SNI 1727-2020 memberikan langkah-langkah dalam menentukan beban angin 

SPGAU untuk bangunan gedung tertutup, tertutup sebagian, dan terbuka dari semua 

ketinggian. Langkah-langkah dalam penentuan beban angin adalah sebagai berikut: 

a. Menentukan Kategori Risiko Bangunan Gedung 

Kategori risiko bangunan gedung yang direncanakan terhadap beban angin 

dapat ditinjau berdasarkan Tabel 1.5-1 SNI 1727-2020. Terdapat empat kategori 

risiko bangunan gedung, di mana semakin tinggi tingkatan, fungsi bangunan menjadi 

lebih penting. 
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Tabel 1. 3. 

Kategori Risiko Bangunan Dan Struktur Lainnya Untuk Beban Banjir, Angin, Salju, 

Gempa, Dan Es 

 
 

b. Menentukan kecepatan angin dasar, V (Pasal 26.5) 

Dalam TPKB Jakarta, kecepatan angin dasar Vs=39,1 m/s untuk strength 

design dan Vs=32 m/s untuk serviceability design. Sedangkan menurut HB 212-2002 

Design wind speeds for Asia–Pacific Region report from AS/NZS merekomendasikan 

menggunakan Vs=32 untuk serviceability design dan Vs=40 m/s untuk ultimate 
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design in Indonesian region. Acuan kecepatan angin berdasarkan konsensus TPKB 

Jakarta dapat digunakan sebagai landasan desain apabila kecepatan angin pada lokasi 

yang ditinjau tidak diketahui secara spesifik. 

c. Menentukan Parameter Beban Angin. 

Parameter beban angin untuk sistem SPGAU ditentukan menurut Pasal 26, 

yaitu sebagai berikut: 

- Faktor arah angin, Kd (Pasal 26.6) 

Faktor arah angin ditentukan berdasarkan tabel sebagai berikut. 

Tabel 1. 4. 

Faktor Arah Angin 

 

- Kategori kekasaran permukaan, (Pasal 26.7) 

Kekasaran permukaan tanah harus ditentukan untuk tujuan menetapkan suatu 

kategori eksposur seperti yang didefinisikan sebagai berikut: 

Kekasaran Permukaan B: Daerah perkotaan dan pinggiran kota, daerah 

berhutan, atau daerah lain dengan penghalang berjarak dekat yang banyak 

memiliki ukuran dari tempat tinggal keluarga. 
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Kekasaran Permukaan C: Dataran terbuka dengan penghalang tersebar yang 

memiliki tinggi umumnya kurang dari 30 ft (9,1 m). Kategori ini mencakup daerah 

terbuka datar dan padang rumput. 

Kekasaran Permukaan D: Area datar, area tidak terhalang dan permukaan air. 

Kategori ini berisi lumpur halus, padang garam, dan es tak terputus. 

- Kategori eksposur, (Pasal 26.7) 

Untuk setiap arah angin yang diperhitungkan, eksposur lawan angin didasarkan 

pada kekasaran permukaan tanah yang ditentukan dari topografi alam, vegetasi, 

dan fasilitas dibangun. 

Eksposur B: Untuk bangunan gedung dengan tinggi atap rata-rata kurang dari 

atau sama dengan 30 ft (9,1 m), Eksposur B berlaku bilamana kekasaran 

permukaan tanah, sebagaimana ditentukan oleh Kekasaran Permukaan B, berlaku 

di arah lawan angin untuk jarak yang lebih besar dari 1.500 ft (457 m). Untuk 

bangunan dengan tinggi atap rata-rata lebih besar dari 30 ft (9,1 m), Eksposur B 

berlaku bilamana Kekasaran Permukaan B berada dalam arah lawan angin untuk 

jarak lebih besar dari 2.600 ft (792 m) atau 20 kali tinggi bangunan, pilih yang 

terbesar. 

Eksposur C: Eksposur C berlaku untuk semua kasus saat Eksposur B atau D tidak 

berlaku. 

Eksposur D: Eksposur D berlaku bilamana kekasaran permukaan tanah, 

ditentukan oleh Kekasaran Permukaan D, berlaku di arah lawan angin untuk jarak 

yang lebih besar dari 5.000 ft (1.524 m) atau 20 kali tinggi bangunan, pilih yang 

terbesar. Eksposur D juga berlaku bilamana kekasaran permukaan tanah lawan 

angin dari situs B atau C, dan situs yang berada dalam jarak 600 ft (183 m) atau 

20 kali tinggi bangunan, mana yang terbesar, dari kondisi Eksposur D 

sebagaimana ditentukan dalam kalimat sebelumnya. 

- Faktor topografi, Kzt (Pasal 26.8) 

Efek peningkatan kecepatan angin pada bukit, bukit memanjang, dan tebing curam 

yang terisolasi akan menimbulkan perubahan mendadak dalam topografi umum, 
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terletak dalam setiap kategori eksposur, dimasukkan dalam perhitungan beban 

angin. 

Di mana faktor topografi: 

 𝐾𝑧𝑡 = (1 + 𝐾1 ∗ 𝐾2 ∗ 𝐾3)2 ........................................................................ (19) 

Di mana faktor ini khusus kategori eksposur C dapat menggunakan Tabel 2.5, 

dengan parameter mengikuti sesuai kasus pada Gambar 2.3 dan Gambar 2.4. Jika 

kondisi situs dan lokasi gedung dann bangunan lain tidak memenuhi semua 

kondisi yang disyaratkan, maka Kzt = 1.0.  

 

Gambar 1. 11. Faktor Topografi 

(Sumber: SNI 1727-2020) 

Di mana faktor ini khusus Kategori Eksposur C dapat menggunakan Tabel 

2.5, dengan parameter mengikuti sesuai kasus pada Gambar 2.3 dan Gambar 2.4. 

Jika kondisi situs dan lokasi gedung dann bangunan lain tidak memenuhi semua 

kondisi yang disyaratkan, maka Kzt = 1.0.  

- Efek Tiupan Angin 

Faktor Efek Tiupan Angin (G) 

Faktor efek-tiupan angin untuk suatu bangunan gedung dan struktur lain yang 

kaku boleh diambil sebesar 0,85. 

- Faktor elevasi permukaan tanah, Ke (Pasal 26.9) 

Faktor elevasi dasar untuk menyesuaikan dengan densitas udara, Ke, di mana 

dapat ditentukan berdasarkan elevasi. Secara konservatif faktor elevasi dasar 

untuk seluruh elevasi dapat diambil, Ke = 1. 
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- Koefisien tekanan internal, GCpi (Pasal 26-13) 

Koefisien tekanan internal, Gcpi dapat ditentukan berdasarkan klasifikasi 

ketertutupan bangunan yang direncanakan. Koefisien tekanan internal bisa 

didapatkan pada Tabel 26.13-1 SNI 1727-2020 yang juga tercantum sebagai 

berikut: 

Tabel 1. 5. 

Koefisien Tekanan Internal, Gcpi untuk Berbagai Klasifikasi Ketertutupan Bangunan 

 

d. Menentukan Koefisien Eksposur Tekanan Velositas, Kz dan Kh (Pasal 26.10) 

Berdasarkan kategori eksposur yang ditentukan dalam tabel berikut, koefisien 

eksposur tekanan velositas Kz atau Kh, sebagaimana yang berlaku. Untuk situs yang 

terletak pada zona transisi antara kategori eksposur yang dekat terhadap perubahan 

oleh akibat kekasaran permukaan tanah, diizinkan untuk menggunakan nilai konversi 

dari Kz atau Kh. 
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Tabel 1. 6. 

Koefisien Eksposur Tekanan Velositas, Kh dan Kz

 

Koefisien eksposur tekanan velositas Kz dapat ditentukan dari data ketinggian 

dan tipe esposur bangunan yang bisa dilihat pada tablel Tabel 1. 7. Koefisien 

Eksposur Tekanan Velositas. 

e. Menentukan Tekanan Velositas qz dan qh 

Tekanan velositas, qz, dievaluasi pada ketinggian z dihitung dengan persamaan 

berikut: 

𝑞𝑧 = 0,613 ∗ 𝐾𝑧 ∗ 𝐾𝑧𝑡 ∗ 𝐾𝑑 ∗ 𝐾𝑒 ∗ 𝑉2 ......................................................... (1.20) 

Di mana: 

qz = Tekanan kecepatan pada ketinggian z (N/m2) 

Kz = Koefisien papan tekanan kecepatan = variatif 

Kzt = Faktor topografi 

Kd = Faktor arah angin 

Ke = Faktor elevasi dasar tanah 

VC = Kecepatan angin rencana 

G = faktor efek-tiupan angin 
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f. Menentukan Koefisien Tekanan Eksternal Cp atau Cn 

Koefisien tekanan eksternal untuk atap pelana, atap perisai, atap miring 

sepihak, dan atap mansard yang biasa digunakan pada bangunan industri bisa 

didapatkan pada Gambar 27.3-1 SNI 1727-2020 sebagai berikut. 

Tabel 2.2 Koefisien Tekan dinding, Cp 

 

Tabel 2.2 Koefisien Tekan dinding, Cp 

 

Gambar 1. 12. Sistem Penahan Gaya Angin Utama, Bagian 1 (seluruh 

ketinggian): koefisien tekanan eksternal, Cp , untuk bangunan tertutup dan 

bangunan tertutup sebagian dinding dan atap (Sumber: SNI 1727-2020) 

g. Menentukan Tekanan Angin untuk Bangunan Gedung 

Tekanan angin desain untuk semua ketinggian ditentukan persamaan berikut: 

𝑝 =  𝑞ℎ ∗ [(𝐺𝐶𝑝𝑓) −  (+/−𝐺𝐶𝑝𝑖)] (kPa) .......................................................... (1.21) 

Di mana: 

q = qz, untuk dinding di sisi angin datang yang diukur pada 

ketinggian z di atas permukaan tanah 

q = qh, untuk dinding di sisi angin pergi, sisi, dan atap, yang diukur 

pada ketinggian h di atas permukaan tanah 

qi = qz, untuk tekanan internal bangunan gedung tertutup dan 

tekanan internal negatif bangunan tertutup sebagian 
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qi  = qh, untuk tekanan internal positif pada bangunan gedung 

tertutup sebagian bila tinggi z ditentukan sebagai level bukaan 

tertinggi pada bangunan gedung 

G = Faktor efek tiupan angin 

Cp  =  Koefisien tekanan eksternal. 

 

 

 

5. Beban Gempa (Seismic Load) 

Dalam penentuan beban gempa, ada 3 pendekatan untuk Analisa beban gempa 

yaitu, Analisa gaya lateral ekuivalen, analisa berdasarkan respon spektrum dan respon 

Riwayat waktu seismik.  
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Tabel 2.12 

Prosedur Analisa yang Diizinkan 

 

Langkah-langkah dalam penentuan beban gempa berdasarkan analisa gaya lateral 

ekuivalen harus dilakukan sesuai SNI 1726:2019 yaitu sebagai berikut: 

a. Peta Zonasi Gempa Indonesia 

Wilayah Indonesia dipetakan berdasarkan tingkat risiko gempanya, yang 

ditentukan atas dasar besarnya percepatan puncak batuan dasar (Peak Ground 

Acceleration, PGA). Berdasarkan SNI 1726:2019, pengaruh beban gempa rencana yang 

harus ditinjau dalam perencanaan ditetapkan sebagai gempa dengan kemungkinan 

terlampaui besarannya selama umur struktur bangunan 50 tahun adalah sebesar 2%. 

Beban gempa ditentukan berdasarkan peta gempa maksimum yang dipertimbangkan 

risiko-tertarget (Maximum Considered Earthquake, MCER) dengan parameter-parameter 

gerak tanah Ss dan S1. Ss adalah parameter nilai percepatan respons spektral gempa 

MCER pada periode pendek, teredam 5%, dan S1 adalah parameter nilai percepatan 

respons spektral gempa MCER pada periode 1 detik, teredam 5%, seperti yang 

ditunjukkan pada gambar berikut: 
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Gambar 1. 13.   Parameter Gerak Tanah Ss, Gempa Maksimum yang Dipertimbangkan Risiko-

Tertarget (MCER) Wilayah Indonesia Untuk Spektrum Respons 0,2-Detik 

(Redaman Kritis 5 %) 

(Sumber: SNI 1726-2019) 

 

Gambar 1. 14.    Parameter Gerak Tanah, S1, Gempa Maksimum yang Dipertimbangkan Risiko-

Tertarget (MCER) Wilayah Indonesia Untuk Spektrum Respons 1-Detik 

(Redaman Kritis 5 %) 

(Sumber: SNI 1726-2019) 
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b. Kategori Risiko dan Faktor Keutamaan Gempa, Ie 

Dalam SNI 1726-2019, struktur bangunan dibedakan berdasarkan tingkat risiko 

yang ditentukan berdasarkan fungsi dari bangunan tersebut. Kategori risiko bangunan 

dibagi dalam 4 tingkatan risiko yang menentuan besarnya faktor keutamaan gempa (Ie) 

yang akan digunakan. Penentuan kategori risiko dan faktor keutamaan gempa (Ie) dapat 

dilihat pada tabel sebagai berikut: 

Tabel 1. 8.  

Kategori Risiko bangunan gedung dan non gedung 
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Tabel 1. 9. 

Faktor Keutamaan Gempa, Ie 

 

c. Kelas Situs dan Koefisien Situs, Fa dan Fv 

Klasifikasi kelas situs ditentukan berdasarkan beberapa paremeter tanah pada 

kedalaman 30 m dari tanah asli, seperti hasil pengujian kecepatan rambat gelombang 

geser rata-rata pada regangan geser yang kecil (v̅s), hasil pengujian penetrasi standar rata-

rata (N̅) atau hasil pengujian penetrasi standar rata-rata tanah nonkohesif (N̅ch) dari data 

N-SPT, dan data kuat geser niralir rata-rata (s̅u) dari uji triaksial. Berdasarkan Pasal 5.3.3 

SNI 1726-2019 untuk penetapan kelas situs tanah keras (SC), tanah sedang (SD), dan 

tanah lunak (SE) harus ditentukan berdasarkan dua dari tiga parameter tersebut. Sehingga, 

apabila hanya digunakan satu parameter dan kelas situs termasuk dalam kriteria yang 

dimaksud pada pasal tersebut. Maka, kelas situs yang diperhitungkan adalah kelas situs 

terendah pada pasal tersebut, yaitu kelas situs tanah lunak (SE). Ketentuan mengenai 

kelas situs diatur pada Tabel 5 SNI 1726-2019 tentang Klasifikasi Situs. 

Tabel 1. 10. 

Klasifikasi Situs 

 



50 | Perencanaan Warehouse Sistem Pre Engineered Building (PEB) 

Tabel 1. 11. 

Koefisien Situs, Fa 

 

Tabel 1. 12.  

Koefisien Situs, Fv 

 

d. Kategori Desain Seismik (KDS) 

Penentuan kategori desain seismik dilakukan berdasarkan kategori risiko serta 

parameter respons spektral desain, SDS dan SD1 seperti ditunjukkan pada tabel berikut: 

Tabel 1. 13. 

Kategori Desain Seismik Berdasarkan Parameter Respons Percepatan Periode Pendek 
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Tabel 1. 14. 

Kategori Desain Seismik Berdasarkan Parameter Respons Percepatan Periode 1 Detik 

 

Menentukan periode getar struktur (T) 

Menentukan nilai Cu pada tabel dibawah ini 

Tabel 2. 12 

Koefisien untuk batas atas pada periode yang dihitung 

 

 

Periode fundamental pendekatan (Ta) ditentukan dari persamaan berikut: 

Ta = Ct x hn
x .............................................................................................................. (1.22) 

Dengan hn adalah ketinggian struktur (m) 

Tabel Nilai parameter periode pendekatan Ct dan x 

 



52 | Perencanaan Warehouse Sistem Pre Engineered Building (PEB) 

Tmax = Cu x Ta  ........................................................................................................ (1.23) 

T (periode fundamental struktur) diambil dari hasil output software Analisa dan dikontrol 

dan tidak lebih dari Tmax 

• Menentukan koefisien respon seismik (Cs) 

koefisien respon seismik (Cs) 

Cs =  
𝑆𝐷𝑆

(
𝑅

𝐼𝑒
)
 .................................................................................................. (1.24) 

 

Csmax =  
𝑆𝐷𝑆

𝑇(
𝑅

𝐼𝑒
)
 ................................................................................................ (1.25) 

 

Csmin =  0,044 x SDS x Ie  ............................................................................ (1.26) 

 

Nilai koefisien respon seismik (Cs) diambil dari tiga persamaan diatas. 

 

• Menentukan gaya dasar seismik (V) 

Gaya geser dasar seismik, V, dalam arah yang ditetapkan harus ditentukan 

sesuai dengan persamaan berikut: 

V = Cs x W  .............................................................................................. (1.27) 

Di mana W adalah berat seismik efektif struktur menyertakan seluruh beban 

mati dan beban lainnya yang sudah diatur pada SNI 1226-2019 pasal 7.2.2 . 

E. KOMBINASI PEMBEBANAN 

Kombinasi pembebanan digunakan untuk menentukan gaya dalam yang bekerja 

pada seluruh elemen struktur, seperti pelat lantai, balok, kolom, dan tangga dengan 

menggunakan metode LRFD (Load and Resistant Factor Design). Berbagai kondisi yang 

mungkin terjadi pada struktur yaitu kombinasi dari Beban Mati (Dead Load), Beban 

Hidup (Live Load), Beban Angin (Wind Load), dan Beban Gempa (Earthquake Load). 
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Kombinasi pembebanan yang digunakan didasarkan pada SNI 1726-2019. Kombinasi 

pembebanan tersebut adalah sebagai berikut: 

1. 1.4D 

2. 1.2D + 1.6L + 0.5 (Lr atau R) 

3. 1.2D + 1.6 (Lr atau R) + (L atau 0.5W) 

4. 1.2D + 1.0W + L + 0.5 (Lr atau R) 

5. 0.9D + 1.0W 

6. 1.2D + 1.0Ev + 1.0Eh + L 

7. 0.9D + 1.0Ev + 1.0Eh 

Keterangan: 

D =  Beban mati + Beban mati tambahan 

L  =  Beban hidup lantai 

Lr =  Beban hidup atap 

Ρ  = Faktor Redundansi 

Pengaruh beban seismik horizontal, Eh , harus ditentukan sesuai Eh = ρQe 

Pengaruh beban seismik horizontal, Ev , harus ditentukan sesuai Ev = 0,2SDSD 

F. BATAS LENDUTAN 

1. Atap (Roofing) 

Fokus pengecekan lendutan pada atap ada 3 bagian yaitu: 

a. Tengah bentang atap 

b. Ujung atap 

c. Daerah yang berpotensi mengalami rembesan 

Terdapat dua jenis atap yang umum digunakan, yaitu atap membran dan atap metal. 

Lendutan yang diizinkan di atap berdasarkan beban yang bekerja dapat dilihat pada Tabel 

di bawah ini. 
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Tabel 1. 15. 

Batasan Lendutan Izin pada Atap 

Struktur atap: Hidup Angin Mati + Hidup 

Elemen Struktur Atap    

Menopang ceiling dengan plaster L/360 L/360 L/240 

Menopang ceiling dengan tanpa 

plaster 

L/240 L/240 L/180 

Tidak menopang ceiling L/180 L/180 L/120 

Struktur atap menopang metal 

roofing 

L/150 
 

L/60 

Struktur penopang lantai L/360 
 

L/240 

Struktur penopang dinding dan 

partisi interior 

   

Dengan finishing yang rapuh 
 

L/240 
 

Dengan finishing yang fleksibel 
 

L/120 
 

Struktur penopang dinding 

sekunder yang menopang penutup 

logam 

 
L/90 

 

(Sumber: Design Guide 3: Serviceability Design Consideration for Steel Building, 2003) 

a. Lendutan Vertikal  

Defleksi vertikal yang berlebih dan penyimpangan (misalignment) yang muncul 

terutama dari tiga sumber: (1) beban gravitasi (DL+LL), (2) efek temperatur, rangkak, 

dan perbedaan penurunan, dan (3) toleransi dan kesalahan konstruksi. Secara historis, 

batas defleksi izin untuk komponen horizontal adalah 1/360 dari bentang yang memikul 

beban hidup nominal penuh dan 1/240 dari bentang untuk komponen atap. Defleksi 

sebesar 1/300 dari bentang (untuk kantilever, 1/150 dari panj ang) dapat terlihat dan 

menyebabkan kerusakan arsitektur secara umum atau kebocoran pada klading. 
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G. PENGECEKAN TERHADAP ASPEK KEGEMPAAN 

1. Bentuk dan Jumlah Ragam 

Ragam getar harus berbetuk tranlasional untuk dua arah ortogonal dan rotasi 

terhadap sumbu vertikal. Ragam getar ini dapat dianalisis dengan menggunakan software 

metode elemen hingga. Partisipasi massa ragam juga harus dicek persentasenya terhadap 

SNI 1726-2019. Pada peraturan tersebut, tepatnya pada Pasal 7.9.1.1 ditentukan bahwa 

partisipasi massa ragam harus 100% dari massa struktur. Namun, terdapat pengecualian 

bahwa analisis diizinkan untuk mencapai paling sedikit 90% dari massa aktual dalam arah 

horizontal ortogonal dari model. 

 

Gambar 1. 15. Derajat Kebebasan pada Tiap Lantai 

(Sumber: Imam Satyarno. dkk, 2012) 

Jumlah ragam dapat diasumsikan secara konservatif sebesar tiga kali jumlah lantai. 

Hal ini didasari ketentuan bahwa setiap lantai memiliki tiga derajat kebebasan yaitu 

translasi arah-x, translasi arah-y, dan rotasi. Jumlah ragam tersebut tentunya harus 

kembali dicek terhadap syarat partisipasi massa ragam. 

2. Simpangan Antar Tingkat 

Gaya gempa lateral akan menyebabkan simpangan struktur pada arah lateral di 

masing-masing lantai. SNI 1726-2019 memberikan pembatasan simpangan lateral antar 

tingkat untuk menjamin stabilitas struktur, dan mencegah kerusakan elemen non 

struktural. Simpangan antar tingkat ditentukan berdasarkan perbedaan simpangan pada 

pusat massa di tingkat yang ditinjau dengan tingkat di bawahnya. Adapun persamaan 

simpangan pada pusat massa yang digunakan adalah sebagai berikut: 

𝛿𝑥 =
𝐶𝑑×𝛿𝑥𝑒

𝐼𝑒
 ....................................................................................... (1.28) 
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Dengan: 

Cd =  Faktor pembesaran defleksi 

δxe =  Simpangan di lantai yang ditinjau yang diakibatkan oleh 

gaya gempa lateral (biasanya ditentukan dengan 

menggunakan program) 

Ie  =  Faktor keutamaan gempa 

 

(Sumber: SNI 1726-2019) 

Simpangan antar tingkat yang dihitung tidak boleh melebihi batas simpangan antar 

tingkat izin (Δa) yang ditentukan oleh SNI 1726-2019 pada tabel di bawah. 

Tabel 1. 16. 

Simpangan Antar Tingkat Izin 

Struktur 
Kategori Resiko 

I atau II III IV 

Struktur, selain dari struktur dinding geser batu 

bata, 4 tingkat atau kurang dengan dinding 

interior, partisi, langit langit dan sistem dinding 

0,025hsx
c 0,020hsx 0,015hsx 
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Struktur 
Kategori Resiko 

I atau II III IV 

eksterior yang telah didesain untuk 

mengakomodasi simpangan antar lantai tingkat. 

Struktur dinding geser kantilever batu batad. 0,010hsx 0,010hsx 0,010hsx 

Struktur dinding geser batu bata lainnya. 0,007hsx 0,007hsx 0,007hsx 

Semua struktur lainnya. 0,020hsx 0,015hsx 0,010hsx 

 

Catatan: 

a hsx adalah tinggi tingkat di bawah tingkat-x 

b Untuk sistem pemikul gaya seismik yang terdiri dari hanya rangka momen b 

dalam kategori desain seismik D, E, dan F, simpangan antar tingkat izin  

b harus sesuai dengan Pasal 7.12.1.1 SNI 1726-2019 

c Tidak boleh ada batasan simpangan antar tingkat untuk struktur satu tingkat 

dengan dinding interior, partisi, langit-langit, dan sistem dinding eksterior 

yang telah didesain untuk mengakomodasi simpangan antar tingkat. 

Persyaratan pemisahan struktur dalam 7.12.3 tidak diabaikan. 

d Struktur di mana sistem struktur dasar terdiri dari dinding geser batu bata 

yang didesain sebagai elemen vertikal kantilever dari dasar atau pendukung 

fondasinya yang dikontruksikan sedemikian agar penyaluran momen di 

antara dinding geser (kopel) dapat diabaikan. 

Terdapat ketentuan lain pada Pasal 7.12.1.1 yang menjelaskan bahwa untuk sistem 

pemikul gaya seismik yang terdiri dari hanya rangka momen pada struktur yang didesain 

untuk kategori desain seismik D, E, atau F, simpangan antar tingkat desain (Δ) tidak boleh 

melebihi Δa/ρ untuk semua tingkat, nilai ρ harus ditentukan berdasarkan Pasal 7.3.4.2 

SNI 1726-2019. 
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3. Pengecekan P-Delta 

P-Delta merupakan pengaruh yang ditimbulkan oleh pergerakan lateral kolom 

akibat pengaruh beban aksial dan horizontal. Pergerakan lateral ini akan menimbulkan 

momen sekunder pada daerah sekitar balok dan kolom, serta penambahan simpangan 

lantai. P-Delta berpengaruh pada geser dan momen yang dihasilkan pada masing-masing 

tingkat, momen elemen struktur, dan simpangan antar tingkat. P-Delta bisa diabaikan 

dengan syarat koefisien stabilitas (θ) kurang dari atau sama dengan 0,1. 

  𝜃 = (𝑃𝑥 × ∆ × 𝐼𝑒)/ ( 𝑉𝑥 × ℎ𝑠𝑥 × 𝐶𝑑) ............................................................... (1.29) 

Dengan: 

𝜃 =  Koefisien stabilitas 

Px = Beban desain vertikal total pada dan di atas tingkat x, bila 

menghitung Px faktor beban individu < 1,0 

∆ =  Simpangan antar lantai tingkat desain, terjadi secara 

serentak dengan Vx 

Ie =  Faktor keutamaan gempa 

Vx =  Gaya geser seismik yang bekerja antara tingkat x dan x-1 

hsx =  Tinggi tingkat di bawah tingkat x 

Cd =  Faktor pembesaran defleksi 

Koefisien stabilitas juga harus dicek terhadap nilai maksimal yang ditentukan 

berdasarkan persamaan sebagai berikut: 

Dengan: 

𝜃 =  Koefisien stabilitas 

θmax = Koefisien stabilitas maksimal 

Px = Beban desain vertikal total pada dan di atas tingkat x, bila 

menghitung Px faktor beban individu < 1,0 

𝛽 =  Rasio kebutuhan geser terhadap kapasitas geser untuk 

tingkat x dan x-1. Rasio ini diizinkan secara konservatif 

diambil sebesar 1,0 

Cd =  Faktor pembesaran defleksi 
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Untuk koefisien stabilitas 0,1 < θ < θmax, faktor peningkatan akibat P-Delta 

ditentukan berdasarkan analisis rasional. Faktor pengali perpindahan dan gaya komponen 

struktur ditentukan dengan 1/(1- θ). Untuk struktur dengan θ > θmax, perlu didesain ulang 

karena struktur tidak cukup stabil. 
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PEMODELAN 

STRUKTUR 

  

 

A. PERANGKAT LUNAK ETABS 

Dalam proses perencanaan struktur ETABS jamak 

digunakan oleh para insinyur karena kemudahan pemakaian 

dan keandalannya. Program ETABS ini pertama kali 

dikembangkan oleh perusahaan perangkat lunak 

terkemuka, Computers and Structures, di California, 

Amerika Serikat. Perkembangan program ini lahir dari riset 

yang diinisiasi oleh Dr. Edward L. Wilson pada tahun 1970 

di University of California, Berkeley. 

 

Gambar 2. 1. Software ETABS 

Elemen-elemen struktur pada suatu bangunan 

diidealisasikan oleh ETABS sebagai elemen garis (frame), 

elemen luasan (area), dan elemen titik (joint). Elemen-

elemen tersebut merepresentasikan elemen aslinya seperti 

balok, kolom, dinding lantai, pengaku dan lain sebagainya. 

Elemen-elemen ini kemudian dirangkai menjadi satu-

kesatuan dan dianalisis melalui metode elemen hingga yang 

digunakan program untuk menganalisis matriks kekakuan 

struktur.  

BAGIAN 

2 
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B. DATA UMUM BANGUNAN 

Struktur bangunan yang didesain memiliki data-data penunjang sebagai berikut: 

Lebar bangunan, B  = 72.975 m 

Panjang bangunan, L  = 135.85 m 

Jarak antar portal  = 10.45 m 

Tinggi kolom   = 18 m 

Tipe struktur   = Gable frame 

Jarak antar kolom post  = 10.425 m 

Sudut atap   = 2  derajat 

Fungsi bangunan  = Pabrik 
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Gambar 2. 20. Model 3d Warehouse  

C. MEMBUAT FILE BARU 

Langkah awal pemodelan dengan software ETABS adalah dengan membuat file 

baru dengan cara klik File–New Model atau bisa dilakukan melalui shortcut Ctrl+N.  

 

Gambar 2. 21. Pembuatan Model Baru pada ETABS 
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Sesuaikan parameter-parameter sesuai kode yang digunakan. Untuk proyek di 

Indonesia, peraturan yang digunakan biasanya mengacu pada peraturan di Amerika. 

SNI 1729-2020 → AISC 360-16 

SNI 2847-2019 → ACI 318-14/19 

 

Gambar 2. 22. Pemilihan Jenis Satuan dan Kode yang Ingin Digunakan 

Pada menu New Model Quick Template → pilih Blank. Terdapat beberapa pilihan 

lain seperti Grid Only yang dapat digunakan untuk membuat template dengan grid sesuai 

story dimension yang dimasukkan. 
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Gambar 2. 23. Tampilan Quick Model 

 

Gambar 2. 24. Tampilan Awal Model ETABS 

Untuk memudahkan proses pemodelan, atur beberapa template unit yang biasa 

digunakan dengan cara klik pada area pojok kanan bawah → Units → Consistent Units 

→ atur satuan panjang dan gaya yang diinginkan.   
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Gambar 2. 25. Atur Satuan Panjang dan Gaya 

Lalu simpan satuan yang telah diatur dengan cara klik kembali pada pojok kanan 

bawah → Units → Show Units Form → beri nama set satuan yang telah diatur dan 

simpan. 
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Gambar 2. 26. Display Units 

      

Gambar 2. 27. Simpan Unit Sets 

Simpan set 

satuan yang 

sudah diatur 
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Gambar 2. 28. Units Sets Sudah Muncul pada Units 

D. MEMBUAT GRID 

Selanjutnya untuk membuat Grid dan Story Data, klik Edit → Edit Stories and 

Grid Systems → Modify. Atur Jarak grid dan ketinggian yang digunakan. Cara lain untuk 

mengedit grid adalah dengan klik kanan → Add/Modify Grid System. 

 

Gambar 2. 29. Edit → Edit Stories and Grid Systems 
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Lalu tambahkan sistem grid baru dengan klik → Add New Grid System. 

  

Gambar 2. 30. Klik Kanan → Add/Modify Grid 

Grid untuk arah x dan y dapat ditambahkan dengan dua cara, memasukkan ordinat 

grid atau dengan cara memasukkan jarak antar grid. Akan dicoba cara input grid melalui 

jarak antar grid. Bangunan warehouse akan memiliki luas 72.98 m x 125.4 m dengan 

jarak antar kolom pada arah memanjang 10.45 m, sementara pada arah melintang dengan 

jarak antar kolom 10.425 m. 

 

Gambar 2. 31. Pengaturan Grid pada Arah X dan Y 
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Untuk grid arah vertikal bisa diatur pada opsi Modify/Show Story Data. Grid pada 

arah vertikal di-input berdasarkan elevasi pada lantai dasar , tie beam, lantai2 dan lantai 

3, pedestal kolom baja dan atap. 

 

Gambar 2. 32. Modify/Show Story Data 

 

Gambar 2. 33. Input Elevasi yang Dibutuhkan 
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Gambar 2. 34. Grid yang Telah Dibuat 

E. PENENTUAN PROPERTI MATERIAL 

Langkah selanjutnya ada penentuan material struktur. Material yang digunakan 

dalam perencanaan struktur menggunakan material beton, baja tulangan dan baja profil. 

Penentuan material dapat dilakukan dengan cara klik Define → Materials. 
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Gambar 2. 35. Define Materials 

Penentuan masing-masing properti material sebagai berikut: 

1. Material Beton 

Data: 

Mutu Beton, fc’   = 25 MPa 

Berat Jenis Beton Bertulang  = 2400 kg/m3 

Nilai modulus elastisitas beton ditentukan berdasarkan Pasal 19.2.2.1 SNI 2847-2019 

sebagai berikut: 

Modulus Elastisitas Beton, Ec = 4700 √(fc') = 4700 x √25 

     = 23500 MPa 

Nisbah Poison, μ   = 0.2 
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Gambar 2. 36. Penentuan Material Beton 
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2. Material Baja Tulangan 

Berdasarkan SNI 2847:2019, spesifikasi material baja tulangan memenuhi 

persyaratan pasal 20.2.5 adalah baja tulangan tulangan kelas BJTS 420B. Spesifikasi 

teknis dari baja tulangan kelas BJTS 420B dapat diketahui berdasarkan Tabel 6 SNI 2052-

2017 dengan sebagai berikut: 

Tabel 2. 1. 

Sifat Mekanis Baja Tulangan Berdasarkan SNI 2052-2017 

 

Berdasarkan data dari tabel di atas diketahui sifat mekanis BJTS 420B sebagai berikut: 

Mutu Baja Tulangan  = BJTD 420B 

Berat Jenis Tulangan  = 7850 kg/m3 

Modulus Elastisitas Baja, Es = 200.000 MPa 

Tegangan Leleh, Fy  = 420 MPa 

Tegangan Putus, Fu  = 525 MPa 
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Expected yield strength, Fye dan expected tensile strength, Fue untuk material baja 

tulangan bisa didapatkan berdasarkan Tabel 6-4 FEMA 356. Faktor konversi yang 

diberikan untuk kuat leleh dan yang diekspektasikan pada baja tulangan adalah 1,25. 

Tabel 2. 2. 

Faktor Konversi untuk Kuat Leleh dan Putus yang Diekspektasikan pada Baja Tulangan 

Berdasarkan FEMA 356 

 

Expected Yield Strength. Fye = 1.25 x 420 MPa = 525 MPa 

Expected Tensile Strength, Fue = 1.25 x 545 MPa = 681,25 MPa 
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Gambar 2. 37. Penentuan Material Baja Tulangan 
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3. Material Baja Profil Canai Panas 

Material baja profil yang digunakan adalah sebagai berikut: 

Data: 

Mutu Baja Profil   = ASTM-A572 GR 50 

Berat Jenis Baja   = 7850 kg/m3 

Modulus Elastisitas Baja, Es = 200.000 MPa 

Tegangan Leleh, Fy  = 345 MPa 

Tegangan Putus, Fu  = 450 MPa 

Expected yield strength, Fye dan expected tensile strength, Fue untuk material baja canai 

panas bisa didapatkan berdasarkan Tabel A.3-1 SNI 7860-2020. Faktor untuk 

mengkonversi kuat leleh menjadi untuk kuat leleh terekspektasi untuk baja canai panas 

A36 adalah 1,5, sementara untuk kuat putus baja, nilai konversi yang diberikan adalah 

1,2. 

Tabel 2. 3. 

Faktor Konversi untuk Kuat Leleh dan Putus yang Diekspektasikan pada Baja Canai Panas 

Berdasarkan SNI 7860-2020 

 

 

Expected Yield Strength, Fye = 1,1 x 345 MPa = 379,5 MPa 

Expected Tensile Strength, Fue = 1,1 x 450 MPa = 495 MPa 
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Gambar 2. 38. Penentuan Material Baja Canai Panas 

F. PENENTUAN PROPERTI PENAMPANG 

Ukuran penampang yang digunakan untuk elemen struktur yang direncanakan 

yaitu sebagai berikut: 

1. Kolom Beton 

K90.90   = 900X900 mm2 

K80.80   = 800X800 mm2 

2. Balok Beton 

B40.90   =  400X900 mm2 

B30.70   = 300x700 mm2 

3. Kolom Baja 

CBU64   = Bu (400-600)X300X8x12 

4. Rafter 

BBU64   = BBu -(1000-600)X300X6x12 

BBU64   = Bu - 600X300X6x12 

5. Purlin 

Double CNP 200  = 2CNP 200x75x20x3,2 
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6. Ring Beam (Regel) dan Nok Atap 

WF 400   = WF.400X200X8X13 

7. Wind Bracing  = Rod 25 mm 

Penentuan dimensi penampang/profil baja dilakukan dengan cara klik Define–

Section Properties–Frame Sections–Add New Property. Tentukan tipe profil baja pada 

pilihan Section Type seperti sebagai berikut: 

 

Gambar 2. 39. Define–Section Properties–Frame Sections–Add New Property 

Terdapat empat template pilihan profil untuk baja, yaitu, profil I/Wide Flange 

Section yang dapat digunakan untuk pemodelan profil I-WF (I-Wide Flange) dan HB (H-

Beam), Channel Section yang dapat digunakan untuk pemodelan profil UNP, Tube 

Section yang dapat digunakan untuk pemodelan profil RHS (Rectangular Hollow Section) 
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atau SHS (Square Hollow Section), serta profil Pipe Section yang dapat digunakan untuk 

pemodelan profil pipa. ETABS juga mengakomodir profil-profil lain seperti Double 

Angle Equal Section dan lain sebagainya. 

 

Gambar 2. 40. Beberapa Template Bentuk Profil yang Diakomodir ETABS 

Pemodelan profil I (400-600)X300X8x12 sebagai berikut: 

• Modeling profil Bu 600x300x8x12 

 

Gambar 2. 41. Pemodelan Bu.600X300X8x12 



Pemodelan Struktur | 99 

• Modeling profil Bu 400x300x8x12 

 

Gambar 2. 42. Pemodelan Bu. 400X300x8x12 

• Modeling profil I (400-600)X300X8x12 

 

Pilih yang 

nonpresmatic section  
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Gambar 2. 43. Pemodelan profil CBu (400-600)X300X8x12 
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Pemodelan profil I-(1000-600)X300X6x12 sebagai berikut: 

• Modeling profil Bu 1000x300x6x12 

 

Gambar 2. 44. Pemodelan Bu 1000X300X6x12 
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• Modeling profil Bu 600x300x6x12 

 

Gambar 2. 45. Pemodelan Bu 600X300X6x12 
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• Modeling profil BBu-(1000-600)X300X6x12 

 

Gambar 2. 46. Pemodelan BBu-(1000-600)X300X6x12 
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Pemodelan profil Bu- 600X300X6x12 

 

Gambar 2. 47. Pemodelan Bu- 600X300X6x12 
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Pemodelan profil WF.400X200X8X13 

 

Gambar 2. 48. Pemodelan profil WF.400X200X8X13 

 

Pemodelan profil 2CNP 200x75x20x3,2 

Untuk memodelkan profil 2CNP 200x75x20x3,2 karena tidak ada di model, bisa 

dimodelkan di section designer dengan cara Define – Section Properties – Frame 

Sections – Add New Property – section designer. 

   

Gambar 2.2 Pemodelan  

Section designer 



106 | Perencanaan Warehouse Sistem Pre Engineered Building (PEB) 

Selanjutnya modelkan profil 2CNP 200x75x20x3,2 dengan cara Draw steel 

shape – Draw Chaneel, kemudian isikan profil chanel sesuai ukuran profil 

 

Gambar 2.2 Pemodelan  

Kemudian setelah termodelkan profil chanel, mirror profil tersebut sehingga 

menjadi profil double chanel dengan cara Edit–Replicate–Mirror–Pilih yang Y Axis. 

 

Gambar 2.2 Pemodelan  

Kemudian tambahkan profil plat lipeed di atas dan di bawah profil tersebut dengan 

cara Draw steel shape–Draw plate–isikan dimensi plat sesuai dimensi lipped chanel 

dengan memperhatikan koordinat. Setelah itu, dengan cara yang sama tambahkan plat 

lipeed lagi dengan koordinat yang berbeda. 
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Gambar 2.2 Pemodelan  

 

 

Gambar 2. 49. Pemodelan CNP. 200X75X20X3,2 
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Pemodelan profil Rod 25 mm 

 

Gambar 2. 50. Pemodelan Rod 19 mm 

Pemodelan Penampang Profil material Beton 

Profil Kolom 

Kolom beton bertulang dibutuhkan untuk menopang kolom baja utama dan kolom 

post. Untuk struktur beton bertulang, kekakuan struktur perlu direduksi dengan beberapa 

faktor berdasarkan Tabel 6.6.3.1.1(a) atau Tabel 6.6.3.1.1(b) SNI 2847-2019. Secara 

konservatif faktor reduksi penampang dapat diambil berdasarkan Tabel 6.6.3.1.1(a) SNI 

2847-2019 sebagai berikut: 
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Tabel 2. 4. 

Momen Inersia dan Luas Penampang yang Diizinkan Untuk Analisis 

Elastis Pada Level Beban Terfaktor 

Bagian dan Kondisi Momen Inersia Luas Penampang 

Kolom 0.7 Ig 

1.0 Ag 
Dinding 

Tidak Retak 0.7 Ig 

Retak 0.35 Ig 

Balok 0.35 Ig 

Pelat datar dan slab datar 0.25 Ig 

 

Penentuan properti penampang kolom dapat dilakukan dengan Define – Section 

Properties – Frame Sections – Add New Property – Concrete Rectangular. Properti 

penampang dapat ditentukan sebagai berikut. 

 

Properti Kolom K80X80 

Mutu Material  =  K-300 (fc’ = 24.9 MPa) 

Mutu Baja Tulangan = BJTS420B 

Di awal jumlah tulangan untuk kolom diasumsikan sebesar 1%Ag, sehingga: 

Tinggi kolom, c1  = 800 mm 

Lebar kolom, c2  = 800 mm 

Luas kolom, Ag  = c1 x c2 = 640000 mm2 

Rasio penulangan, ρ  = 1%  

Luas tulangan yang dibutuhkan  As = 1%Ag 

As = 6400 mm2 

Dimensi tulangan    db = 25 

Luas tulangan     As1 = 490.87 mm2 

Jumlah tulangan    n = 14  

Faktor modifikasi kekakuan = 0,7 
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Gambar 2. 51. Pemodelan Penampang Kolom K80X80 
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Gambar 2. 52. Modifikasi Kekakuan untuk K80X80 

 

Properti Kolom K90X90 

Mutu Material  =  K-300 (fc’ = 24.9 MPa) 

Mutu Baja Tulangan = BJTS420B 

Di awal jumlah tulangan untuk kolom diasumsikan sebesar 1%Ag, sehingga: 

Tinggi kolom, c1  = 900 mm 

Lebar kolom, c2  = 900 mm 

Luas kolom, Ag  = c1 x c2 = 810000 mm2 

Rasio penulangan, ρ  = 1%  

Luas tulangan yang dibutuhkan  As = 1%Ag 

As = 8100 mm2 

Dimensi tulangan    db = 25  

Luas tulangan     As1 = 490.87 mm2 

Jumlah tulangan    n = 18  

Faktor modifikasi kekakuan = 0,7 
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Gambar 2. 53. Pemodelan Penampang Kolom K90X90 
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Gambar 2. 54. Modifikasi Kekakuan untuk K90X90 

 

Profil Balok  

Properti Beam B40/90 

Mutu Material   =  K-300 (fc’ = 24.9 MPa) 

Mutu Baja Tulangan  = BJTS420B 

Dia. Tulangan Geser, ds = 10 mm 

Dia. Tulangan Long., db = 16 mm 

Clear cover, cc   = 40 mm 

Cover to longitudinal bar = cc + ds + db 

    = 40 + 10 + 0,5*16 

    =  58 mm 

Faktor modifikasi kekakuan = 0,35 
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Gambar 2. 55. Pemodelan Penampang Balok B40X90 
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Properti Beam B30/70 

Mutu Material   =  K-300 (fc’ = 24.9 MPa) 

Mutu Baja Tulangan  = BJTS420B 

Dia. Tulangan Geser, ds = 10 mm 

Dia. Tulangan Long., db = 16 mm 

Clear cover, cc   = 40 mm 

Cover to longitudinal bar = cc + ds + db 

    = 40 + 10 + 0,5*16 

    =  58 mm 

Faktor modifikasi kekakuan = 0,35 
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Gambar 2. 56. Pemodelan Penampang Balok B30X70 

Properti Tie Beam TB25/60 

Mutu Material   =  K-300 (fc’ = 25 MPa) 

Mutu Baja Tulangan  = BJTS420B 

Dia. Tulangan Geser, ds = 10 mm 

Dia. Tulangan Long., db = 16 mm 

Clear cover, cc   = 40 mm 

Cover to longitudinal bar = cc + ds + db 

    = 40 + 10 + 0,5*16 

    =  58 mm 

Faktor modifikasi kekakuan = 0,35 
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Gambar 2. 57. Pemodelan Penampang TB 25.60 
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Gambar 2. 58. Modifikasi Kekakuan untuk TB25/60 

G. PEMODELAN KOLOM K90X90 DAN K80X80 PADA LANTAI 1 

Permodelan elemen kolom dilakukan dengan cara klik Draw → Draw 

Beam/Column/Brace Objects → Quick Draw Column. Akan muncul tampilan seperti di 

bawah ini. Tentukan Section Properties kolom yang akan digunakan dan arah Kolom. 

Pilih All Stories pada bagian pojok kanan bawah. 

 

 

Gambar 2. 59. Draw Kolom K80X80 dan 90X90  
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Masuk ke elevasi Potongan yang akan kita modelkan di mana K900X90 dan 

K80X80 sebagai kolom , caranya dengan klik View → Set Elevation View → Pilih X13. 

Lalu drag kursor di posisi di mana kolom dibutuhkan. 

 

Gambar 2. 60. Set Elevation View 

 

Gambar 2. 61. Titik Kolom Lantai 1 K90X90 

Posisi Kolom 

lt1 K90x90 
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Gambar 2. 62. Titik Kolom Lantai 1 K80X80 

 

Posisi Kolom 
lt1 K80x80 
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Gambar 2. 63. Pemodelan kolom View X13 

Dengan cara sama modelkan semua kolom K 80x80 dan 90x90 ke semua lokasi 

yang akan kita modelkan dengan mengganti Set Elevation View. Setelah semua kolom 

lantai 1 sudah termodelkan, kembali ke tampilan 3d, dengan set default 3D view kemudian 

kita bisa melihat hasil pemodelan secara realistis dengan memilih extruded View Toggle. 
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Gambar 2. 64. Kolom 80x80 dan 90x90 yang sudah Termodelkan 

Di permodelan awal, apabila secara default tumpuan kolom akan bertipe sendi 

(pinned). Tumpuan kolom perlu diubah menjadi tumpuan jepit dengan cara Select joint 

bawah dari kolom → Assign → Restraints → Fixed. 

Posisi Kolom 

lt1 K80x80 

Posisi Kolom 

lt1 K90x90 
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Gambar 2. 65. Merubah Tumpuan Kolom Menjadi Jepit 

H. PEMODELAN BALOK ANAK DAN BALOK INDUK LANTAI 2 B 30/70 DAN 

B 40/90 

Untuk pemodelan balok langkah pertama yang perlu dilakukan adalah masuk ke 

elevasi +6 Mezzanin dengan cara klik View → Set Plan View → Pilih Lantai 2. Dari view 

plan yang telah ada, kolom bisa langsung dimodelkan dengan opsi klik Draw → Draw 

Beam/Column/Brace Objects → Quick Draw Beam. 
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Gambar 2. 66. Mengganti evelvasi Ke Lantai 2  
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Adapun properti kolom yang dimodelkan perlu ditentukan saat opsi Quick Draw 

Column sudah diaktifkan. Properti B 40x90 dan B 30x70 disajikan sebagaimana gambar 

berikut. 

 

 

 

Gambar 2. 67. Properties Balok 40x90 dan 30x70 yang Dimodelkan 

  

Gambar 2. 68. Titik Balok 40x90 Pada Lantai 2 

Posisi B40/90 
(warna merah) 
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Gambar 2. 69. Posisi Balok Utama 30x70 Pada Lantai 2  

 

Gambar 2. 70. Balok yang Telah dimodelkan Pada Lantai 2 

  

Posisi B30/70 

(warna Hijau) 
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I. PEMODELAN SLAB S150 

Untuk pemodelan slab langkah pertama yang perlu dilakukan adalah masuk ke 

elevasi lantai 2 dengan cara klik View → Set Plan View → Pilih lantai 2 . Dari view plan 

yang telah ada, kolom bisa langsung dimodelkan dengan opsi klik Draw → Draw 

Floor/wall → Quick Draw Floor/wall. 

 

 

Gambar 2. 71. Properties Slab 150  
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Gambar 2. 72. Pemodelan Slab 150 Pada Lantai 2 

J. PEMODELAN KOLOM K90X90 DAN K80X80 PADA LANTAI 2 

Permodelan elemen kolom lantai 2 sama seperti pemodelan pada lantai 1 yaitu 

dilakukan dengan cara klik View→Set Elevation View→Pilih X13. klik Draw → Draw 

Beam/Column/Brace Objects → Quick Draw Column lalu drag kursor di posisi di mana 

kolom yang dibutuhkan. Setelah kolom di grid X13 sudah termodelkan dengan cara yang 

sama ulangi di grid yang lain. Atau juga bisa me-replicate kolom tersebut. 

 

Gambar 2. 73. Pemodelan Kolom grid x13 
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Gambar 2. 74. Pemodelan Kolom Lantai 2 

K. PEMODELAN BALOK ANAK DAN BALOK LANTAI 3 

Untuk pemodelan balok lantai 3 sama seperti pemodelan balok pada lantai 2. 

Dengan cara klik View→Set Plan View→Pilih Elevasi lantai 3 +11 . Dari view plan yang 

telah ada, kolom bisa langsung dimodelkan dengan opsi klik Draw→Draw 

Beam/Column/Brace Objects→Quick Draw Beam.  
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Gambar 2. 75. Pemodelan Balok 40x90 Pada Lantai 3  

  

Gambar 2. 76. Pemodelan Balok Utama 30x70 Pada Pada Lantai 3 

 

 

 

 

Posisi B40/90 

(warna merah) 

Posisi B30/70 
(warna Hijau) 
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Gambar 2. 77. Balok yang Telah dimodelkan Pada lantai 3 

L. LPEMODELAN SLAB LANTAI 3 (S150) 

Untuk pemodelan slab langkah pertama yang perlu dilakukan adalah masuk ke 

elevasi +11 Lantai 3 dengan cara klik View→Set Plan View→Pilih Lantai 3 +11. Dari 

view plan yang telah ada, kolom bisa langsung dimodelkan dengan opsi klik Draw → 

Draw Floor/wall → Quick Draw Floor/wall. 

 

 

Gambar 2. 78. Properties Slab 150 Pada Lantai 3 
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*

 

Gambar 2. 79. Slab 150 yang Telah dimodelkan Pada Lantai 3 

M.  PEMODELAN KOLOM BAJA DAN RAFTER  

Sebelum memodelkan rafter, hal yang terlebih dahulu perlu dilakukan adalah 

mengatur elevation view di mana rafter akan dimodelkan. Hal tersebut dapat dilakukan 

dengan cara klik opsi View→View→Set Elevation View→Pilih x10, untuk menampilkan 

Frame Axis x10 (arah melintang). 
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Gambar 2. 80. Masuk Ke Grid X10 

 

Gambar 2. 81. Tampilan Grid X10 

 



134 | Perencanaan Warehouse Sistem Pre Engineered Building (PEB) 

Modelkan kolom pedestal beton terlebih dahulu langkah dengan cara klik Draw 

→ Draw Beam /Colom → Pilih profil yang digunakan sebagai kolom pedestal → lalu 

drag kursor di posisi di mana kolom yang dibutuhkan.  

 

Gambar 2. 82. Kolom Pedestal yang Termodelkan 

Setelah modelkan kolom pedestal beton dengan cara yang sama modelkan kolom 

dan rafter dengan klik Draw → Draw Beam /Colom → Pilih profil yang digunakan 

sebagai kolom dan rafter → lalu drag kursor di posisi di mana kolom dan rafter yang 

dibutuhkan.  

 

 

Gambar 2. 83. Kolom dan rafter yang Telah dimodelkan 
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 Potong kelebihan batang kolom yang dimodelkan dengan cara, selec kolom 

beserta ujung kolom dan rafter yang ingin kita potong, klik Edit → align Joint /Frame 

/Edges → Trim Frame. 

 

 

 

 

Gambar 2. 84. Trime Frame pada Kolom  

Bagi/ potong rafter setiap bertemu dengan kolom sesuai pemodelan di lapangan 

dengan cara select rafter dan kolom yang akan kita potong klik Edit→Edit 

Frames→Break at Intersection with selected frames and joints.  
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Gambar 2. 85. Trime Frame pada Rafter 

Bagi/ potong rafter lagi menjadi 3 segment dengan cara selec rafer dengan titik 

pertemuan gording kemudian potong dengan klik Edit → Edit Frames → Break at 

Intersection with selected frames and joints. Selanjutnya ganti profil rafter yang sudah 

kita bagi dengan cara selec profil yang akan diganti klik Assign → Section Property → 

Pilih BBU (1000-600).300.6.12. 
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Gambar 2. 86. Model Rafter Tapeered 

Tambahkan frame section baru seperti profil BBU (1000- 600).300.6.12. dengan 

posisi section yang berbeda dengan cara Klik Define → Section Properties → frame 

section → selec BBU (1000- 600).300.6.12 → Add Copy Property → Beri nama section 

baru BBU (1000- 600).300.6.12’ dan ubah posisi start dan end. 

  

Posisi Profil 

Terbaik 



138 | Perencanaan Warehouse Sistem Pre Engineered Building (PEB) 

 

 

Gambar 2. 87. Mengubah Posisi Start dan End Profil 

Posisi Start dan End 
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Selanjutnya Assign profil rafter yang terbalik tadi dengan profil baru yang sudah 

dimodelkan BBU (1000- 600).300.6.12’ dengan cara select profil yang akan diganti klik 

Assign → Section Property → Pilih BBU (1000- 600).300.6.12’. 

 

 

Gambar 2. 88. Kolom dan rafter yang Telah dimodelkan 

Setelah kolom di grid X10 sudah termodelkan dengan cara yang sama ulangi di 

grid yang lain. Atau juga bisa me-replicate kolom tersebut dengan cara select kolom dan 

rafter yang ingin kita copy Klik Edit→Replicate→isikan dx sesuai jarak rafter atau bisa 

pick to point on model→Pilih titik awal (titik rafter yang ingin kita copy) dilanjutkan titik 

kedua (titik rafter baru). Apabila jarak antar rafter sama number bisa diisi sesuai jumlah 

rafter yang ingin kita copy. 
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Gambar 2. 89. Replicate Pada Rafter 
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Gambar 2. 90. Rafter yang sudah direplicate 

N. PEMODELAN RING BEAM WF.400X 200X8X13 

Nok atap atau biasa disebut ridge diperlukan untuk menghubungkan satu rafter 

dengan rafter yang lainnya. Nok atap dimodelkan menggunakan WF.400x200x8x13 dan 

dihubungkan secara sederhana (pinned) antar rafter. Hal ini dilakukan pertemuan nok 

atap dengan rafter dihubungkan melalui gusset plate yang hanya dapat menahan gaya 

geser dan tidak menahan momen. Pemodelan nok atap dapat dilakukan dengan mengatur 

potongan terlebih dahulu dengan cara klik opsi View → Set Elevation View → Pilih 

potongan yang akan kita modelkan. Selanjutnya, klik Draw → Draw Beam /Colom → 

Pilih profil WF.400x200x8x13 → lalu drag kursor di posisi di mana Ring Beam yang 

dibutuhkan. 
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Gambar 2. 91. Pemodelan Ring Beam elevasi Y1 dan Y3 

 

 

Gambar 2. 92. Pemodelan Ring Beam elevasi Y6 dan Y8 
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O. PEMODELAN PURLIN CNP. 200X75X20X3,2 

Purlin merupakan elemen yang menjadi dudukan dari penutup atap. Meski di 

depan, beban tidak diaplikasikan pada purlin namun pada rafter, elemen purlin tetap perlu 

dimodelkan agar berat sendiri purlin tetap terhitung sebagai beban yang merangka pada 

rafter. Purlin dimodelkan sebagai simply supported beam dengan tipe koneksi sendi 

sehingga moment release perlu di-assign sebagai ‘Pinned.’ Untuk memudahkan 

pemodelan langkah pertama yang perlu dilakukan adalah membagi rafter menjadi 

beberapa bagian. Purlin akan dimodelkan setiap 1,5 m (jarak antar purlin 1,5 m). 

Sebelum membagi rafter menjadi beberapa bagian, view perlu diatur terlebih 

dahulu agar model yang tidak diperlukan tidak mengganggu pemodelan. Dengan cara 

View→3D View→pilih yz pada fast view→pilih perspective toggle (ikon kacamata) 

→pilih Select frame yang akan di hide→klik kanan pada kursor→pilih perspective 

toggle→Hide Selected Objects. 

 

 

Gambar 2. 93. Pemodelan 3D View  
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Setelah profil yang tidak perlukan di hide, kembali ke tampilan 3D. Kemudian 

devide rafter dengan jarak 1.5 meter dengan cara, select rafter→Edit→Edit 

Frames→Devide Frames→Tentukan jumlah hingga jarak menjadi 1.5m → Apply 

 

  

 

Gambar 2. 94. Rafter Terbagi dengan Jarak 1,5 m 

Rafter sudah 

terbagi dengan 

jarak 1,5m 
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Setelah rafter terbagi, masing-masing joint dari rafter yang telah dibagi perlu di-

extrude menjadi frames yang merupakan CNP. 200X75X20X3,2. Sebelum langkah 

tersebut dilakukan, terlebih dahulu perlu diatur bahwa joint akan di-extrude menjadi 

CNP. 200X75X20X3,2. Hal tersebut dapat dilakukan dengan cara klik Draw 

Beam/Column/Brace (Plan, View, 3D)→atur Properties of Object sesuai pada gambar di 

bawah→tutup kembali Properties of Object. Dengan demikian joint akan dapat langsung 

di-extrude menjadi CNP. 200X75X20X3,2. 

 

 

Gambar 2. 95. Pengaturan Properties of Object 

Langkah selanjutnya adalah melakukan ekstrusi joint. Hal tersebut dapat 

dilakukan dengan cara select masing-masing joint pada rafter → Edit → Extrude → 

Extrude Joints to Frames. Opsi Extrude Joints to Frames dapat mengekstraksi object joint 

menjadi frames yang dikehendaki. Lalu masukkan panjang purlin yang diinginkan 

yaitu10,45 meter pada arah y dengan jumlah 12.  
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Gambar 2. 96. Extrude Joints to Frames Purlin 

Purlin didesain sebagai simply supported beam yang tidak menahan momen di 

daerah tumpuan. Atas dasar tersebut maka bagian pangkal dan ujung purlin perlu di-

release dengan cara klik Select→Select→Properties→Frame Sections→2 

CNP.200X50X20X2,3→Assign→Release Partial Fixity→Checklist Moment 22 dan 

Moment 33→Apply→OK.  

Select joints 

pada rafter 
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Gambar 2. 97. Release Partial Fixity Pada Purlin 

Setelah purlin berhasil dimodelkan pada satu sisi rafter, maka 

CNP.150X50X20X2,3 perlu di-replicate secara mirror ke satu sisi yang lain. Hal tersebut 

dapat dilakukan dengan cara klik Ctrl+J untuk Select Previous →klik Ctrl+R untuk 

Replicate→klik Set Plan View pada ribbon atas→Select BASE→lakukan Mirror pada 

opsi Replicate dengan cara Pick Two Points on Model→hubungkan midpoint pada bagian 

tengah As 1 bangunan dengan midpoint pada bagian tengah As 2 bangunan→Apply→OK. 
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Gambar 2. 98. Mirror Pada Purlin 

 

Gambar 2. 99. Purlin Sudah Dimodelkan 

Setelah purlin dimodelkan, maka rafter yang sebelumnya dibagi untuk 

mempermudah pemodelan, perlu disatukan kembali dengan cara select rafter yang akan 

disambung→Edit→Edit Frames→Joint Frames. 
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Gambar 2. 100. Frames Rafter Digabungkan Kembali 

Pemodelan Roof Bracing dengan Rod 24 mm 

Roof bracing dimodelkan pada bentang di mana X-bracing sudah dimodelkan. 

Roof bracing juga berfungsi sebagai ikatan angin. Roof bracing dimodelkan sebagai steel 

rod dengan diameter 25 mm sebagaimana yang dijelaskan sebelumnya. Pemodelan roof 

bracing dapat dilakukan dengan cara klik Draw Beam/Column/Brace (Plan, Elev, 3D) 

pada ribbon bagian kiri→atur Properties of Object sebagaimana gambar di 

bawah→hubungkan secara diagonal bracing Rod 24 mm. 
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Gambar 2. 101. Draw Rod 24 mm Secara Diagonal dari Rafter ke Rafter 

Setelah model roof bracing dengan Rod 24 mm berhasil dibuat pada satu sisi atap, 

maka roof bracing tersebut perlu direplikasi ke sisi yang lain. Hal tersebut dapat 

dilakukan dengan cara Select roof bracing yang telah dibuat→klik Ctrl+R untuk 

Replicate→klik Set Plan View pada ribbon atas→Select BASE→lakukan Mirror pada 

opsi Replicate dengan cara Pick Two Points on Model→hubungkan midpoint pada bagian 

tengah As 1 bangunan dengan midpoint pada bagian tengah As 2 bangunan→Apply→OK. 

 

Gambar 2. 102. Replicate Roof Bracing 
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Roof bracing yang sudah termodelkan perlu direplikasi dengan jarak 12 m dari 

posisi semula searah y. Pilih roof bracing yang telah termodelkan terlebih dahulu. Hal 

tersebut dilakukan dengan cara Select→Select→Properties→Frame Sections→Rod 25 

mm→Apply→OK. Setelah roof bracing yang sebelumnya sudah dimodelkan terpilih, 

klik Ctrl+R→Input jarak dan jumlah replikasi→Apply→OK. 

 

Gambar 2. 103. Roof Bracing Sudah Termodel pada Keseluruhan Bangunan 

P. PEMODELAN TIE BEAM TB 25/60 

Pemodelan elemen tie beam diperlukan agar berat sendiri tie beam ikut terhitung 

saat desain untuk struktur bawah. Pemodelan tie beam dapat dilakukan dengan mengatur 

View Plan terlebih dahulu dengan cara klik ikon Set Plan View pada Ribbon→Select 

BASE→Apply→OK. Pemodelan tie beam dilakukan dengan cara klik Draw 

Beam/Column/Brace Objects pada ribbon bagian kiri→tentukan Section Properties Tie 

Beam→Drag kursor pada area di mana tie beam dibutuhkan.  
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Gambar 2. 104. TB25/60 yang Sudah Berhasil Dimodelkan 

Setelah semua dimodelkan, klik kanan pada kursor kemudian pilih show all 

Object. Keseluruhan bangunan sudah termodelkan. 
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Gambar 2. 105. Pemodelan Seluruh Bangunan 
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PEMBEBANAN 

STRUKTUR 

 

 

A. PEMBEBANAN PADA BANGUNAN INDUSTRI 

Dalam desain bangunan industri, beban 

diasumsikan terlebih dahulu berdasarkan pertimbangan-

pertimbangan teknis yang matang. Beban-beban yang 

diperhitungkan di antaranya adalah beban mati, beban 

hidup, beban gempa, dan beban angin. Sebuah desain 

struktur dikatakan aman apabila memiliki kapasitas yang 

lebih besar dari beban yang ada sehingga struktur kuat 

menopang beban tersebut. 

B. PEMBUATAN LOAD PATTERN 

Load pattern (pola beban) merupakan distribusi 

spasial dari serangkaian gaya, perpindahan, suhu, dan 

pengaruh lain tertentu yang bekerja pada suatu struktur. 

Kombinasi sambungan dan elemen apa pun dapat 

dipengaruhi oleh kondisi pembebanan dan kinematik. 

Setiap pola beban diberi tipe desain (DEAD, SUPER 

DEAD, WIND, SEISMIC, dll.) yang mengklasifikasikan 

tipe beban yang diaplikasikan dan dikomputasikan sesuai 

tipe beban yang didefinisikan. Dalam ETABS, penentuan 

load pattern dapat dilakukan dengan cara klik Define – 

Load Patterns. Masukan semua jenis beban seperti gambar 

di bawah. 

BAGIAN 

3 
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Gambar 3. 1. Load Pattern Definition 

C. PERHITUNGAN BEBAN MATI (DEAD LOAD) 

Beban mati tambahan merupakan beban yang bekerja pada seluruh atap. Beban 

ini terdiri dari beban mati, beban mati tambahan, berat sendiri struktur, berat finishing 

arsitektur dan berat ducting/kabel/pipa M/E dimasukkan serta beban lain yang 

diperhitungankan sebagai beban tetap pada struktur.  

 

Superimposed Dead Load (SIDL)       

Berat sendiri struktur           (Dihitung oleh program) 

Penutup atap (t = 0,55 mm + Insulasi)   = 6 kg/m2 

ME & Lampu       = 9 kg/m2 

Solar Panel       = 20 kg/m2

 +        35 kg/m2 

Beban SIDL pada atap = 35 kg/m2 

Pada ETABS beban mati dalam hal ini berat sendiri struktur dapat dihitung secara 

otomatis begitu berat jenis material di-input saat pendefinisian material. Untuk beban 

kolateral atau beban mati tambahan, beban dapat di-input sebagai beban garis pada rafter. 

Beban area perlu dikonversi dahulu menjadi beban garis sebagaimana perhitungan di 

bawah. 
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Jarak antar portal, a = 10.45 m 

 Beban garis, q SIDL = 35 x 10.45 

    = 366 kg/m 

Beban di-input sebagai beban garis pada ETABS dengan cara klik 

Select→Select→Properties→Frame Sections→Select profil yang dijadikan rafter→Klik 

kanan→Show Selected Objects Only. 

 

 

Gambar 3. 2. Select Profil Rafter 
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Gambar 3. 3. Show Profil Rafter Only 

Terlebih dahulu akan diaplikasikan beban pada rafter bagian tengah, maka drag 

kursor untuk memilih rafter yang akan diaplikasikan beban SIDL 90 kg/m. Setelah rafter 

terpilih maka klik Assign→Frame Load→Distributed→Load Pattern 

Name=SIDL→Uniform Load=366 kg/m.  

 

Gambar 3. 4. Assign → Frame Loads → Distributed 
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Gambar 3. 5. SIDL 366 kg/m untuk Rafter  

Perhitungan Beban Hidup Atap (Roof Live Load) 

Besaran beban hidup dan reduksi beban hidup mengikuti ketentuan SNI 1727-

2020, Beban desain minimum dan kriteria terkait untuk bangunan gedung dan 

struktur lain. 

Beban hidup pada atap = 60 kg/m2 

Untuk beban hidup, beban dapat di-input sebagai beban garis pada rafter. Beban 

area perlu dikonversi dahulu menjadi beban garis sebagaimana perhitungan di 

bawah. 
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Untuk rafter di bagian tengah 

Jarak antar portal, a = 10.45 m 

    = 60 x 10.45  

    = 627 kg/m 

Sebagaimana aplikasi beban mati dan SIDL pada rafter, beban hidup di-input 

dengan cara yang sama dengan besaran yang berbeda pada rafter yang telah dimodelkan. 

Terlebih dahulu akan diaplikasikan beban pada rafter bagian tengah, maka drag kursor 

untuk memilih rafter yang akan diaplikasikan beban hidup 360 kg/m. Setelah rafter 

terpilih maka klik Assign→Frame Load→Distributed→Load Pattern Name = LL → 

Uniform Load = 627 kg/m. Lakukan hal yang sama terhadap rafter bagian tepi dengan 

input besaran beban hidup = 627 kg/m. 

 

Gambar 3. 6. Beban LL 627 kg/m untuk Rafter  

D. PERHITUNGAN BEBAN HUJAN (RAIN LOAD) 

Beban akibat genangan air hujan dapat dihitung berdasarkan persamaan yang ada 

di Bab 2 dengan detail perhitungan sebagai berikut: 

Sudut atap, 𝛼  = 2 derajat 

Beban hujan, R = 40-0,8*2 

   = 38.4 kg/m^2  > 20 kg/m^2 
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Maka beban akibat genangan air hujan diambil sebesar 20 kg/m^2. 

Secara sederhana konversi beban area ke beban garis dapat dilakukan dengan 

mengalikan beban area dan bentang portal untuk rafter tengah, serta beban area dan 

setengah bentang portal untuk rafter tepi. 

Jarak antar portal, a = 10.45  m 

Beban garis, q R = q*a 

   = 20*10.45 

   =  209 kg/m 

Sebagaimana aplikasi beban-beban sebelumnya pada rafter, beban hujan di-input 

dengan cara yang sama dengan besaran yang berbeda pada rafter yang telah dimodelkan. 

Terlebih dahulu akan diaplikasikan beban pada rafter bagian tengah, maka drag kursor 

untuk memilih rafter yang akan diaplikasikan beban hujan 209 kg/m. Setelah rafter 

terpilih maka klik Assign→Frame Load→Distributed→Load Pattern Name = 

R→Uniform Load = 209 kg/m 

 

Gambar 3. 7. Beban Hujan 209 kg/m untuk Rafter  
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E. PERHITUNGAN BEBAN ANGIN (WIND LOAD) 

Perhitungan angin untuk struktur warehouse yang direncanakan dilakukan 

menggunakan metode yang disederhanakan untuk bangunan bertingkat rendah 

berdasarkan SNI 1727-2020: 

Data-data Awal Bangunan 

Kec. Angin, V  = 39,1 m/s  (TPKB Jakarta) 

Kategori Risiko  = II  (Table 1.5-1 Risk Category) 

Kategori Eksposur = C  (Sect. 26.7) 

Tinggi Ujung Atap, hr = 18.77 m  (hr >= he) 

Tinggi dinding, he  = 17.5 m  (he <= hr) 

Lebar Bangunan = 72.98 m  (Tegak lurus nok atap) 

Panjang Bangunan  = 125.4 m  (Pararel terhadap nok atap) 

Faktor Topografi  = Gable  (Gable atau Miring Sepihak) 

Kzt    = 1,00  (Sect. 26.8 & Figure 26.8-1) 

Kd    = 0,85  (Table 26.6) 

Bangunan tertutup?  YA  (Sect. 26.2 & Table 26.11-1) 

Parameter dan Koefisien yang Digunakan 

Sudut atap, θ    = 2 derajat 

Rata-rata tinggi atap, h = (h = (hr+he)/2, untuk sudut atap > derajat) 

    = h = he, untuk sudut atap <= 10 derajat 

    = 18.14  m 
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Koefisien Tekanan Internal Positif & Negatif, GCpi (Table 26.13-1): 

 

Gambar 3. 8. Penentuan Koefisien Tekanan Internal 

Tekanan internal positif, +Gcpi  = 0,18 

Tekanan internal positif, -Gcpi  = -0,18 

Koefisien eksposur tekanan velositas Kz: 

 Tekanan Velositas 

Tekanan velositas angin ditentukan berdasarkan parameter-parameter yang telah 

ditentukan sebelumnya dengan persamaan sebagai berikut: 

𝑞𝑧 = 0,613 ∗ 𝐾𝑧 ∗ 𝐾𝑧𝑡 ∗ 𝐾𝑑 ∗ 𝐾ℎ ∗ 𝑉2 

𝑞𝑧 = 0,613 ∗ 0,98 ∗ 1 ∗ 0,85 ∗ 1.13 ∗ 39,12 = 900.14 𝑘𝑃𝑎 

Beban Angin 

Beban angin ditentukan dengan persamaan sebagai berikut: 

 

Untuk angin Datang Atap: 

 Cpf = -0.7 

𝑝 =  𝑞ℎ ∗ [(𝐺𝐶𝑝𝑓) − 𝑞 (𝐺𝐶𝑝𝑖)] 
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 =900.14 x ((0.85 x (-0.7) – 900.14 x 0.18 

 = -697.61 N/mm2   = -70 kg/m2 x 10.45 

     = -731.5 kg/m 

Untuk angin Pergi Atap: 

 Cpf = -0.3 

𝑝 =  𝑞ℎ ∗ [(𝐺𝐶𝑝𝑓) − 𝑞 (𝐺𝐶𝑝𝑖)] 

 =900.14 x ((0.85 x (-0.3) – 900.14 x 0.18 

 = -391.56 N/mm2   = -40 kg/m2 x 10.45 

     = -418 kg/m 

 

Untuk Dinding Angin Datang: 

Cpf = 0.8 

𝑝 =  𝑞ℎ ∗ [(𝐺𝐶𝑝𝑓) − 𝑞 (𝐺𝐶𝑝𝑖)] 

 =900.14 x ((0.85 x (0.8) – 900.14 x 0.18 

 = 266.86 N/mm2   = 33.35 kg/m2 x 10.45 

     = 349 kg/m 

Untuk Dinding Angin Pergi: 

Cpf = -0.5 

𝑝 =  𝑞ℎ ∗ [(𝐺𝐶𝑝𝑓) − 𝑞 (𝐺𝐶𝑝𝑖)] 

 =900.14 x ((0.85 x (-0.5) – 900.14 x 0.18 

 = -544.59 N/mm2   = -68 kg/m2 x 10.45 

     = -711.36 kg/m 

 



Pembebanan Struktur | 165 

Dengan koefisien tekanan eksternal yang telah diperhitungkan, Gcpi dan Gcpf, 

sesuai pada Gambar 28.3-1 SNI 1727-2020, rekapitulasi perhitungan tekanan angin untuk 

masing-masing kasus dan sisi adalah sebagai berikut: 

Beban angin baik untuk arah transversal maupun longitudinal di-input pada 

struktur sebagai beban garis dengan mengalikan tekanan angin dengan area tributari yang 

dilayani. Hal tersebut dapat dilakukan dengan cara klik rafter yang akan di-assign beban 

terpilih maka klik Assign→Frame Load→Distributed→Load Pattern Name =Wx dan 

Wy→Uniform Load = Input besaran beban. Beban yang diaplikasikan pada struktur 

bangunan yang didesain ada pada gambar di bawah ini. 

 

Gambar 3. 11. Pembebanan Angin Pada Rafter 
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Gambar 3. 12. Pembebanan Angin Pada Dinding 

 

Gambar 3. 13. Pembebanan Angin Pada Arah Sumbu Y 
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PERENCANAAN 

STRUKTUR TERHADAP 

BEBAN GEMPA 

 

A. PERHITUNGAN BEBAN GEMPA (SEISMIC 

LOAD) 

Beban gempa dihitung dan disesuaikan dengan tata 

cara perhitungan beban gempa yang terdapat pada uraian di 

Bagian 1. Beban gempa yang digunakan pada struktur ini 

merupakan beban gempa statik yang dihitung berdasarkan 

gaya geser dasar bangunan. Tahapan-tahapan penentuan 

beban gempa akan disajikan pada Bagian 4 ini. 

B. KATEGORI RISIKO 

Kategori risiko bangunan ini ditentukan 

berdasarkan fungsi bangunan. Bangunan yang 

direncanakan berfungsi sebagai bangunan pabrik yang 

memiliki kategori risiko II. 

  

BAGIAN 

4 
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C. FAKTOR KEUTAMAAN GEMPA 

Setelah kategori risiko bangunan ditentukan berdasarkan jenis pemanfaatan 

bangunan. Maka, faktor keutamaan gempa sebagai salah satu parameter untuk 

menentukan besarnya beban gempa dapat ditentukan berdasarkan Tabel 4 SNI 1726-2019 

tentang faktor keutamaan gempa. Faktor keutamaan gempa untuk bangunan yang 

direncanakan adalah 1,00. 

D. PENENTUAN KELAS SITUS 

Kelas situs ditentukan berdasarkan SNI 1726-2019 berdasarkan data penyelidikan 

tanah yang tersedia. Pada proyek ini, hanya diketahui satu jenis data penyelidikan tanah 

yang digunakan untuk menentukan kelas situs, yaitu berupa data N-SPT. Terdapat tiga 

data N-SPT yang dapat dilihat pada bagian lampiran. Berdasarkan SNI 1726-2019 apabila 

hanya memperhitungkan satu jenis data tanah, maka kelas situs yang digunakan adalah 

kelas situs yang paling rendah sesuai ketentuan yang terdapat pada SNI 1726- 2019. 

Namun pada perhitungan ini, penentuan kelas situs murni berdasarkan nilai yang 

diperoleh dari data N-SPT. Analisis data N-SPT untuk penentuan kelas situs disajikan 

pada tabel sebagai berikut. 
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Gambar 4. 1 Hasil Pengujian Tanah pada BH 1, BH 2, dan BH 3 
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Tabel 4. 1. 

Klasifikasi Situs Berdasarkan BH-1 

Depth 

(m) 

di 

(m) 

BSTP-01 

N-SPT di/Ni 

2 2 2 1.00 

4 2 12 0.17 

6 2 18 0.11 

8 2 31 0.06 

10 2 32 0.06 

12 2 39 0.05 

14 2 50 0.04 

16 2 50 0.04 

18 2 50 0.04 

20 2 50 0.04 

22 2 47 0.04 

24 2 50 0.04 

26 2 50 0.04 

28 2 50 0.04 

30 2 50 0.04 

 30  1.82 

 
Nrerata 

 
16.49594147 
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Tabel 4. 2 

 Klasifikasi Situs Berdasarkan BH-2 

Depth 

(m) 

di 

(m) 

BH-2 

N-SPT di/Ni 

2 2 4 0.50 

4 2 3 0.67 

6 2 6 0.33 

8 2 11 0.18 

10 2 16 0.13 

12 2 50 0.04 

14 2 45 0.04 

16 2 27 0.07 

18 2 50 0.04 

20 2 48 0.04 

22 2 50 0.04 

24 2 50 0.04 

26 2 50 0.04 

28 2 50 0.04 

30 2 33 0.06 

  30   2.27 

Nrerata 
 

13.22979 
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Tabel 4. 3. 

Klasifikasi Situs Berdasarkan BH-3 

Depth 

(m) 

di 

(m) 
BH-3  

  N-SPT di/Ni 

2 2 2 1.00 

4 2 5 0.40 

6 2 6 0.33 

8 2 7 0.29 

10 2 9 0.22 

12 2 14 0.14 

14 2 20 0.10 

16 2 41 0.05 

18 2 34 0.06 

20 2 30 0.07 

22 2 40 0.05 

24 2 38 0.05 

26 2 50 0.04 

28 2 50 0.04 

30 2 50 0.04 

  30   2.88 

Nrerata   
 

10.41295 

 

Berdasarkan analisis data N-SPT, diperoleh nilai tahanan penetrasi standar rata-

rata tanah dalam lapisan 30 m paling atas (N̅) pada masing-masing titik bore log adalah 

sebagai berikut. 

N̅1 = 16.4 

N̅2 = 13.2 

N̅3 = 10.4 
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Dikarenakan nilai N̅ pada masing-masing titik bore log masih dalam kecil dari 15, 

maka dapat disimpulkan bahwa kelas situs pada lokasi proyek termasuk dalam kelas situs 

tanah lunak (SE). Penentuan tanah kategori sedang (SD) minimal mem menggunakan 

sedikitnya hasil pengukuran dua dari tiga parameter vs , N , dan su. 

E. PERCEPATAN SPEKTRAL DESAIN 

Grafik respon spektrum didesain berdasarkan SNI 1726-2019, yaitu dengan 

bantuan software respon spektrum analisis yang dikembangkan oleh Kementrian PUPR. 

Data yang diperlukan untuk menjalankan software ini adalah lokasi proyek dan kelas situs 

pada lokasi proyek. Berdasarkan data yang diketahui, lokasi proyek berada pada garis 

bujur 107.301364584281 ° dan garis lintang -6.38970951018348°, sedangkan kelas situs 

pada lokasi proyek telah diketahui berdasarkan perhitungan di subbab sebelumnya, yaitu 

termasuk dalam kelas situs tanah sedang (SD). Sehingga, diperoleh grafik respon 

spektrum sebagai berikut. 

 

Gambar 4. 2. Grafik Respon Spektrum pada Lokasi Proyek 
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 Selain grafik respon spektrum, software respon spektum analisis juga dapat 

mengeluarkan data-data lain yang mendukung perhitungan beban gempa. Data-data 

tersebut adalah sebagai berikut: 

SS = 0.804571 g 

S1 = 0.376023 g 

TL = 20 detik 

Fa = 1.256343 

Fv = 2.495906 

SMS = 1.010818 g 

SM1 = 0.938519 g 

SDS = 0.673878 g 

SD1 = 0.625680 g 

T0 = 0.185695 detik 

Ts = 0.928475 detik 

F. PENENTUAN KATEGORI DESAIN SEISMIK 

Kategori desain seismik ditentukan berdasarkan Tabel 8 dan 9 SNI 1726-2019. 

Berdasarkan data yang telah diperoleh yang telah disesuaikan dengan ketentuan yang ada 

pada SNI 1726-2019, maka dapat disimpulkan bahwa struktur ini termasuk dalam 

Kategori Desain Seismik D (KDS D). 

 

 

Gambar 4. 3. Pemilihan Kategori Desain Seismik 
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G. SISTEM STRUKTUR 

Sistem struktur yang digunakan harus disesuaikan dengan Tabel 12 SNI 1726-

2019. Pada bangunan industri, biasanya pada arah melintang digunakan sistem struktur 

rangka baja pemikul momen biasa, sementara pada arah memanjang digunakan sistem 

rangka baja dengan bresing konsentris biasa. Sistem rangka baja dengan bresing 

konsentris biasa mengandalkan rangka baja dengan kombinasi bracing menggunakan 

profil double angle. Namun tidak semua bentang arah memanjang menggunakan sistem 

rangka baja dengan bresing konsenstris biasa. Bentang yang tidak menggunakan sistem 

ini, bertugas untuk menahan beban gravitasi saja dan tidak ikut menahan gaya lateral. 

Untuk KDS D, penggunaan sistem struktur rangka baja pemikul momen biasa 

diizinkan berdasarkan Pasal 7.2.5.6. SNI 1726-2019 untuk struktur yang didesain 1 

tingkat dengan beban tributari atap tidak lebih dari 0,96 kN/m^2. Ketinggian diizinkan 

untuk ditambahkan hinggal 20 m. Sementara itu penggunaan struktur sistem rangka baja 

dengan bresing konsentris biasa diizinkan pada bangunan satu tingkat hingga ketinggian 

18 m dengan beban mati atap tidak melebihi 0,96 kN/m^2. 

 

Gambar 4. 4. Pemilihan Sistem Struktur 

Sistem Rangka Baja Pemikul Momen Biasa (Arah Transversal & Arah 

Longitudinal) 

Koefisien modifikasi respons (R) = 3,5 

Faktor kuat lebih (Ω0)   = 3 

Faktor pembesaran defleksi (Cd) = 3 
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H. PERHITUNGAN PERIODE FUNDAMENTAL STRUKTUR 

Periode hasil analisis struktur perlu dibatasi untuk perhitungan gaya geser dasar 

statik oleh beberapa koefisien dan parameter yang telah ditetapkan sesuai pada Tabel 17 

dan 18 SNI 1726-2019 Koefisien dan parameter yang dimaksud adalah sebagai berikut: 

Periode pada Arah Melintang (OMF) 

Cu = 1,4 

Ct = 0,0724 

x = 0,8 

Perhitungan periode struktur dapat dijabarkan sebagai berikut: 

Tinggi bangunan (seismik)   h = 17.5 m 

Periode Fundamental Pendekatan Ta = Ct × hx 

      = 0,715 detik 

Periode maksimum   Tmax = Cu × Ta 

      = 1.001 detik 

Hasil perhitungan periode fundamental struktur perlu dibandingkan dengan hasil 

analisis periode fundamental melalui bantuan ETABS. Dari hasil analisis diperoleh 

periode sebagai berikut: 

Periode hasil analisis arah-x  Tc, x = 3,099 detik 

Periode hasil analisis arah-y  Tc, y = 1,559 detik 

Dikarenakan periode hasil analisis (Tc) lebih besar dari periode maksimum (Tmax), 

maka periode struktur yang digunakan adalah sebagai berikut: 

Periode pakai arah-x   Tx = 1,001 detik 

Periode pakai arah-y   Ty = 1,001 detik 

I. PERHITUNGAN GAYA GESER DASAR SEISMIK 

Gaya geser dasar seismik dengan metode statik ekivalen (V) untuk arah-x dan 

arah-y dihitung berdasarkan pada Pasal 7.8. SNI 1726-2019. Gaya geser dasar seismik 

dihitung berdasarkan persamaan Persamaan 30 pada SNI 1726-2019. Massa seismik 

efektif struktur yang dihitung antara lain adalah sebagai berikut: 
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1. Berat sendiri struktur  = Dihitung oleh program 

2. Beban SIDL (Atap + M/E) = 15  kg/m2 

3. Dinding termasuk girt  = 15  kg/m2 

 

Perhitungan Koefisien Respon Seismik Arah Transversal (OMF) 

Koefisien respon seismik (CS) =  SDS/(R/Ie) 

     =  0,674 /(3,5/1) 

     =  0,205 

Nilai CS perlu dicek terhadap batas atas batas bawah. Untuk batas atas 

dikarenakan nilai T kurang dari a tau sama dengn TL, maka digunakan Persamaan 32 SNI 

1726-2019. Sedangkan, untuk batas bawah dikarenakan nilai S1 lebih kecil dari 0,6. 

Maka, Persamaan 35 SNI 1726-2019 tidak perlu diperhitungkan. 

Batas atas, CS max =  SD1/(T×(R/Ie) 

   =  0,177 

Batas bawah, CS min =  0,044×SDS×Ie >  0,01 

   =  0,030  >  0,01 

   =  0,030 

Dikarenakan nilai CS min < CS < CS max, maka nilai CS yang digunakan adalah 

sebagai berikut: 

Koefisien respon seismik pakai arah transversal, Cs  = 0,177 

 

Perhitungan Berat Seismik Efektif Arah Transversal 

Berat seismik efektif struktur dihitung berdasarkan massa efektif struktur yang 

diperoleh dari program dengan kombinasi 100% beban mati dan beban mati tambahan. 

Pada perhitungan berat seismik efektif untuk bangunan industri, beban dinding pada arah 

yang pararel terhadap arah yang ditinjau bisa diabaikan dengan asumsi bahwa dinding 

ikut menahan gaya lateral searah bidang. Selain itu dinding yang dihitung sebagai massa 

juga hanya separuh dari seluruh luasan yang dihitung. Pada proyek ini, beban dinding 

dihitung secara keseluruhan untuk memberikan gaya gempa yang lebih konservatif. 

Perhitungan berat seismik efektif struktur ditampilkan sebagai berikut. 
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Perhitungan Berat Seismik Efektif untuk Portal Memanjang 

Luas bangunan yang ditinjau   = 72,98 x 125,4   

      = 9151,10 m2 

Sudut atap, α     = 2  derajat 

Luas atap yang ditinjau   = Luas bangunan/Cos (α) 

      = 9151,10 /Cos (2) 

      = 9145.5  m2 

SIDL pada Atap    = 35  kg/m2 

Total SIDL     = 35 x 9145.5 

      = 320092.16 kg 

Berat dinding    = berat clading x keliling bangunan x tinggi kolom 

    = 10 x 396,75 x 6,5 

    =  25788.75  Kg 

Berat seismik efektif, W = Dead Load + SIDL + Dinding  

    = 320092 + 347334 + 25788,75 

    = 693214,9 kg 

Gaya geser dasar seismik arah transversal, Vx = CS*W  

       = 0,177 x 693214,9

       = 122696.098 kg 

       = 1227 kN 

Jumlah portal yang ditinjau, nPortal   = 13 

Gaya geser dasar per portal, Vx   = 94,4 kN 

Beban lateral gempa diaplikasikan pada dua titik yaitu pada bagian pangkal portal 

dan pada bagian ujung portal (As A dan As D). 

Beban diaplikasikan pada 2 titik   = 94,4 x 0.5 kN 

       = 47,2  kN 

Gaya lateral akibat gempa pada arah x untuk portal ujung di-input pada top kolom 

dengan cara Select joint kolom sebagaimana gambar di bawah→Assign→Joint 

Loads→Forces→Input beban sebagaimana gambar di bawah→Apply→OK. 
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Gambar 4. 5. Assign → Joint Loads → Forces 
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Gambar 4. 6. Input Beban Gempa Arah X untuk Portal  

Perhitungan Berat Seismik Efektif Arah Melintang 

Pada arah longitudinal beban yang diperhitungan adalah berat sendiri struktur 

secara keseluruhan, berat dinding secara keseluruhan, beban SIDL. Perhitungan berat 

seismik efektif struktur ditampilkan sebagai berikut. 

 

Perhitungan Berat Seismik Efektif untuk Portal Arah Melintang 

Luas bangunan yang ditinjau   = 72,98 x 125,4  

      = 9151,10 m2 

Sudut atap, α     = 2  derajat 

Luas atap yang ditinjau   = Luas bangunan/Cos (α) 

      = 9151,10 /Cos (2) 

      = 9145.5  m2 

 

SIDL pada Atap    = 35  kg/m2 

Total SIDL     = 35 x 9145.5 

      = 320092.16 kg 

Berat dinding    = berat clading x keliling bangunan x tinggi kolom 

    = 10 x 396,75 x 6,5 
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    =  25788.75  Kg 

Berat seismik efektif, W = Dead Load + SIDL + Dinding  

    = 320092 + 347334 + 25788,75 

    = 693214,9 kg 

Gaya geser dasar seismik arah long., Vy  = CS*W  

       = 0,177 x 693214,9

       = 122696.098 kg 

       = 1227 kN 

Jumlah portal yang ditinjau, nPortal   = 13 

Gaya geser dasar per portal, Vy   = 94,4 kN 

Beban lateral gempa diaplikasikan pada dua titik yaitu pada bagian pangkal portal 

dan pada bagian ujung portal (As 1 dan As 16). 

Beban diaplikasikan pada 2 titik   = 94,4 x 0.5 kN 

       = 47,2  kN 

Gaya lateral akibat gempa pada arah y di-input pada top kolom dengan cara Select 

joint kolom sebagaimana gambar di bawah→Assign→Joint Loads→Forces→Input 

beban sebagaimana gambar di bawah→Apply→OK. 

 

Gambar 4. 7. Beban Gempa pada Pangkal dan Ujung Portal 
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Gambar 4. 8. Input Beban Gempa Arah Y 

J. PENGECEKAN SIMPANGAN ANTAR TINGKAT 

Simpangan antar tingkat harus dicek berdasarkan pasa 7.12. SNI1726-2019. Batas 

simpangan antar tingkat sesuai dengan Tabel 20 SNI 1726-2019. Struktur yang didesain 

termasuk dalam KDS D, sehingga batasan simpangan antar tingkat harus dibagi dengan 

faktor redundansi yang diasumsikan sebesar 1.  

Tabel 4. 4. 

Simpangan Antar Tingkat Izin Berdasarkan SNI 1726-2019 

 

Run Analyze 

Sebelum melakukan analisis menggunanakan ETABS, kita lakukan modifikasi 

berat massa efektif, karena kita sudah memasukan berat mati, yaitu berat sendiri dan juga 
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berat mati tambahan pada struktur dalam menghitung gaya gempa statis diatas. 

berdasarkan SNI 1726-2019 berat seismik efektif tidak hanya berat beban mati, akan 

tetapi dalam perencanaan warehouse, berat efektif berat beban hidup dimasukan sebesar 

25% dengan cara mengatur Mass Source. Masuk ke Define→Mass Source→Modify/show 

Mass Source . 

 

 

Gambar 4.9 Mengatur Mass Source 

Defleksi pada ETABS, dapat dicek dengan melakukan running case terlebih 

dahulu dengan cara klik Analyze→Set Load Cases to Run→Run All→Run Now. Perilaku 

struktur setelah terkena beban gempa dapat dicek dengan cara klik Show Deformed Shape 

pada ribbon bagian atas→Atur case yang ingin ditampilkan→Atur perpindahan yang 

ingin ditampikan→Apply→OK. 
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Gambar 4. 9. Analyze → Set Load Cases to Run 

 

Gambar 4. 10. Atur Perpindahan yang Ingin Ditampilkan 
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Simpangan Inelastik untuk Portal Arah Transversal 

 

Gambar 4. 11. Simpangan Elastik Akibat Gempa Arah Y 

Simpangan tersebut perlu dicek terhadap batas izin yang berlaku berdasarkan SNI 

1726-2019. Simpangan elastik tersebut perlu diamplifikasi dahulu menjadi simpangan 

inelastik. Perhitungan simpangan inelastik antar tingkat dapat disajikan sebagai berikut: 

∆𝑦= 20.184 𝑚𝑚 

 

Simpangan Inelastik untuk Portal Arah Longitudinal 

Berdasarkan hasil analisis struktur didapatkan bahwa akibat beban gempa arah y 

diperoleh simpangan elastik sebesar 1,537 mm. Simpangan tersebut perlu dicek terhadap 

batas izin yang berlaku berdasarkan SNI 1726-2019. Simpangan elastik tersebut perlu 

diamplifikasi dahulu menjadi simpangan inelastik. Perhitungan simpangan inelastik antar 

tingkat dapat disajikan sebagai berikut: 

 

 

Gambar 4. 12. Simpangan Elastik Akibat Gempa Arah x 
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Simpangan elastik tersebut perlu diamplifikasi dahulu menjadi simpangan 

inelastik. Perhitungan simpangan inelastik antar tingkat dapat disajikan sebagai berikut: 

∆𝑥=  66.294 𝑚𝑚 

 

Pengecekan Terhadap Simpangan Antar Tingkat Izin 

Simpangan antar tingkat yang sudah dihitung sebelumnya perlu dibandingkan 

dengan simpangan antar tingkat izin untuk memastikan bahwa struktur tidak mengalami 

simpangan antar tingkat yang berlebihan. Hasil pengecekan menunjukkan bahwa 

simpangan antar tingkat struktur masih di bawah batas yang diizinkan. 

Tabel 4. 5. 

Pengecekan Terhadap Simpangan Antar Tingkat Izin 

 Δ (mm) 0,02hsx (mm) Cek 

Portal Arah 

Transversal 
20.184 112 OK 

Portal Arah 

Longitudinal 
66.294 112 OK 

 

K. PENGECEKAN TERHADAP PENGARUH P-DELTA 

Pengaruh P-Delta pada struktur perlu diperhitungkan sesuai dengan Pasal 7.8.7. 

SNI 1726-2019. Pengaruh P-Delta perlu dibandingkan terhadap nilai koefisien stabilitas 

(θ) yang dihitung berdasarkan Persamaan 45 SNI 1726-2019. Nilai koefisien stabilitas 

perlu dicek terhadap batasan koefisien stabilitas (θmax) yang dihitung berdasarkan 

Persamaan 46 SNI 1726-2019 dan batasan pengaruh P-Delta sebesar 0,1.  

Perhitungan Koefisien Stabilitas Portal Arah Transversal 

Beban desain vertikal total, P  = 2377,9  kN 

Gaya geser seismik, Vx  = 337,9+ 48,2 

     = 386,0  kN 

Tinggi tingkat, hsx   = 9  m 
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Faktor pembesaran defleksi, Cd = 3 

Simpangan antar tingkat, ΔX  = 28,809  mm 

Koefisien stabilitas dihitung dengan persamaan sebagai berikut: 

𝜃 =
𝑃𝑥 × ∆ × 𝐼𝑒

 𝑉𝑥 × ℎ𝑠𝑥 × 𝐶𝑑
 

𝜃 =
2377,9 × 28,809 × 1

 386,0 × 9000 × 3
= 0,0066 

 

Perhitungan Koefisien Stabilitas Portal Arah Longitudinal 

Beban desain vertikal total, P  = 2377,9  kN 

Gaya geser seismik, Vy  = 355,9   kN 

Tinggi tingkat, hsx   = 9  m 

Faktor pembesaran defleksi, Cd = 3,25 

Simpangan antar tingkat, Δy  = 5,876  mm 

Koefisien stabilitas dihitung dengan persamaan sebagai berikut: 

𝜃 =
𝑃𝑥 × ∆ × 𝐼𝑒

 𝑉𝑥 × ℎ𝑠𝑥 × 𝐶𝑑
 

𝜃 =
2377,9 × 5,876 × 1

 355,9 × 9000 × 3,25
= 0,0013 

Perhitungan batasan koefisien stabilitas dapat dijabarkan sebagai berikut: 

Koefisien Stabilitas Maksimum untuk Portal Arah Transversal 

Rasio kebutuhan geser, β  =  1,0 

Faktor pembesaran defleksi, Cd =  3 

Batas koefisien stabilitas, θmax =  0,5/(β×Cd) < 0,25 

=  0,1667 

Koefisien Stabilitas Maksimum untuk Portal Arah Longitudinal 

Rasio kebutuhan geser, β  =  1,0 

Faktor pembesaran defleksi, Cd =  3,25 

Batas koefisien stabilitas, θmax =  0,5/(β×Cd) < 0,25 

=  0,1538 
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Pengecekan Koefisien Stabilitas Terhadap Batas Izin 

Berdasarkan perhitungan di atas dapat dilihat bahwa nilai dari koefisien stabilitas 

pada tiap tingkat baik untuk arah-x maupun untuk arah-y masih memenuhi batasan nilai 

untuk koefisien stabilitas (θmax) dan nilai untuk batasan pengaruh P-Delta sebesar 0,1. 

Sehingga, dapat disimpulkan bahwa struktur tidak perlu memperhitungkan pengaruh dari 

P-Delta. 

Arah transversal 𝜃 = 0,0066 < 0,1667, 𝑂𝐾! 

Arah longitudinal 𝜃 = 0,0013 < 0,1538, 𝑂𝐾! 
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PERENCANAAN 

STRUKTUR BAJA PEB 

 

 

 

 

A. PERENCANAAN STRUKTUR BALOK PROFIL BU 

600.300.6.12 

Peraturan desain struktur baja di Indonesia mengacu 

pada SNI 1729-2020 yang merupakan adopsi identik dari 

AISC 360-16. Berikut ini disajikan perhitungan struktur 

runway beam yang mengacu pada SNI 1729-2020. 

 

 

 

 

 

 

 

 

 

 

    

    

    

    

  

 
Gambar 5.1 Model Profil BU 600.300.6.12 

 

  

 

h 
 

= 600 mm 

bf = 300 mm 

tw = 6 mm 

tf = 12 mm 

6 

300 

12 

600 

BAGIAN 

5 
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Analisis profil penampang:       

 A = 2 x b x tf + ( h- 2 x ts ) x tw    

  = 11808 mm2  

 Ix = 1/12 x bf x h3 - 1/12 x ( bf - tw) x ( h - 2 x tf )3   

  =  5,400,069,496  mm2    

 Iy = 1/6 x tf x b3 + 1/12 x (h - 2 x tf) x tw3    

  = 54024576 mm2     

 Sx = Ix / 0.5h    

  = 2499425.28 mm2     

 Sy = Iy / 0.5bf    

  = 360163.84 mm2   

 Zx = 1/4 x bf x h2 - 1/4 x (b - tw) x (h - 2 x tf)2    

  = 2780352 mm2  

 Zy = 1/2 x tf x bf2 - 1/4 x (h - 2tf ) x tw2    

   549216  

 

Plat Sayap   

λf = 0.5 x bf/tf 

 = 12.5 

λpf =  

 = 9.15   

λrf =  

  = 18.58 

  

  

0.38 𝑥√𝐸/𝐹𝑦 

0.95 𝑥 (
 𝐾𝑐 𝑥𝐸

𝐹𝑙
)

0.5

` 
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  Kc =  

 = 0.461880215  

  Fl = 0.7 x Fy ( simetri ganda) 

= 241.5  

 λp < λs< λr (profil non-kompak) 

 

  

 

 

Berdasarkan nilai λp dan λr dari plat badan dan sayap, dibagi menjadi 3   

(1) Penampang Kompak:   (λf juga λw) < λp  

(2) Penampang tak kompak:   λp < (λf juga λw) < λr 

(3) Penampang langsing:    λr < (λf juga λw)

   

Kondisi kondisi batas untuk " tekok torsi lateral" balok sesuai ketentuan F2.2 

(AISC 2010).(Kompak di web, tak kompak di flange). 

Lateral Torsional Buckling       

 ry = (Iy/A)0.5    

  =     

       

  = 67.64060934 mm   

     

 Lp = 1.76 x ry x (E/fy)0.5    

       

  =      

  = 2866.3263 mm   

  = 2.8663 m  

  

  

  

4

√ℎ/𝑡𝑤
 

(
54024576 

11808 
)

0.5

 

 1.76 x 67.64 (
200000 

345 
)

0.5
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Cw = 1/24 x (h - tf)2 x tf x bf3    

   

  =     

  = 4667544000000.00 mm6     

    

rts2 = (Iy x Cw)0.5 / Sx       

         

         

 =       

  

 = 6353.31 mm      

trs = 79.71 mm      

C = 1 (Profil I simetris ganda)      

h0 = h - tf       

  588 mm      

J =        

         

         

 =        

          

 = 445952       

         

         

Lr =        

         

         

         

  

=        

         

         

Lr = 7568.90  mm      

 = 7.57  m      

 

 

Kondisi Batas LTB Di mana Lp =2.866 dan Lr = 7.57 m   

     

 

1

24
 x (600 - 12)2 x 12 x 3003 

(54024576 x 4667544000000.00)0.5

2499425.28
 

2 𝑥 𝑏𝑓 𝑥 (𝑡𝑓)3 + ℎ𝑜 𝑥 𝑡𝑤3

3
 

2 𝑥 300 𝑥 (12)3 + 588 𝑥 8 3

3
 

1.95𝑟𝑡𝑠 
𝐸

0.7𝑓𝑦
√

𝐽. 𝑐

𝑠𝑥.  ℎ𝑜
+ √(

𝑗. 𝑐

𝑠𝑥.  ℎ𝑜
)

2

+ 6.76 (
0.7𝑓𝑦

𝐸
)

2

 

1.95 𝑥 79.71 
200000

0.7𝑥 345 
√

445952 𝑥1

2499425.28 𝑥 588 
+ √(

445952 𝑥 1

2499425.28 𝑥 588 
)

2

+ 6.76 (
0.7𝑥 345

200000
)

2
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Diketahui jarak antar gording =1.5 m      

  

1.5 < 3.4 (Lb < Lp)       

Karena Lb < Lp maka baja tidak mengalami Lateral torsional bakling sehingga 

terjadi plastis penuh.  

 

Perhitungan Kuat Lentur Pelelehan (Momen Plastis) 

Kapasitas momen plastis dapat dihitung berdasarkan persamaan sebagai berikut: 

   

Mn = Mp = ∅ x Zx x fy (∅ =0.9) 

  = 863299296 N.mm 

  = 863.299296 Kn.m 

 

Kondisi Batas : Tekuk Lokal Sayap        

        

Mnx =     

           

 =      

        

 =  771,032,905.07  N.mm    

 =  771.03  Kn.m      

 

Mn dipilih terkecil yaitu: 771.03  Kn.m  

 

 

[𝑀𝑝 − (𝑀𝑝 − 0.7𝑓𝑦. 𝑠𝑥). (
𝜆𝑓 − 𝜆𝑝𝑓

𝜆𝑟𝑓 − 𝜆𝑝𝑓 
)] 

[863299296 − (863299296 − 0.7𝑥 345 x 2499425.28 ). (
12.5 − 9.15 

18.58 − 12.5 
)] 
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Gambar 5.2 Momen dan Aksial Ultimate Profil BU 600.300.6.12 

 Dari hasil analisa menggunakan software didapatkan nilai paling maksimal 

Profil BU 600.300.6.8 pada jarak 3.46 m dengan hasil gaya dalam sebagai berikut: 

Mux : 192.02 Kn.m 

Pu : 75.73  Kn 

 

Cek rasio = 
𝑃𝑟

2𝑃𝑐
 + 

𝑀𝑢𝑥

∅𝑀𝑛𝑥
 + 

𝑀𝑢𝑦

∅𝑀𝑛𝑦
 

  =  
𝑃𝑟

2𝑃𝑐
 + 

192.02

771.07
 + 

𝑀𝑢𝑦

∅𝑀𝑛𝑦
 

  = 0.02 + 0.268 + 0.001 

  = 0.289  (OK) 
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Gambar 5.3 Steel Stress Check Information 

Perhitungan Gaya Geser 600.300.6.12 

Aw = d x tw  = 600-(12x2) x 6 

    = 3456 mm2 

h/tw = 600/6  = 100 < 260 maka Kv = 5 

 

Cek hilai h/tw 

   =  

   = 70.53 

 

h/tw >    maka nilai Cv didapat pada rumus dibawah:  

      

 

Cv = 

 

Cv = 0.438 

Vn = 0.6 x Fy x Aw x Cv 

 = 0.6 x 345 x 3456 x 0.438 

 = 313113.6 N 

1.37 𝑥 [
𝐾𝑣 𝑥 𝐸

𝑓𝑦
]

0.5

 1.37 𝑥 [
5 𝑥 200000

345
]

0.5

 

1.37 𝑥 [
𝐾𝑣 𝑥 𝐸

𝑓𝑦
]

0.5

 

1.51 𝑥 𝑘𝑣 𝑥 𝐸

(
ℎ

𝑡𝑤)
2

 𝑥 𝑓𝑦
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Gambar 5.4 Nilai Geser Profil BU 600.300.6.12 

Dari hasil analisa menggunakan software didapatkan nilai paling maksimal Profil 

BU 600.300.6.12 pada jarak 3.46 m dengan hasil gaya dalam sebagai berikut: 

Vu : 4216.36 N 

Rasio Gaya geser: 

 
𝑉𝑢

 ∅.Vn
  = 

4216.36

 0.9 x 313113.6
 

   = 0.01    (OK) 

 

Perencanaan Kolom CBU (400-600).300.8.12 

Berdasarkan hasil analisa ETABS didapatkan rasio kolom paling menentukan di station 

0.0 yaitu 0.558. maka analisa yang akan kita tinjau di station 0.0 juga yaitu frame 

section  
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BU 400.300.8.12  

 

Gambar 5.5 Model Profil BU 400.300.8.12 

Periksa Kelangsingan Penampang 

Kelangsingan sayap 

b/t  = 300/12 

  = 25 >     = 13.96 ( sayap tidak langsing) 

Kelangsingan Badan 

h/tw  = (400-2 x 12)/8 

  = 47   >     = 35.87 ( badan tidak langsing) 

Karena kolom tidak termasuk elemen langsing ditinjau menggunakan tekuk lentur 

λy = 
𝐾 𝑥 𝐿𝑦

𝑟𝑦
 = 

1 𝑥 6285

71.5
  

 = 100.468 <    = 113.40 (terjadi tekuk inelastis) maka: 

 

Fe =    = 
𝜋2 𝑥 200000

(100.47)2   

    = 195.56 Mpa  

  

0.56𝑥√𝐸/𝐹𝑦 

1.49 𝑥√𝐸/𝐹𝑦 

4.71 𝑥√𝐸/𝐹𝑦 

𝜋2 𝑥 𝐸

(
𝑘𝑙
𝑟 )

2  
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Fcr =  

= 

= 164.87 Mpa 

Pn = Fcr x A = 164.87 x 10208 

   = 1682992.96 Mpa 

   = 1682.99 Kn 

Pc = ∅ x Pn = 0.9 x 1741.941 

   = 1567.75 Kn  

 

Pengecekan Kondisi Lentur kolom 

 

 

 

 

 

 

 

Analisis profil penampang:       

A = 2 x b x ts + ( h- 2 x ts ) x tb    

  10208 mm2   

Ix = 1/12 x b x h3 - 1/12 x ( b - tb) x ( h - 2 x ts )3 

 = 306503850.67 mm4     

Iy = 1/6 x ts x b3 + 1/12 x (h - 2 x ts) x tb3   

  54016042.67 mm4   

Sx = Ix / 0.5h    

  1532519.25 mm3   

h = 400 mm 

bf = 300 mm 

tw = 8 mm 

tf = 12 mm 

[0.658^(𝑓𝑦/𝐹𝑒)] x Fy 

[0.658^(345/195.56)] x 345 

300 

400 

8 

12 
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Sy = Iy / 0.5b    

  360106.9511 mm3   

Zx = 1/4 x b x h2 - 1/4 x (b - tb) x (h - 2 x ts)2   

  1679552 mm3   

Zy = 1/2 x ts x b2 - 1/4 x (h - 2ts ) x tb2    

  546016 mm3 

 

Plat Sayap     

λf = 0.5 x bf/tf   

= 12.5   

λpf =  

= 9.15   

   

λrf =    

= 20.56   

   

Kc =    

=     0.57    

Fl = 0.7 x Fy ( simetri ganda)   

241.5   

Karena termasuk kedalam profil kompak, kuat lentur penampang pada kondisi 

plastis. 

Mp1 = ∅ x Zx x Fy = 0.9 x 1679552 x 345 

 = 521500896 Nmm 

 = 521.500896 Kn.m 

  

Plat badan    
h1 = h - 2 x tf   

 = 376   
λw = h1/tw   

 = 47.00   
Λ  = 

 

  

 = 

 

90.53 
   

λrw =    

 = 

 

137.24 
   

λb < λp  (termasuk profil kompak) 

0.38 𝑥√𝐸/𝐹𝑦 

0.95 𝑥( 𝐾𝑐 𝑥𝐸/𝐹𝑙)^0.5 

4

√ℎ/𝑡𝑤
 

3.76 𝑥√𝐸/𝐹𝑦 

5.70 𝑥√𝐸/𝐹𝑦 
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Kondisi kondisi batas untuk " tekok torsi lateral" balok sesuai ketentuan F2.2 

(AISC 2010)          

        

Lateral-Torsional Buckling      

    

 ry = (Iy/A)0.5     

  

  =       

        

  = 72.74297375 mm    

  

 Lp = 1.76 x ry x (E/fy)0.5    

     

=        

  = 3082.5432 mm    

  

  = 3.0825 m      

 Cw = 1/24 x (h - tf)2 tf x bf3      

        

  =        

  = 2032344000000.00 mm6      

 rts2 = (Iy x Cw)0.5 / Sx       

  = 6836.82 mm      

 trs = 82.69 mm      

 C = 1 (Profil I simetris ganda)      

 h0 = h - tf       

   388 mm      

 J =         

    

  =      

  = 411818.6667       

(
54024576 

11808 
)

2

 

 1.76 x 67.64 (
200000 

345 
)

0.5
 

1

24
 x (600 - 12)2 x 12 x 3003 

2 𝑥 𝑏𝑓 𝑥 (𝑡𝑓)3 + ℎ𝑜 𝑥 𝑡𝑤3

3
 

2 𝑥 300 𝑥 (12)3 + 588 𝑥 8 3

3
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 Lr =        

           

    

  =        

           

     

 Lr = 8346.94 mm      

  = 8.35 m        

 

Cb  = 1 

Karena Lp < Lb < Lr 

Mn =  

Mn =  

Mn =    429402270.13 N.mm 

Mn = 429.40 Kn.m 

 

Berdasarkan bantuan ETABS didapatkan gaya sebagai berikut; 

 

     
 

Gambar 5.6 Momen dan Aksial Ultimate Profil BU 400.300.8.12 

 Pu = 608286.33 N   = 608.28633 Kn 

 Mu = 91335569.56 N.mm  = 91.34    Kn.m 

 

1.95𝑟𝑡𝑠 
𝐸

0.7𝑓𝑦
√

𝐽. 𝑐

𝑠𝑥.  ℎ𝑜
+ √(

𝑗. 𝑐

𝑠𝑥.  ℎ𝑜
)

2

+ 6.76 (
0.7𝑓𝑦

𝐸
)

2

 

1.95 𝑥 79.71 
200000

0.7𝑥 345 
√

445952 𝑥1

2499425.28 𝑥 588 
+ √(

445952 𝑥 1

2499425.28 𝑥 588 
)

2

+ 6.76 (
0.7𝑥 345

200000
)

2

 

𝐶𝑏 𝑥 [𝑀𝑝 − (𝑀𝑝 − 0.7𝑓𝑦. 𝑠𝑥). (
𝐿𝑏 − 𝐿𝑝

𝐿𝑟 − 𝐿𝑝
)] 

1 𝑥 [521500896 − (521500896 − 0.7345.1532519.25). (
6285 − 3082.54

8346.94 − 3082.54
)] 
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Menghitung Gaya aksial dan momen Lentur 

 

 Jika  
𝑃𝑟

𝑃𝑐
 = 

608.286

1682.99 
 = 0.361 > 0.2, maka: 

 

         
𝑃𝑟

𝑃𝑐
 + 

8

9
 [

𝑀𝑟𝑥

𝑀𝑐𝑥
 +

𝑀𝑟𝑦

𝑀𝑐𝑦
 ] < 1.0 

 

   0.361 + 
8

9
 [

 91.34 

429.40 
 + 0 ]  

   0.361 + 0.189  = 0.55  < 1 (OK) 

 

Gambar 5.7 Rasio Hasil Analisi ETABS profil CBU (400-600).300.8.12 

Perhitungan Gaya Geser 400.300.8.12 

Aw = d x tw  = 400-(12x2) x 8 

    = 3008 mm2 

h/tw = 600/8  = 50 < 260 maka Kv = 5 
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Cek nilai h/tw 

   =  

   = 53.93 

 

h/tw <    maka nilai Cv adalah 1 

 

Vn = 0.6 x Fy x Aw x Cv 

 = 0.6 x 345 x 3008 x 1 

 = 622656 N 

 

 

Gambar 5.8 Nilai Geser Profil BU 400.300.8.12 

Dari hasil analsia menggunakan sofwere didapatkan nilai paling maksimal Profil 

BU 400.300.6.12 pada jarak 0 m dengan hasil gaya dalam sebagai berikut: 

Vu : 53822.71 N 

 

 

 

2.24 𝑥 [
 𝐸

𝑓𝑦
]

0.5

 2.24 𝑥 [
200000

345
]

0.5

 

1.37 𝑥 [
𝐾𝑣 𝑥 𝐸

𝑓𝑦
]

0.5
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Rasio Gaya geser: 

 
𝑉𝑢

 ∅.Vn
  = 

53822.71 

 0.9 x 622656
 

   = 0.09    (OK)  Profil aman terhadap Geser 

 

B. PERENCANAAN PURLIN 

Purlin direncanakan menggunakan profil 2CNP 200.75.20.3,2 

Jarak Purlin    Lgording  : 1.5 m  

kemiringan Atap   𝛼   : 2° 

Bentang Purlin   Lgording  : 10.45  m 

Jumlah Sagord (dipasang/2m)   : 5    buah 

Jarak antar Sagord     : 2.09  m 

Berdasarkan modeling dari Etabs didapatkan Section Properties 2CNP 

200.75.20.3,2 

Zx : 173636.7  mm3   A : 2416.6    mm2 

Zy : 127304.6  mm3   Sx : 14866033.8 mm3 

Ix : 14866033.8 mm4   Sy : 113029.8  mm3 

Iy : 8477237.8 mm4   Qbs : 18.57     kg/m 
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Gambar 5.9 Frame Section Properties 2CNP 200.75.20.3,2 

Perhitungan beban yang bekerja pada purlin: 

Berat sendiri penutup atap    : 5.0 kg/m2 

Solar Panel      : 20.0 kg/m2 

ME       : 5 kg/m2 

Insulation (glasswool 16 kg/m³ , t=1")  : 5 kg/m2                     + 

Total Beban yang bekerja pada purlin  : 35  kg/m2              

         

Berat Total Beban Tambahan (SIDL) = 35 x 1.5 = 52.5 kg/m    

Beban Air Hujan (58 kg/m2)       = 58 x 1.5 = 87.0 kg/m 

Berat Sendiri Purlin     = 18.57 kg/m 

Total        = 158.07 kg/m 

 

+ 
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Beban tambahan (bracing, sagrod, etc) = 10% DL = (10% x (52.5 + 18.57))  

       = 7.107 kg/m 

Total  (q)      = 158.07 + 7.107 

       = 165. 177 kg/m 

 

 

Gambar 5.10 Model Arah Gaya 2CNP 200.75.20.3,2 

 

qx = q x cos(𝛼)  = 165. 177 x cos (2°) 

    = 165.076 kg/m 

qy = q x cos(𝛼)  = 165. 177 x sin (2°) 

= 5.762 kg/m 

 

 

 

Momen maksimum di tengah bentang: 

Mux = (
1

8
) x qx x L2 = (

1

8
) x 165.076 x 10.45 2 

    = 2253.346 kg.m 

 

Muy = (
1

8
) x qy x L2 = (

1

8
) x 5.762 x 10.45 2 

    = 3.146 kg.m 

10.45 m 
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Akibat beban maintance 

Point Load (P) (100kg) 

 

Px = P cos ( 𝛼 ) = 100 x cos (2°) 

= 99.939 kg 

Py = P sin ( 𝛼 ) = 100 x sin (2°) 

= 3.488 kg 

 

 

Momen maksimum di tengah bentang: 

Mux = (
1

4
) x qx x L2 = (

1

4
) x 99.939 x 10.45 2 

    = 261.091 kg.m 

Muy = (
1

4
) x qy x L2 = (

1

4
) x 3.488 x 10.45 2 

    = 1.823 kg.m 

 

Momen dipilih paling besar antara beban point load dan beban merata: 

 

Mux  = 2253.346  kg.m = 22097775.6 N.mm 

Muy  = 3.146  kg.m = 30851.7209 N.mm 

 

  

10.45 m 

100 kg 
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Cek profil penampang 

Plat Badan 

λw  (b/t)    = 68.6/3.2  

= 21.44 

λpw    =    

    = 1.12 x √200000/240   

    = 32.33 

λrw    =    

= 1.40 x √200000/240   

    = 40.41 

 

 λw  < λpw   badan termasuk profil kompak 

 

 

Plat Sayap 

 

λf (h/t)    = 193.6/3.2  

= 60.5 

λpf    =    

    = 2.42 x √200000/240   

    = 69.86 

λrf    =    

= 5.7 x √200000/240   

    = 164.54 

λf < λpf    sayap termasuk profil kompak 

 

Termasuk profil kompak 

Mn1x  = ∅ x Zx x fy = 0.9 x 173636.7 x 240 

    = 37505527.2 N.mm 

Mn1y  = ∅ x Zy x fy = 0.9 x 127304.6 x 240 

= 27497793.6 N.mm 

 

1.12 𝑥√𝐸/𝐹𝑦 

1.40 𝑥√𝐸/𝐹𝑦 

2.42 𝑥√𝐸/𝐹𝑦 

5.7 𝑥√𝐸/𝐹𝑦 
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Menghitung Lateral-Torsional Buckling (Tekuk Global) 

ry = (Iy/A)0.5  

 =   

     

 = 59.22769038 mm 

Lp = 1.76 x ry x (E/fy)0.5  

=     

 = 3009.1708 mm 

Purlin dengan Panjang 10.45 m dipasang 5 sagord sehingga Panjang purlin yang 

tidak terkekang  = 2.09 m 

Lb  = 2.09 m < 3.009 m ( Tidak Terjadi Lateral-Torsional Buckling) 

Sehingga : 

Mn2x  = ∅ x Zx x fy = 0.9 x 173636.7 x 240 

     = 37505527.2 N.mm 

Mn2y  = ∅ x Zy x fy = 0.9 x 127304.6 x 240 

= 27497793.6 N.mm 

Ratio: 

  
𝑀𝑢𝑥

𝑀𝑛𝑥
 +

30851.7209

0.5 𝑥 27497793.6 
   < 1 

 
22097775.6 

37505527.2 
 +

𝑀𝑢𝑦

0.5 𝑥 𝑀𝑛𝑦
   < 1 

 

    0.59   < 1   (OK) 

 

Perhitungan Lendutan: 

 

∆1 = 
𝑞 𝑥 𝐿 ^4

384 𝑥 𝐸 𝑥 𝐼
   = 

(
165.076

100
) 𝑥 10450 ^4

384 𝑥 200000 𝑥 14866033.8
 

 

    = 17.24 mm 

Lendutan Izin 

 = 
𝐿

180
   =

10450

180
 

    = 58.05 mm  

 

Lendutan yang terjadi < lendutan izin (OK) 

(
8477237.8 

2416.6 
)

2

 

 1.76 x 59.227 (
200000 

240
)

0.5
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DESAIN STRUKTUR 

MENGGUNAKAN ETABS 

 

 

A. KOMBINASI PEMBEBANAN YANG 

DIGUNAKAN 

Maka kombinasi beban yang digunakan adalah 

sebagai berikut: 

 

 

 

Tabel 6. 1. 

Kombinasi Pembebanan yang Digunakan 

Input 

SDS 0.67388 

ρ 1.3 

 

Nomor DL SIDL LL Lr R Wx Wy Ex Ey 

1 1.1 1.4 1.4               

2 
2.1 1.2 1.2 1.6 0.5           

2.2 1.2 1.2 1.6   0.5         

3 

3.1 1.2 1.2 1 1.6           

3.2 1.2 1.2   1.6   0.5       

3.3 1.2 1.2   1.6     0.5     

3.4 1.2 1.2   1.6   0.375 0.375     

3.5 1.2 1.2 1   1.6         

3.6 1.2 1.2     1.6 0.5       

3.7 1.2 1.2     1.6   0.5     

BAGIAN 

6 
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Nomor DL SIDL LL Lr R Wx Wy Ex Ey 

3.8 1.2 1.2     1.6 0.375 0.375     

4 

4.1 1.2 1.2 1 0.5   1       

4.2 1.2 1.2 1 0.5     1     

4.5 1.2 1.2 1 0.5   0.75 0.75     

4.3 1.2 1.2 1   0.5 1       

4.4 1.2 1.2 1   0.5   1     

4.6 1.2 1.2 1   0.5 0.75 0.75     

5 

5.1 0.9 0.9       1       

5.2 0.9 0.9         1     

5.3 0.9 0.9       0.75 0.75     

6 

6.1 1.3348 1.3348 1         1.3 0.39 

6.2 1.3348 1.3348 1         1.3 -0.39 

6.3 1.3348 1.3348 1         -1.3 0.39 

6.4 1.3348 1.3348 1         -1.3 -0.39 

6.5 1.3348 1.3348 1         0.39 1.3 

6.6 1.3348 1.3348 1         -0.39 1.3 

6.7 1.3348 1.3348 1         0.39 -1.3 

6.8 1.3348 1.3348 1         -0.39 -1.3 

7 

7.1 0.7652 0.7652           1.3 0.39 

7.2 0.7652 0.7652           1.3 -0.39 

7.3 0.7652 0.7652           -1.3 0.39 

7.4 0.7652 0.7652           -1.3 -0.39 

7.5 0.7652 0.7652           0.39 1.3 

7.6 0.7652 0.7652           -0.39 1.3 

7.7 0.7652 0.7652           0.39 -1.3 

7.8 0.7652 0.7652           -0.39 -1.3 

 

Di mana: 

Keterangan: 

DL =  Beban mati 

SIDL = Beban mati tambahan 
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LL =  Beban hidup 

Lr =  Beban hidup atap 

R =  Beban hujan 

Ex =  Beban gempa arah x 

Ey =  Beban gempa arah y 

B. STRESS RATIO STRUKTUR 

 

Gambar 6.1 Stress Ratio 

Pengecekan Kemampulayanan Struktur 

Lendutan yang terjadi pada struktur yang menopang atap harus dianalisis terhadap 

lendutan izin didasarkan pada Tabel 1 pada Design Guide 3: Serviceability Design for 

Steel Building yang mengadopsi IBC Tabel 1604.4. Pengecekan lendutan diperlukan 

untuk memastikan bahwa deformasi yang terjadi tidak menyebabkan kerusakan struktural 

maupun non struktural. Umumnya terdapat dua kondisi lendutan yang ditinjau yaitu 

lendutan akibat beban tetap dan lendutan akibat beban tambahan. Pengecekan lendutan 

untuk struktur yang ditinjau disajikan sebagaimana berikut: 
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1. Lendutan pada Atap Akibat Beban Service (DL +LL)     

Bentang yang diperhitungkan, L   = 31275  mm 

L/240, Δall     = 130.31  mm 

Lendutan seketika maksimum, Δmax  = 115.129 mm 

Cek, Δmax < Δall   = OK 

 

 

Gambar 6. 2 Lendutan Akibat Beban Service Atap 

C. DESAIN SAMBUNGAN 

1. Desain Sambungan Rafter dengan Rafter 

Hubungan antara rafter dengan rafter biasa disebut dengan apex haunch. 

Sambungan apex haunch akan didesain menggunakan IdeaStatica. Buat proyek 

sambungan baru dengan cara klik New→pilih Blank. Setelah proyek baru berhasil dibuat 

profil baru dengan cara klik kanan pada opsi Members→New Member. Member yang 

baru dibuat tidak memiliki profil, maka profil tersebut perlu diatur terlebih dahulu. 
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Gambar 6. 3 Membuat New Property  

Karena profil Buid-Up menggunakan mutu tinggi maka material baja perlu 

dimodifikasi dengan cara pilih material→material baja→Edit→Atur fy dan fu pada 

sesuai mutu baja→Save. 

 



Desain Struktur Menggunakan ETABS | 215 

 

Gambar 6. 4 Mengatur Mutu Material Baja 

Kemudian, dibuat profil baru dengan cara klik kanan pada opsi Members→New 

Member. Member yang baru dibuat tidak memiliki profil, maka profil tersebut perlu diatur 

terlebih dahulu. 

 

Gambar 6.5. Pembuatan Member Baru 
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Klik menu Materials pada ribbon bagian atas→klik Cross Section untuk membuat 

penampang baru→pilih I Sections sebagaimana pada gambar di bawah→atur properti 

BU.600X300X6X12 sebagaimana gambar di bawah. 

 

Gambar 6. 6 Tambahkan Profil Baru 

 

Gambar 6. 7 Properti Penampang BU.600X300X6.12 
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Gandakan rafter yang telah dimodelkan dengan cara klik kanan pada M1 di bawah 

menu Members→Copy→atur properti rafter kedua. 

 

Gambar 6.8 Gandakan Rafter Pertama 

Atur properti rafter kedua sebagaimana gambar di bawah. 

 

Gambar 6. 9 Properti Rafter Kedua 
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Kedua rafter yang bertemu perlu dihubungkan dengan double end plate. Untuk 

menyambungkan antara kedua rafter tersebut, klik kanan pada Operations → pilih Plate 

to Plate.  

 

Gambar 6. 10 Plate to Plate untuk Menghubungkan Kedua Rafter 

Properti double end plate perlu diatur baik dari ketebalan pelat, jumlah baut serta 

dimensi pelat. Klik PP1→atur properti Plate to Plate sebagaimana gambar di bawah. 
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Gambar 6. 11 Properti Plate to Plate 

Tambahkan haunch di bagian bawah rafter dengan operasi Widener. Properti 

haunch: panjang haunch, kedalaman haunch, dan jumlah baut perlu diatur sebagaimana 

gambar di bawah.  
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Gambar 6. 12 Widener untuk membentuk Haunch pada pertemuan Rafter 

 

Gambar 6. 13 Properti Haunch bagian kanan 
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Copy Widener tersebut untuk memodelkan widener sebelah kiri kemudian atur 

widener kiri sesuai konfigurasi di bawah ini. 

 

Gambar 6. 14 Properti Haunch Bagian Kiri 

Lanjutkan dengan modeling Apex haunch pada badan profil dengan cara tambah 

Operation→Pilih Rib→Atur posisi, ketebalan Apex haunch.  
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Gambar 6. 1 Properti Haunch badan bagian kanan 
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Gambar 6. 2 Properti Stiffener Bagian Kiri 

 Terakhir, beban perlu ditambahkan untuk menganalisis kekuatan dari sambungan 

aped haunch yang telah didesain. Klik kanan pada Load Effects→New Load→Klik LE1 

di bawah menu Load Effects→Atur beban sebagaimana gambar di bawah. Masukan 

beban sesuai hasil analisis dari ETABS. 

 

Gambar 6.17 Hasil Gaya Dalam Profil BU.600X300X6.12 Dari Etabs 
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Kemudian filter stasion sesuai titik yang akan kita modelkan sambungan 

 

Gambar 6. 18 Beban untuk Desain Sambungan Profil  

Analisis dan desain apex haunch dapat dilakukan dengan cara klik Calculate  
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